
SIMPL Windows Release notes: 
Introduction 

Congratulations! You have received a copy of Crestron's SIMPL Windows 
software package. This exciting program builds programs for Crestron control 
systems, both with a graphical programming environment called SIMPL and a 
procedural language called SIMPL+ for more advanced programmers.  

Crestron has devoted a great deal of time and effort to make sure that the 
software you receive is "ready for primetime." If you have any comments or 
suggestions, we would appreciate hearing from you by email at 
software@crestron.com. (Technical support questions should continue to go 
to our telephone hot line at 1-888-CRESTRON.) If you cannot email us, you can 
also give us your feedback via the telephone or fax. If you are experiencing 
problems, Crestron's top-notch technical support team is standing by to help 
you at 1-888-CRESTRON.  

The following sections are available in the release notes: 

l General Notes and Issues  
l New SIMPL Windows Features  
l Installing the Crestron Database  
l Installing the SIMPL+ Cross Compiler  
l Installing the Crestron Toolbox 

General Notes and Issues 

Special Note for Windows XP Service Pack 2 Users  

It has been discovered that Windows XP Service Pack 2 causes a memory leak with 
applications that use the Microsoft Foundation Classes (MFC). This can be seen by 
using Task Manager to watch the allocation of GDI objects by the application when 
child windows are created and destroyed. Since Crestron Toolbox uses MFC it is 
affected by this issue and may eventually crash after a large number of windows are 
opened and closed. Microsoft is aware of this problem and has issued Hotfix 
KB319740 to address it. For more information and to download the patch, please 
see: http://support.microsoft.com/kb/319740/en-us 

It is not neccessary to install this patch, unless you feel you are seeing this issue as 
it is not likey to come to the point of crashing the application due to the limited use of 
these resources by Crestron Toolbox.  

 
Main Page Related Pages 
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General Notes:  

l Display of "(C:xx H:yy)" in Program Tree and System Configuration Tree: The 
F11 Key (when pressed while the Program Tree on the Program Manger page 
is active, or when the System Tree on the Configuration Managemer page is 
active) will toggle the display of some debugging information. This information 
will appear in the format of "(C:xx H:yy)" after the symbol or device name. This 
data can aid Crestron support personnel in troubleshooting problems andcan 
be very helpful for problem resolution but is meaningless to the programmer, 
and harmless to display. 

l SIMPL Windows 2.10.XX (and later) SUGGESTS the following software to be 
installed to ensure importing as much VTPro-e data as possible when 
associating an user interface device with a VTPro-e project: 

¡ VTPro-e 3.7.0.7 or later (refer to specific hardware documentation for 
version required by specific devices)  

¡ Crestron Database 18.7.5 or later.  
¡ Crestron Toolbox 1.07.00 or later.  

Known issues:  
l Replace Control System with sub-slotted devices: 

¡ Any programming on sub-slotted device cards that are fixed may not 
get copied over, even if the new Control System is the same or has 
the same fixed cards (e.g. programming on the AADS XM Tuner 
card does not get copied over if converting from an AADS-XM to an 
AADS.)  

¡ Serial drivers may have issues when converting to or from AES, 
AADS, or AADS-XM 

l The Parameter Properties dialog will allow incorrect data to be entered for 
Ranges and Default Values for items that are a Decimal format. If a 
Default Value is acutally an illegal value (e.g. a Decimal item with a 
floating point entry), it will not be assigned to that parameter when the 
module is added to the program. If a Range is an illegal value, data entry 
checking may not be correct. Until this is fixed, make sure Ranges and 
Default Values are legal. Refer to the Numeric Formats section of the 
Help to determine legal values.  

l There have been times when running SIMPL Windows on the Microsoft 
Vista operating system, that compiling a program may result in errors 
stating that SIMPL Windows could not find or compile the Crestron 
SIMPL+ modules in the program. Try exiting SIMPL Windows and start it 
up again.  

l Double clicking on an .SMW to open a file may result in a dialog telling 
you the name has been shortened by windows. This seems to happen 
more if an .SMW is inside a .ZIP file. The workaround is to open SIMPL 
Windows and do File -> Open and open the .SMW. 

Things to keep in mind:  
l When importing Crestron Modules, please make sure to verify the Default 
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Argument's Input, Parameter and Output Properties for completeness. 
About a year after the original concept of these properties were 
introduced, Crestron added support of a "Is a Signed Value" field for 
Parameter, Analog Input and Analog Output properties. Simpl Windows 
supports backwards compatibility of this new property for modules that 
were saved before the new property was introduced. However, if a 
programmer were to import a Crestron Module that was created before 
the signed property was added, and there were parameters or analog 
inputs or outputs that need to allow signed values, Simpl Windows will not 
allow negative values on data entry. The workaround for this is simply to 
edit the properties of the desired Parameter or Analog Input and click on 
the "Is a Signed Value" checkbox.  

l If an attempt is made to edit the "[Reference Name]" parameter from a 
SIMPL+ module that was compiled in 2.07 through 2.08.14, SIMPL 
Windows will give an Invalid Parameter error message. If a module 
created before 2.07, which has a reference name entered into the 
"[Reference Name]" field is compiled in any of these versions, the 
compiler error log will have a message about an invalid partial 
substitution. Two solutions exist: Either delete the reference name or 
compile in 2.08.18 (or later).  

l If programming a module to have Input/Output Groups and the label for 
the [~BeginGroup~] is different than the label on the associated 
[~EndGroup~], SIMPL Windows does not flag this and thus, when using 
that module in a program, collapsing and expanding that group may not 
work properly. Please edit the module and make sure the labels match.  

l When using the "Make Symbol Complete" option, it will not necessarily 
complete the symbol's parameters if the parameter has no default value. 

New SIMPL Windows Features 

Fixes/Changes to 2.10.31 to 2.10.32: 

SIMPL Windows Bug Fixes:  

l Fixed problem where SIMPL Windows was not recalling the last state of an 
Input/Output Group (i.e. expanded or collapsed) when the program is saved 
and then reopened. 

SIMPL+ Bug Fixes:  

l Correct issues where non-volatile variables were being allowed to be declared 
as dynamic. This will now be flagged as a compilation issue. The progammer 
can check the return values of ResizeArray(), ResizeString(), and 
ResizeStructureArray(), which will return an error code of 0x8004 if the 
element is not dynamic.  

l Correct issue where dynamic variables could not be declared in functions when 
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#DEFAULT_NONVOLATILE was in effect.  
l INCLUDE3.DAT version v1.69 included to help resolve issues related to the 

previous bug fix. 

Fixes/Changes to 2.10.30 to 2.10.31: 

SIMPL Windows Bug Fixes:  

l Fixed problem in saving programs that have multiple lines of comments in the 
program header. Every time the program file was being saved by SIMPL 
Windows 2.10.30, multiple Carriage Returns and Line Feeds were being added 
to the Program Header comments. Over time and after many saves, the 
program file could become very large and take longer each time to open in 
SIMPL Windows.  

l Fixed problem with Module help not always being available for user module 
symbols. If an existing module has this problem, use this version of SIMPL 
Windows (2.10.31 or later) to open the module and then just save it again. 

SIMPL+ Bug Fixes:  

l Correct issue if #ENABLE_DYNAMIC is used where temporary compiler 
variables were not being sized properly which led to data truncation. 
#ENABLE_DYNAMIC allows the SIMPL+ compiler to dynamically allocate 
temporarly variables rather than use fixed lengths, which can lead to memory 
improvements.  

l Fix issue where application could hang if a #HELP_BEGIN was encountered 
but no #HELP_END was encountered. 

Library Update Version 560 (Changes from 554):  

l Correct HelpID for Defargs to correct module help issues. Note that if you need 
help for the define arguments when writing a module, you should look up define 
arguments in the help index. This will be resolved with v2.11 of SIMPL 
Windows.  

l Fix INET-CBD Power factor  
l Fix INETI-CB Power factor  
l Correct help ID for TPMC-10 WiFi Reserved Joins  
l Correct help ID for TPMC-4X/4XG WiFi Reserved Joins  
l DVDPHD "Day 2" Extenders (Requires new DVPHD firmware to take 

advantage of new features)  
l INCLUDE2.DAT changed to INCLUDE3.DAT (version 1.68) 

¡ Internal corrections for #ENABLE_DYNAMIC to do with above issue. 

Fixes/Changes to 2.10.29 to 2.10.30: 

SIMPL Windows Bug Fixes:  

l Fixed problem with modules not showing up in the Symbol Library Tree if the 
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module had incomplete symbols that were commented out.  
l Fixed problem in importing joins from VTPro-e projects that had more than 999 

joins.  
l Fixed problem with "Rename Signal Globally" option not being enabled for any 

signal on a symbol that has OOTBF programming. This should only be disabled 
for protected signals. 

Library Update Version 554 (Changes from 549):  

l Expose System Builder model for AMS-AIP  
l Expose TPMC-4XG  
l Expose Windows SideShow 

Fixes/Changes to 2.10.28 to 2.10.29: 

SIMPL Windows Bug Fixes:  

l Fixed error when adding an IR driver to a program. This was introduced in 
2.10.28 and was resulting in none of the IR commands being set in the IR 
Driver’s symbol.  

l Fixed a crash on closing Test Manager application if an attempt to close the 
Test Manager is issued while still trying to connect to the control system. 

Fixes/Changes to 2.10.27 to 2.10.28: 

SIMPL Windows Bug Fixes:  

l Fixed problem with increased time to switch between the Program Manager 
and the Configuration Manager views. This was extremely apparent when the 
User IR database folder had an unusually large amount of .IR files.  

l Selecting Refresh from the view menu, or hitting F5, will no longer rebuild the 
User and Project IR Database.  

l Removed the feature of automatically building the User and Project IR 
database when the Configuration Manager view is accessed for the first time if 
there was no User and/or Project IR database file already. This feature was 
introduced in 2.10.03.  

l Changed the default option for UI Configuration Dialog to be "Include in 
Archives of this Project" from "Include in Archives and Import Joins".  

l Fixed problem where certain symbols were not being displayed in the Detail 
View window. This included symbols whose user/project module file could not 
be found, and symbols that were user/project modules deemed incomplete.  

l Correct compilation of strings that are marked as "Read Only" (Not currently 
used by any devices/symbols).  

l Fixed crash in Test Manager if a program using an OOTBF module was 
opened. Test Manager does not support such systems and as such, the 
Crestron Toolbox’s SIMPL Debugger should be used in those cases. 
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Fixes/Changes to 2.10.26 to 2.10.27: 

SIMPL Windows Bug Fixes:  

l Fixed the problem where replacing an AMS-AIP system with another AMS-AIP 
was resulting in duplicate device extenders being left in the converted program.  

l Fixed problem with importing Digital Input properties where the list of Standard 
Commands was getting cleared upon the import however, closing and re-
opening the dialog reinstated the list.  

l Added logic to not allow the commenting out of symbols if they have any 
system control programming.  

l Fixed the problem where the Vision Tools Pro-e option on the Tools menu was 
always disabled.  

l Fixed problem where the Test Manager could not be started. 

SIMPL+ Bug Fixes:  

l SendMailAdvance() changed to require CUZ 4.001. 

Library Update Version 549 (Changes from 546):  

l Correct help ID's for various older touch panels  
l Restrict the following C2NI-CB Brightness & Bargraph settings to a lower bound 

of 1% 
¡ Min Auto Indicator Intensity  
¡ Max Auto Indicator Intensity 

l INCLUDE2.DAT 1.64 
¡ Support for SendMailAdvance() for CUZ 4.001 

Fixes/Changes to 2.10.24 to 2.10.25: 

SIMPL Windows Bug Fixes:  

l Fixed problem in the right click menu of the System Configuration Tree where 
the "Delete" option was enabled for fixed cards. If a delete was attempted, the 
deletion of the device was correctly being denied but, any programming that 
might have been done on the device symbol was being cleared.  

l Restored the View menu options of Expand All, Collapse All, Expand Current 
Node and Collapse Current Node. Also fixed the problem where the Expand All 
and Collapse All options were never enabled. These options will only work if a 
node in the Symbol Library or the Program Tree is selected. 

Library Update Version 541 (Changes from 532):  

l Added Analog Input "MinutesUntilLowBatteryWarning" to CEN-UPS Extended 
Controls  

l Expose CEN-TRACK - Note the following changes from Lib 538 which was 
released independently: 
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¡ Change CEN-TRACK to have 44 total slots (instead of 54). There are only 
40 drop slots for browses contexts.  

¡ Remove "PresetSaveSubpage_F" and "ShowKeypadSubpage_F" digital 
output joins from CEN-TRACK AMFM GUI Browse Context 

l Alter C2I-AMS-SURROUND-SOUND to deal with Dolby Decode modes as an 
analogs rather than digitals.  

l Expose the following keypads: 
¡ C2NI-CB  
¡ INET-CBD  
¡ INETI-CBD  
¡ HTT-B10X 

l Implement the following changes to the TPS extenders (Note: Requires 
firmware 3.001.0022 or better): 

¡ Add The following Extenders to TPS-12, TPS-15, TPS-17 
n Annotation Reserved Joins  
n Ethernet Reserved Joins  
n System3 Reserved Joins 

¡ Add the following extenders to TPS-12G-QM, TPS-15G-QM, TPS-G-TPI 
n Ethernet Reserved Joins  
n System3 Reserved Joins 

¡ Add the following extenders to TPS-GA-TPI 
n System3 Reserved Joins 

¡ TPS-12 System Reserved Joins  
¡ TPS-12G-QM System Reserved Joins  
¡ TPS-15G-QM System Reserved Joins  
¡ TPS-15 System Reserved Joins  
¡ TPS-17 System Reserved Joins 

n Added Digital Inputs 
n Lcd Brt High  
n Lcd Brt Med  
n Lcd Brt Lo 

n Added Serial Inputs 
n Smart Channel A  
n Smart Channel B 

n Added Digital Outputs 
n Lcd Brt High_fb  
n Lcd Brt Med_fb  
n Lcd Brt Lo_fb 

n Added Serial Outputs 
n Product Name Text Join_fb  
n Product Version Text Join_fb  
n Project Name Text Join_fb 

¡ TPS-G-TPI System Reserved Joins 
n Added Serial Outputs 

n Product Name Text Join_fb  
n Product Version Text Join_fb  
n Project Name Text Join_fb 

¡ TPS-GA-TPI System Reserved Joins 
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n Rename Serial Inputs 
n "Smart2 Pad A" to "Smart Channel A"  
n "Smart2 Pad B" to "Smart Channel B" 

n Added Serial Outputs 
n Product Name Text Join_fb  
n Product Version Text Join_fb  
n Project Name Text Join_fb 

n Removed Serial Outputs 
n Smart2 Pad A_fb  
n Smart2 Pad B_fb 

¡ TPS-12 System2 Reserved Joins  
¡ TPS-12G-QM System2 Reserved Joins  
¡ TPS-15G-QM System2 Reserved Joins  
¡ TPS-15 System2 Reserved Joins  
¡ TPS-17 System2 Reserved Joins 

n Added Digital Inputs 
n Lcd Brt High Up  
n Lcd Brt High Dn  
n Lcd Brt Med Up  
n Lcd Brt Med Dn  
n Lcd Brt Lo Up  
n Lcd Brt Lo Dn  
n Subpage Fixed Z Order 

n Added Analog Inputs 
n Key Bklt Brt  
n LCD Level High  
n LCD Level Med  
n LCD Level Lo 

n Added Digital Outputs 
n Subpage Fixed Z Order_fb 

n Added Analog Outputs 
n LCD Level High_fb  
n LCD Level Med_fb  
n LCD Level Lo_fb 

¡ TPS-G-TPI System2 Reserved Joins 
n Added Digital Inputs 

n Subpage Fixed Z Order  
n Test Pattern Color Bars  
n Test Pattern Vertical Lines  
n Test Pattern Grayscale  
n Test Pattern Grid  
n Clear Test Pattern 

n Added Digital Outputs 
n Test Pattern Color Bars_fb  
n Test Pattern Vertical Lines_fb  
n Test Pattern Grayscale_fb  
n Test Pattern Grid_fb 

¡ TPS-GA-TPI System2 Reserved Joins 
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n Added Digital Inputs 
n Test Pattern Color Bars  
n Test Pattern Vertical Lines  
n Test Pattern Grayscale  
n Test Pattern Grid  
n Clear Test Pattern 

n Added Digital Outputs 
n Subpage Fixed Z Order_fb  
n Test Pattern Color Bars_fb  
n Test Pattern Vertical Lines_fb  
n Test Pattern Grayscale_fb  
n Test Pattern Grid_fb 

¡ TPS-12 SVID-1 Control Reserved Joins  
¡ TPS-15 SVID-1 Control Reserved Joins  
¡ TPS-17 SVID-1 Control Reserved Joins 

n Added Digital Inputs 
n SVID-QM Safe Tv Setup None  
n SVID-QM Safe Tv Setup Min  
n SVID-QM Safe Tv Setup Max 

n Added Digital Outputs 
n SVID-QM Safe Tv Setup None_fb  
n SVID-QM Safe Tv Setup Min_fb  
n SVID-QM Safe Tv Setup Max_fb 

¡ TPS-12 SVID-2 Control Reserved Joins  
¡ TPS-15 SVID-2 Control Reserved Joins  
¡ TPS-17 SVID-2 Control Reserved Joins 

n Added Digital Inputs 
n SVID Safe Tv Setup None  
n SVID Safe Tv Setup Min  
n SVID Safe Tv Setup Max 

n Added Digital Outputs 
n SVID Safe Tv Setup None_fb  
n SVID Safe Tv Setup Min_fb  
n SVID Safe Tv Setup Max_fb 

¡ TPS-12 Composite-1 Control Reserved Joins  
¡ TPS-15 Composite-1 Control Reserved Joins  
¡ TPS-17 Composite-1 Control Reserved Joins 

n Added Digital Inputs 
n Composite-QM Safe Tv Setup None  
n Composite-QM Safe Tv Setup Min  
n Composite-QM Safe Tv Setup Max 

n Added Digital Outputs 
n Composite-QM Safe Tv Setup None_fb  
n Composite-QM Safe Tv Setup Min_fb  
n Composite-QM Safe Tv Setup Max_fb 

¡ TPS-12 Composite-2 Control Reserved Joins  
¡ TPS-15 Composite-2 Control Reserved Joins  
¡ TPS-17 Composite-2 Control Reserved Joins 
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n Added Digital Inputs 
n Composite Safe Tv Setup None  
n Composite Safe Tv Setup Min  
n Composite Safe Tv Setup Max 

n Added Digital Outputs 
n Composite Safe Tv Setup None_fb  
n Composite Safe Tv Setup Min_fb  
n Composite Safe Tv Setup Max_fb 

¡ TPS-12 YPbPr-1 Control Reserved Joins  
¡ TPS-15 YPbPr-1 Control Reserved Joins  
¡ TPS-17 YPbPr-1 Control Reserved Joins 

n Added Digital Inputs 
n YPbPr-QM Safe Tv Setup None  
n YPbPr-QM Safe Tv Setup Min  
n YPbPr-QM Safe Tv Setup Max 

n Added Digital Outputs 
n YPbPr-QM Safe Tv Setup None_fb  
n YPbPr-QM Safe Tv Setup Min_fb  
n YPbPr-QM Safe Tv Setup Max_fb 

n Removed Digital Inputs 
n YPbPr-QM Hue Up  
n YPbPr-QM Hue Down 

n Removed Analog Inputs 
n YPbPr-QM Hue 

n Removed Analog Outputs 
n YPbPr-QM Hue_fb 

¡ TPS-12 YPbPr-2 Control Reserved Joins  
¡ TPS-15 YPbPr-2 Control Reserved Joins  
¡ TPS-17 YPbPr-2 Control Reserved Joins 

n Added Digital Inputs 
n YPbPr Safe Tv Setup None  
n YPbPr Safe Tv Setup Min  
n YPbPr Safe Tv Setup Max 

n Added Digital Outputs 
n YPbPr Safe Tv Setup None_fb  
n YPbPr Safe Tv Setup Min_fb  
n YPbPr Safe Tv Setup Max_fb 

n Removed Digital Inputs 
n YPbPr-QM Hue Up  
n YPbPr-QM Hue Down 

n Removed Analog Inputs 
n YPbPr-QM Hue 

n Removed Analog Outputs 
n YPbPr-QM Hue_fb 

¡ TPS-12G-QM YPbPr-1 Control Reserved Joins  
¡ TPS-15G-QM YPbPr-1 Control Reserved Joins  
¡ TPS-G-TPI YPbPr-1 Control Reserved Joins 

n Removed Digital Inputs 
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n YPbPr-1 Hue Up  
n YPbPr-1 Hue Down 

n Removed Analog Inputs 
n YPbPr-1 Hue 

n Removed Analog Outputs 
n YPbPr-1 Hue_fb 

¡ TPS-12G-QM YPbPr-2 Control Reserved Joins  
¡ TPS-15G-QM YPbPr-2 Control Reserved Joins  
¡ TPS-G-TPI YPbPr-2 Control Reserved Joins 

n Removed Digital Inputs 
n YPbPr-2 Hue Up  
n YPbPr-2 Hue Down 

n Removed Analog Inputs 
n YPbPr-2 Hue 

n Removed Analog Outputs 
n YPbPr-2 Hue_fb 

¡ TPS-G-TPI Annotation Reserved Joins 
n Added Digital Inputs 

n Annotation Remote Override On  
n Annotation Remote Override Off 

n Added Digital Outputs 
n Annotation Enable_fb  
n Annotation Disable_fb  
n Annotation Brush Thin_fb  
n Annotation Brush Med_fb  
n Annotation Brush Thick_fb  
n Annotation Color Red_fb  
n Annotation Color Green_fb  
n Annotation Color Blue_fb  
n Annotation Color Yellow_fb  
n Annotation Color Cyan_fb  
n Annotation Color Magenta_fb  
n Annotation Color White_fb  
n Annotation Color Black_fb  
n Annotation Freeze Off_fb  
n Annotation Freeze On_fb  
n Annotation Color Erase_fb  
n Annotation Remote Override On_fb  
n Annotation Remote Override Off_fb 

¡ TPS-GA-TPI Annotation Reserved Joins 
n Added Digital Inputs 

n Annotation Remote Override On  
n Annotation Remote Override Off 

n Added Digital Outputs 
n Annotation Remote Override On_fb  
n Annotation Remote Override Off_fb 

Fixes/Changes to 2.10.23 to 2.10.24: 
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SIMPL Windows Bug Fixes:  

l Correct issue with 2 Series compilation where the internal file timestap on 
several files was incorrect (started in 2.09.XX)  

l Fixed more parameter data entry validation issues. 

SIMPL Windows Enhancements:  

l When generating Connection Logic for a module, and the selected target 
device is subslotted, if any of the devices have duplicate cues, SIMPL will now 
generate a unique input or output for the Argument Definition symbol. When 
generation of the programming is complete, a dialog will appear if any duplicate 
cues were found. This dialog has a Print button to be able to print out the list of 
affected signals such that the programmer can update signal names if desired. 

Fixes/Changes to 2.10.22 to 2.10.23: 

SIMPL Windows Bug Fixes:  

l Fixed error in parameter validation that was rejecting any value in seconds that 
did not have a number preceding the decimal point (i.e; .1s is rejected but 0.1s 
was not).  

l Enhanced the Transfer File processing such that if the programmer cancels out 
of the Crestron Toolbox Address Book dialog, SIMPL will cancel the attempt to 
transfer the file. Before this enhancement, SIMPL was then trying to complete 
the transfer via the Viewport. 

Fixes/Changes to 2.10.21 to 2.10.22: 

SIMPL Windows Bug Fixes:  

l Fixed SIMPL Windows crash when right clicking on any symbol in the Symbol 
Library Tree.  

l Fixed an error where parameters with the same names were being allowed in 
the Argument Definition of a module.  

l Fixed an error where decimal, hexadecimal, and time in tick parameters could 
have values entered as the unit only with no value.  

l Fixed some errors on the Analog Output Properties dialog where multiple 
default numerical formats were being allowed and importing of data wasn't 
clearing out the existing data first. 

SIMPL Windows Enhancements:  

l Added support of the F7 key to expand or collapse the current node in the 
System Configuration Tree on the Configuration Manager view. As a part of this 
implementation, the "Expand Current Node" and "Collapse Current Node" 
options on the right click menu were replaced with just one option that will read 
either "Expand Current Node F7" or "Collapse Current Node F7" based on the 
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state of the current node. If the current node cannot be expanded or collapsed, 
this right click menu option will not appear. 

Fixes/Changes to 2.10.20 to 2.10.21: 

SIMPL Windows Bug Fixes:  

l Fixed an error that was allowing a programmer to swap a 1-way Serial device 
with an IR device that was on an IR port with more than 1 IR devices. This was 
resulting in the 1way Serial device ended up being stacked on an IR port with 
an IR device when the "Allow stacking" option is not selected.  

l Fixed error where negative Hexadecimal parameter values were not being 
allowed when they should be (e.g. Analog Initialize).  

l If a symbol in a program is a Crestron, User or Project module and it cannot be 
found in the current Symbol Library, SIMPL Windows will no longer show that 
symbol's detail in the Detail View.  

l Fixed error in the Analog Input Properties dialog that was allowing the dialog to 
be dismissed without having a Default Numerical Format selected.  

l Fixed error on the Parameter Properties and the Analog Input Properties dialog 
that was not importing List items correctly. If any of the values or the labels 
being imported were the same as something already in the list, the items were 
being added twice. Now, SIMPL will delete any existing data and only use data 
from the property item being imported.  

l Fixed error where selecting AutoTile Horizontal from the View menu was not 
deselecting the AutoTile Vertical option if it was the previous selection.  

l Disabled the option to insert Input/Output Group labels while the selected item 
is a parameter on the Argument Definition. Groups are not yet supported for 
parameters. 

SIMPL Windows Enhancements:  

l SIMPL Windows Added ability to expand/collapse nodes in the Program and 
Symbol Library Trees on the Program Manager page, and the Device Library 
Tree on the Configuration Manager page via a right click menu option the F7 
key. We will also add this shortcut key for the System Configuration Tree in a 
future version. 

Fixes/Changes to 2.10.19 to 2.10.20: 

SIMPL Windows Bug Fixes:  

l Correct issue with compilation of time parameters on C2N-CB-TS for 2 series 
systems. Compilation was using the wrong timebase (using 1s=112.5 ticks 
instead of 1s=100 ticks).  

l Fixed handling of IR and Serial 1-way drivers in the System Tree on the 
Configuration Manager page: 

¡ There were cases where two 1-way serial drivers could end up on the 
same IR port. This should never be allowed.  
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¡ There were cases where, even though the "Allow stacking" option (will 
allow one 1way Serial driver on same port as IR Drivers) was disabled, 
1way Serial drivers were still allowed on the same port as an IR driver.  

¡ The configuration dialogs were not showing the correct list of available 
ports for 1-way serial drivers sitting in an IR port. The list was including 
port numbers that would have resulted in two 1way Serial drivers on the 
same port or stacking with an IR driver even if the "Allow Stacking" option 
was disabled. Since SIMPL Windows won't allow those cases now, if the 
programmer were to select a port that would have resulted in such a 
situation, no action was being taken. These ports are now just no longer in 
the list of available ports. 

l Fixed error in the Parameter and Analog Input Properties dialogs. If the default 
numerical format is Decimal and then decimal is removed from the list of 
allowed numerical formats (i.e. uncheck the Decimal checkbox), no selection of 
default numerical format exists. If you then re-check the decimal checkbox, the 
default numerical format was being reset to Decimal however, clicking OK at 
this point would generate a warning that no default format had been selected. 
This has been fixed. Note though, that decimal is the only numerical format 
type in which the default type will automatically be selected as that is the 
default value for the default format since that is the default "default numerical 
format".  

l Fixed the error where cancelling out of the Preferences dialog was still keeping 
any changes made.  

l Fixed error on Digital Input Properties dialog where selecting a Behavior other 
than "Edge Triggered" was still showing "Edge Triggered" as also selected. The 
selection being returned by the dialog was correct, it was just indication as to 
which options were selected that was incorrect.  

l Fixed error when trying to access Help from the Module Header->Connection 
Logic dialog. A message was being generated indicating the help file could not 
be found.  

l Added logic to try to minimize the amount of failures when extracting Crestron 
SIMPL+ modues from the Crestron database during SIMPL Windows program 
compiles. There had been cases where a file was in the temp directory marked 
as read only, and the extraction failed and causes the module not to be 
included in the final SPZ file. The 2 Series control system would then generate 
errors at program startup about not being able to find that particular SIMPL+ 
module. 

SIMPL Windows Enhancements:  

l Added shortcut key to close all symbol detail view windows. This key is Alt+X.  
l Added shortcut keys to select the tile options in Detail View (Note: this does not 

affect the "AutoTile Vertical" or "AutoTile Horizontal" commands. Those options 
are available in the View menu and, when selected (indicated by a checkbox on 
the menu item), when symbols are added to the Detail View window, the 
selected auto tiling method will be applied.) 

¡ Alt+V will issue a "Tile Vertical" command.  
¡ Alt+H will issue a "Tile Horizontal" command. 
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SIMPL+ Bug Fixes:  

l Fixed TRACE() function translation bug. If the first character of the string to 
TRACE() was a hex character (A-F or a-f) then the special trace characters 
would not print correctly.  

l SocketGetRemoteIPAddress() and SocketGetAddressAsRequested() 
will now allow TCP_CLIENT datatypes to be passed as arguments. 
SocketGetPortNumber() will now also allow TCP_CLIENT and 
UDP_SOCKET datatypes to be passed as arguments. 

Library Update Version 532 (Changes from 531):  

l Correct Help ID issues on AMS Audio Board. 

Fixes/Changes to 2.10.18 to 2.10.19: 

SIMPL Windows Bug Fixes:  

l Removed "Expand All Nodes", "Collapse All Nodes", "Expand Current Node" 
and "Collapse Current Node" options from the View menu. These options have 
been disabled for a few years and as such, were never used.  

l Fixed problem in Detail View with parameters that have List values defined via 
a Parameter Property. Double clicking on such a parameter, would clear the 
current selection if a value had already been selected, or if there was a default 
value. The current selection will not be retained and be the 'selected' item when 
the list is displayed.  

l Fixed potential data integrity errors: 
¡ When editing a program generated by System Builder. If the program has 

built in functionality, and the programmer tries to delete any subfolder that 
contains the protected system control module or contains another 
subfolder(s) that may contain the system control module, SIMPL Windows 
was allowing the delete. However, when the delete was processed, the 
system control symbol was not being deleted and as such, a data integrity 
error was encountered upon reopening of the project.  

¡ When editing a SystemBuilder generated program for a system with built 
in system control, programmers were being allowed to delete the top level 
"Common" and/or "Devices" subfolders even though a protected module 
existed under those subfolders. This was causing a data integrity error 
when the program was reopened. Now, if any subfolder has a protected 
module below it, the subfolder can no longer be deleted. Any non-
protected symbols below that subfolder, however, can be specifically 
deleted. 

l Will now hide any device extenders that have only protected programming if the 
"Don't show system control programming" flag is set. 

Library Update Version 531 (Changes from 523):  
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l Expose MPS-300 model  
l Expose CEN-UPS1250 model  
l Update C2N-CB-TS Model Parameters  
l Add SNMP model to device library  
l Correct SIMPL+ Help file for 2.10.XX SIMPL Windows 

Fixes/Changes to 2.10.17 to 2.10.18: 

SIMPL Windows Bug Fixes:  

l Fixed error introduced in 2.10.17 that caused System Builder generation times 
to be tripled. 

SIMPL Windows Enhancements:  

l SIMPL Windows: Added logic to the Device Library Tree's right click menu to 
no longer show the "Add Multiple Copies" if the selected device is a control 
system or, if the selected device is an SNMP or Poll Accelerator and the 
maximum allowed number of SNMP's and/or Poll Accelerator's are already in 
the program. 

Library Update Version 523 (Changes from 520):  

l Use INCLUDE2.DAT file for better compatability with older versions of SIMPL 
Windows that use INCLUDE.DAT. This was done becuase of structural 
changes to the file. This change should be transparent to users. 

Fixes/Changes to 2.10.16 to 2.10.17: 

SIMPL Windows Bug Fixes:  

l Fixed error when compiling from System Builder. 

Fixes/Changes to 2.10.15 to 2.10.16: 

SIMPL Windows Bug Fixes:  

l Fixed problem when trying to copy multiple signals to an area of a symbol that 
contained an Input/Output group that was collapsed. In these cases, instead of 
signals being pasted inside the group, which they should have been, the entire 
group was skipped and the first non-group items would get the pasted data.  

l Fixed problem where clicking on Ctrl+A in a symbol's detail view would not 
select signals inside an Input/Output group. Now, when the programmer wants 
to select all signals, all Input/Output groups will be expanded and then all 
signals will be selected.  

l Fixed problem with SIMPL Windows hanging when using Ctrl+C and Ctrl+V to 
try to copy and paste fixed signals on an OOTBF symbol. 

Page 16 of 116Release notes: SIMPL Windows Release notes:

7/1/2008file://C:\Crestron\Simpl\simpl_release_notes.html



Fixes/Changes to 2.10.12 to 2.10.15: 

SIMPL Windows Bug Fixes:  

l SIMPL Windows: Added logic to mark modules as having incomplete 
programming if: 

¡ The module is saved and there are inputs or outputs on the Argument 
Definition symbol that do not have signals.  

¡ If there are symbols in the module that are incomplete.  
¡ If there are nested Group Labels or if there are incomplete Groups (i.e. a 

Begin without an End or an End without a Begin). 
l If a module is marked as having incomplete programming, the module will not 

show up in the Symbol Library and cannot be added to a program via a 
speedkey. If a module with incomplete programming is already in a program, 
and that program is opened, a warning will appear in the error log warning the 
user that the module will need to be completed.  

l Fixed a problem with losing the first character of a Symbol comment when 
entering the comment via the status bar.  

l Fixed problems with selecting multiple Symbol Tree categories for a module.  
l Fixed problem with symbol tree category for modules created with SIMPL 

2.10.12. These modules were not being read in by SIMPL Windows 2.08.44 or 
older.  

l Fixed problems with parameter validation: 
¡ If a parameter's property indicated it could be multiple numeric types, but 

the default type was character, entering in just a character was not being 
interpreted correctly.  

¡ The warning given to the programmer about the number of digits allowed 
in a Percentage value was incorrect in stating that the precision was only 
to .01%. The correct precision is to .001%.  

¡ Fixed error in data entry of parameter values. If incorrect units were typed 
in, the intended units were added to the end of the entered value instead 
of rejecting the entry. For example, if a paramter required a Decimal value 
and the programmer entered 12t, the resulting value was 12td. 

l Removed attempt to access device Help from the Crestron Product CD. This 
CD is no longer supported or distributed by Crestron.  

l Fixed a problem where, if a module exists in a program and then the module is 
edited to have Input and/or Output Groups, the instance of the module already 
in a program would not display the Input and/or Output Groups appropriately in 
the Detail View.  

l Compilation of projects with SIMPL+ larger than the target processor can 
handle will now properly fail with the real size of the generated SIMPL+.  

l Compilation now reflects the exact size that the compiled SIMPL+ will take up 
in the target processor, rather than a close approximate.  

l Fixed problem where, if a module was programmed to have outputs and there 
were ambiguous outputs (i.e. not specifically analog, digital, or serial) in the 
Argument Definition, saving the module would cause the output signals to be 
removed from the Argument Definition.  

l Fixed problem where all discontinued Crestron Modules were appearing in the 
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Symbol Library tree. 

SIMPL Windows Enhancements:  

l Updated the UI Project configuration dialog. Reworded the selections such that 
it made more sense what the programmer is choosing to do. The options are 
now: 

¡ "Include in archives of this project" - Will associate the VTPro-e project to 
the SIMPL Windows program such that it will be included in SIMPL 
Windows archives of the SIMPL Windows program.  

¡ "Include in archives and open in VTPro-e" - Will associate the VTPro-e 
project to the SIMPL Windows program for archive purposes, and will 
open the selected VTPro-e project in VTPro-e when the configuration 
dialog is exited.  

¡ "Include in archives and Import Joins" - Will associate the VTPro-e project 
to the SIMPL Windows program for archive purposes, and will import the 
join data onto the associated Touchpanel symbol in the SIMPL Windows 
program.  

¡ "Include in archives, import joins and open in VTPro-e" - Will associate the 
VTPro-e project to the SIMPL Windows program for archive purposes, will 
import the join data onto the associated Touchpanel symbol in the SIMPL 
Windows program and will open the selected VTPro-e project in VTPro-e 
when the configuration dialog is exited.  

¡ The Default selection will be "Include in archives and Import Joins". 
l Programmers can now select SIMPL+ library files (.usl) from the File menu's 

Open File dialog, using the "All Files *,*" filter, and have the library open up in 
SIMPL+.  

l Changed hotkey sequence for inserting an Input/Output Group [~BeginGroup~] 
into a module's Argument Definition symbol. The hotkey is now "Alt+I".  

l If a "Ctl+I" is entered to complete the logic on a symbol or symbols, and SIMPL 
did not have enough information to be able to complete the symbol fully, a 
message box will now appear informing the programmer.  

l Input/Output Group tags (i.e. [~BeginGroup~]label and [~EndGroup~]label) in 
the Argument Defintion of a Module will now appear in Green and the line 
underneath will also be in green. This is to help the programmer see where 
groups are when programming a module.  

l Enhanced the logic for applying prefixes and suffixes signal names to not 
display "Couldn't add prefix/suffix" messages if the signal is a comment (i.e. //) 
or a fixed signal added by OOTBF programming. 

SIMPL+ Enhancements:  

l When compiling a module in the SIMPL+ GUI, the SIMPL+ GUI will print the 
compiled module size after compilation is complete. Please note that when 
compiling a SIMPL program from SIMPL Windows that contains many SIMPL+ 
modules the final complilation result is NOT the sum total of each compiled 
module size due to shared code space. 
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SIMPL+ Bug Fixes:  

l Correct issue with _SKIP_ keyword not rendering properly between I/O Arrays. 

Library Update 520 (Changes from 512):  

l AADS 1 Way Serial Driver can now be dropped on AADS IR Ports.  
l Correct Help ID for AMS Surround Sound Slot  
l Increase number of joins on AMS Screen Feedback to better support future 

AMS-AIP Protected Module programming  
l Add Help ID's to DVPHD Extenders  
l Add Dolby Digital join to AMS Surround Sound Slot (Requires newer Surround 

Sound Board firmware)  
l INCLUDE.DAT 1.62 

¡ Updated support for flagging SIMPL+ compilations too large for the target 
processor. 

Fixes/Changes to 2.10.11 to 2.10.12: 

SIMPL Windows Bug Fixes:  

l Fixed problem with double clicking to open a .SMW/.UMC file in SIMPL 
Windows and getting a "File Open Error" however, files open fine when 
selected from within SIMPL Windows. Double clicking on a SIMPL Windows file 
will once again start up SIMPL Windows and open the selected file.  

l Fixed problem with devices that have multiple Device Tree categories not 
showing up in the Add Device/Replace Device dialog that is displayed in the 
System Configuration Tree (lower right window on the the Configuration 
Manager view).  

l Fixed problem with not being able to a assign "Custom" Symbol Tree category 
to a module. This problem resulted from the implementation of supporting 
multiple symbol tree category assignment to modules.  

l Fixed problem with all hidden/discontinuted Crestron Module symbols showing 
up in the Symbol Tree under both the "All Crestron Modules" and the 
"Miscellaneous" symbol tree folders.  

l Fixed problem with symbols that have been assigned to multiple Symbol Tree 
categories losing the last selected category. 

SIMPL+ Bug Fixes:  

l If using a propList, a propDefaultValue no longer needs to be specified 
when using parameters.  

l When a parameter array is the last parameter type the cues will be proper and 
defaults will show up properly.  

l #BEGIN_PROP_FULL_DESCRIPTION ... 
#END_PROP_FULL_DESCRIPTION now shows up correctly in SIMPL Windows 
ALT-F3 properties when doing multine descriptions.  
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l #BEGIN_PROP_NOTES ... #END_PROP_NOTES now shows up correctly in 
SIMPL Windows ALT-F3 properties when doing multine notes.  

l #BEGIN_PROP_SHORT_DESCRIPTION ... 
#END_PROP_SHORT_DESCRIPTION has now been replaced by 
propShortDescription = "status_bar_hint_text" for a one line 
short description field.  

l STRING_PARAMETER defaults are no longer double quoted.  
l Better support to accomodate different SIMPL+ memory sizes across various 

control systems (requires INCLUDE.DAT 1.59 or later) 

Library Update Version 512 (Changes from 510):  

l Add proper AAS-1/2/4 Firmware names to AAS model.  
l Restore CEN-IDOC Search functionality  
l INCLUDE.DAT 1.59 

¡ Better support to accomodate different SIMPL+ memory sizes across 
various control systems. 

Fixes/Changes to 2.10.10 to 2.10.11: 

SIMPL Windows Bug Fixes:  

l SIMPL Windows: Fixed error in trying to import VTPro-e projects that had join 
numbers extending beyond the maximum allowed inputs/outputs on the 
touchpanel symbols (i.e. reserved joins). Projects based on templates could 
typically have reserved joins and as such, when importing those projects, no 
data was being imported due to the error in processing the reserved joins. 

SIMPL Windows Enhancements:  

l When selectiing to Show Routings (F2) from a symbol's Detail View, SIMPL will 
now automatically Highlight the routings of the selected signal (i.e. the F3 
function) when the "Open All Symbols" option is selected on the Show Details 
dialog. Note: this is only available when hitting F2 from a symbol's Detail View.  

l Added abilty to set a symbol's comment when adding it to the program via a 
Speedkey on the status bar. If the programmer types a colon and then the 
comment, the text after the colon will be entered as the symbol's comment. For 
example, typing "SBUFFER : My buffer" (no quotes) will add a Serial Buffer 
symbol and assign the comment "My buffer" to that symbol in the program. 

Fixes/Changes to 2.10.09 to 2.10.10: 

SIMPL Windows Bug Fixes:  

l Fixed error where modules selected to have GUI connection logic via the 
Module Header dialog, but did not have a VTPro-e project data imported, were 
not showing up in the Symbol Library or the Program Tree as having any GUI 

Page 20 of 116Release notes: SIMPL Windows Release notes:

7/1/2008file://C:\Crestron\Simpl\simpl_release_notes.html



logic to import.  
l Added logic to try to make Data Integrity errors for missing signals a little less 

prohibitive. Now, if SIMPL finds a reference to a signal that is not defined in the 
program, SIMPL will create a new signal for that reference and name it 
"SIMPL_ADDED_SIG_xxx" where xxx is the signal's reference number in the 
program. A message will be placed in the Error Log notifying the programmer of 
this change in signal names. The programmer may still then be able to open 
the program and rename those signals if they choose and then continue 
programming.  

l Fixed a potential data integrity error that could occur when saving a module if 
alot of symbols had been deleted from that module since the last time it was 
saved. Note: This was a very rare occurrance and when it did happen, Crestron 
was able to recover all valid programming in the module.  

l When selecting the Alt+Shift+6 key sequence to append a prefix to a 
Parameter value, SIMPL will no longer enforce the signal validity rules (i.e 
replace spaces with _, no commas allowed etc) on the entered Prefix value.  

l When opening a file, the dialog that appears prompting the programmer to 
select a file will now default to show the file types last selected for open if the 
file was an .smw or a .umc, otherwise, the dialog will default to show all 
applicable SIMPL Windows file types (*.smw, *.umc, *.usp).  

l Fixed the processing for importing device connection logic. When device 
extenders are specified in the connection log, SIMPL will now always add the 
device extender such that any instance in the program will be left untouched. 
This includes default device extenders that have been added when the device 
was added. 

SIMPL Windows Enhancements:  

l Added support for symbols to appear under multiple categories in the Symbol 
Library tree on the Program Manager view. Programmers can now select, via 
the Program Header dialog, multiple categories under which they want the 
module to appear in the Symbol Library. However, at this time, Custom 
Category names are not supported for this multiple selection.  

l Added support for Crestron devices to appear under multiple categories in the 
Device Library tree on the Configuration Manager view. 

SIMPL+ Bug Fixes:  

l Implemented additional error handling when writing output files. 

SIMPL+ Enhancements:  

l Allow multiple categories to be assigned within #CATEGORY directive.  
l TRACE() function: This function is used for debugging to the trace window of 

Toolbox 1.08 and later. It prefaces a string with \xFA\xE0 and suffixes it with 
\xFB. For example, trace("hello") is the same as print("\xFA\xE0hello\xFB). 
Toolbox will use this insure that data printed with the trace() function always 
shows up in the trace window.  
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l #ENABLE_TRACE: Will enable trace() output, if not specified, trace() 
statements are not compiled into the final code.  

l #PRINT_TO_TRACE: If specified, all print() statements act like trace() 
statements. This is intended to be a quick way to convert all prints to the new 
trace().  

l SetByte() function: Allows setting a byte via an INTEGER variable into a 
STRING variable. 

Library Update Version 510 (Changes from 505):  

l Remove NET dialog from CNPWS-75  
l C2N-CB-TS Brightness and Bargraph Functions: Join gap now exists after first 

bargraph  
l C2N-CB-TS Brightness and Bargraph Settings: "Auto Backlight Above" 

renamed to "Min Auto Backlight"  
l C2N-CB-TS Brightness and Bargraph Settings: "Auto Backlight Below" 

renamed to "Max Auto Backlight"  
l Expose Extenders on QM-FTCC-TPS_TPS-4  
l Update Hint on TPS-6L (Cresnet)  
l Update Help ID on C2N-CB-TS Digital Inputs  
l Update Help ID on C2N-CB-TS Advanced Button Events  
l Update Help ID on C2N-CB-TS Brightness and Bargraph Functions  
l Update Help ID on C2N-CB-TS Brightenss and Bargraph Settings  
l Remove Search capabilities from CEN-IDOC, pending future firmware update 

where they may work.  
l Rename "Everything Else Text Join_fb" to "Project Name Text Join_fb" on QM-

FTCC-TPS_TPS-4  
l Expose the following models: 

¡ CEN-RGBHV8x4  
¡ CEN-RGBHV16x16  
¡ CEN-RGBHV8x8  
¡ CEN-RGBHV12x4  
¡ CEN-RGBHV12x8 

l Correct AAS models to remove "Day 3" labels.  
l INCLUDE.DAT 1.58 

¡ SetByte() function 

Fixes/Changes to 2.10.08 to 2.10.09: 

SIMPL Windows Bug Fixes:  

l Fixed error for SystemBuilder program generation. Some symbols were being 
left incomplete.  

l Fixed error in generating Connection Logic in a module for devices that have 
multiple levels of subslots. The 2nd level of subslots and below were not getting 
Virtual Device programming generated.  

l Added logic to restrict the number of SNMP devices that can be added to a 
program. The number of allowed SNMP devices is currently limited to 1. 
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SIMPL Windows Enhancements:  

l Added the version of the INCLUDE.DAT file, used by SIMPL+, to the SIMPL 
Windows Help About dialog. 

Library Update Version 505:  

l Include SNMP device  
l TPS-6L now has 4000 Serial Input Joins 

Fixes/Changes to 2.10.06 to 2.10.08: 

SIMPL Windows Bug Fixes:  

l Fixed problem in Saving a User Module to an existing file. In some cases, data 
from the existing file was being erroneously retained.  

l For time parameters of the format HH.MM.SS or MM.SS.HS or SS.HS, SIMPL 
Windows will now allow values greater than 59 in the minutes and seconds 
fields.  

l Fixed problem of not being able to open programs if the splash screen is 
disabled.  

l Fixed long delay occassionally experienced when trying to collapse (i.e. Alt -) 
inputs/outputs on symbols. 

SIMPL Windows Enhancements:  

l Updated Help/About SIMPL Windows dialog to allow user to copy the version 
information by selecting the contents of the window and hitting Ctrl-C. This 
information can then be pasted (i.e. Ctrl+V) into an ascii document (e.g. 
Notepad, Word, etc).  

l Module Header Connection Logic will now support connection logic for Device 
Extenders: 

¡ When a device is selected in the "Device Connection Logic" list, a the 
names of applicable Device Extenders will appear in the Device 
Extenders list. The programmer can then select multiple Device Extenders 
to add connection logic for, in addition to the logic added for the Device.  

¡ Device Extenders can only be selected if there is only 1 device selected.  
¡ When the programmer clicks OK on the Module Header, SIMPL Windows 

will automatically add a separate "Virtual Device For Module Connection" 
symbol for the selected device extenders. Programming will then be 
generated "Virtual Device For Module Connection" symbol(s) and the 
Define Arguments symbol. Note: the parameters added to the "Virtual 
Device For Module Connection" symbol will be in the format of: "EXT xx: 
cue". This will tell SIMPL what Device Extender to connect the logic to on 
import.  

¡ When the module is added to a program and the connection logic in the 
module is imported into the program, SIMPL Windows will add the 
specified device extenders to the selected device's symbol and program 
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the device extender appropriately. 
l For symbols whose parameter values have been defined as a list of values, the 

value displayed will now be the Label assigned to the selected value instead of 
the value itself. e.g. If a list item is presented in the drop down list as "7.1 + 4 
Stereo Rooms [1d]", that is what the programmer will see instead of the value 
1d which is what that list selection will translate to at compile/run time. 

SIMPL+ Bug Fixes:  

l Ensure that property’s Default Value is included within Property List  
l Ensure that Property’s Lower Bound is less than Upper Bound  
l Where applicable, ensure that all Property value units are of the same type  
l Updates for optimizing Dynamic string allocations 

Library Update Version 498:  

l Rename "C2N-FTB" to "C2N-FTB/C2N-FTDAC"  
l INCLUDE.DAT version 1.57: 

¡ Correct internal function that could cause Gather(), GatherByLength(), 
Lower() functions to crash (ONLY in the 1.5X line of INCLUDE.DAT - the 
earlier 1.4X versions are fine!) 

Fixes/Changes from 2.10.05 to 2.10.06 

SIMPL+ Enhancements:  

l Implement #ENABLE_DYNAMIC compiler directive. To use the "dynamic" 
keyword on arrays, this compiler directive must be present. In addition, if the 
compiler directive is present, the SIMPL+ compiler will also optimize 
intermediate temporary data structures. 

SIMPL+ Bug Fixes:  

l Correct Issues with parameter property validation. 

Library Update Version 495:  

l INCLUDE.DAT version 1.56: 
¡ If an out of bounds access is performed on dynamic arrays, it will now 

access the zeroth element in the array. This is also true for static structure 
arrays. 

l Add EQ_Preset, EQ_Preset_F to C2I-AMS-SURROUND-SOUND slot.  
l Add "QM-MD8x8-HB" to QM-MD8x8 Firmware Name list  
l Correct Help ID for QM-MD8x8 Switcher  
l Correct Help ID for QM-MD4x2 Switcher  
l Rename "CEN-IDOC" to "CEN-IDOC (without search)" and prevent it from 

dropping into new programs  
l Release CEN-IDOC revision (New device to drop in) that contains Search 
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capabilities. Requires revised CEN-IDOC firmware.  
l Release AAS-1/2/4 Revision that has new browse contexts (Jukebox & 

Simplified) as well as other enhancements. 

Special SIMPL+ Notes: The following table describes the behavior when a user 
accesses an element that is out of bounds in an array as of CUZ 4.XXX. Any out of 
bounds access will generate an error. However, depending on the type of the array 
the following can happen:  

l Scenario A: No element in the array will be modified after an error (i.e. User 
tries to read/write an element that is out of bounds).  

l Scenario B: The zeroth location will be modified or read in spite of the error. 

                            Static   Dynamic 
String Array                A        B 
Integer Array               A        B 
Long Integer Array          A        B 
Signed Integer Array        A        B 
Signed Long Integer Array   A        B 
Structure Array             B        B 

Fixes/Changes from 2.10.04 to 2.10.05: 

SIMPL Windows Bug Fixes:  

l Fixed compilation issue where Input/Output groups were not properly taken into 
account. 

SIMPL Windows Enhancements:  

l Updated Help/About SIMPL Windows dialog to allow user to copy the version 
information by selecting the contents of the version window and hitting 
CTRL+C. This information can then be pasted (i.e. CTRL+V) into an ASCII 
document (e.g. Notepad, WORD etc). 

Fixes/Changes from 2.10.03 to 2.10.04: 

SIMPL Windows Bug Fixes:  

l Fixed error in validation of percentage parameter values that was causing 
SIMPL to crash either during the entry of a percent value or, during compile if 
the parameter already had the percent value entered via an older version of 
SIMPL Windows. 

SIMPL Windows Enhancements:  

l Input/Output Groups: 
¡ Group Labels will now be displayed in bold black.  
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¡ Cues inside a group will be displayed in green.  
¡ When a group is expanded or collapsed, any other group with the same 

group label will also be expanded or collapsed. 
l Added "Goto Item (Ctl+G) option to the right click menu in the Detail View.  
l The Import Property Data dialog will now show cue names and the Short 

Description field (if available) for all items of the same type that have property 
data defined.  

l Updated Interface to Toolbox to support the Toolbox 1.07.XX release. 

Library Update Version 491:  

l Rename "RoomView 7.0" to "RoomView SE/RoomView 7.0"  
l Rename "RoomView" to "RoomView Express/RoomView 6.0"  
l Fix help file for "Serial/Analog One-Shot"  
l AMS Video Board Modification: 

¡ Add Digital Inputs: 
n Diagnostic_Mode_Enable  
n Diagnostic_Mode_Scroll_Up  
n Diagnostic_Mode_Scroll_Dn 

¡ Add Digital Outputs: 
n Diagnostic_Mode_Enable_F 

¡ Add Serial Outputs: 
n Diagnostic_Info_F$ 

l TPMC-8X Setup Extender Modifications: 
¡ Add Digital Inputs: 

n Enter Certificate Setup  
n Exit Certificate Setup 

¡ Add Digital Outputs: 
n Enter Certificate Setup_fb  
n Exit Certificate Setup_fb 

l InfiNet Offline Manager is now accessable to all users  
l INCLUDE.DAT version 1.55: 

¡ Limit dynamic strings to 65535 bytes instead of 65536 bytes. 

Fixes/Changes from 2.08.40 to 2.10.03: 

SIMPL Windows Bug Fixes:  

l Fixed SIMPL Windows hang when selecting to generate Connection Logic in a 
module for a CEN-COM.  

l Fixed problems on IP Net Address configuration dialog: 
¡ For XGEN Systems, the dialog was always giving an error stating that 

only 2 characters were allowed for the "Device ID" which is not even 
editable by the programmer.  

¡ For systems that support IP Id's or DHCP, the IP Net Address dialog was 
allowing both radio buttons for "IP ID" and "Remap this IP ID at program 
upload" to be selected at the same time. These are now mutually 
exclusive selections. 
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l Fixed parameter validity checking on data entry of parameter values (Incorrect 
units were being assigned at times, negative values were being allowed when 
they shouldn't be and fractional values were being allowed when they shouldn't 
be). The following guidelines are now being enforced by the validity checking: 

¡ Fractional values (those with "." in it) should only allow 0-9 in the values 
on either side of the decimal point.  

¡ Values specified as Hex ("h"), Decimal ("d"), or Ticks ("t") should ONLY 
allow integral values. For example, 25.2h, 25.2d, or 25.2t are all invalid.  

¡ Values specified as time ("s") or Percent ("%") are allowed to have 
fractional components, and as such should only contain the digits 0-9.  

¡ Negative Hex, Decimal, and Percentages are allowed.  
¡ Negative time is not allowed. 

l Cleaned up how SIMPL Windows deals with errors in device detection during 
an AutoFill. SIMPL Windows will now try to add devices that didn't have errors 
such as duplicate Cresnet IDs or duplicate TSIDs. Devices that do have errors 
will will be reported in the error log.  

l Fixed problem when Module Header was being used to generate connection 
logic for the TCP/IP Client device. The XGen version of the TCP/IP Client 
module was being used and as such, not all cues required by 2-series were 
being brought in to the connection logic.  

l Fixed Replace Control System errors:  
l Fixed error in replacing a control system when a new serial driver was being 

added. No serial device settings were being recorded and as such, a compiler 
error was being generated at compile time saying the serial settings were 
invalid.  

l Fixed problem in Replace Control System with devices in the new program 
getting device names from completely unrelated devices in the original 
program. Typically this would occur if the original program had more relay 
devices from the Crestron Database than there was room for in the new control 
system.  

l Fixed processing of Default Device Extenders during a replace control system. 
The default extender was only being added to the new control system if the old 
control sytem also had the same extender.  

l Fixed problem in Replace Control System where user programming on built-in 
system control modules (a.k.a OOTBF) was not always getting copied over.  

l Fixed a problem with rebuilding User and Project IR Databases on startup if 
there is no database files found. Note: due to technical constraints, this will only 
happen once the Configuration Manager view has been accessed.  

l Fixed problem on Project Header and Module Header when trying to retrieve 
the firmware version. Viewport was always being used instead of the Crestron 
Toolbox.  

l Fixed problem with comments in Program Header not copying over on a 
replace of the control system.  

l Fixed error in the System Configuration tree when right clicking on a device to 
add or replace. If there is only one potential device with which to add/replace, 
SIMPL was not recoginzing that device and as such the options to add or 
replace, in the right click menu, were not enabled and thus the programmer 
was led to believe there were no optional devices.  
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l Fixed problem with not being able to have more than 1 [~UNUSED~] parameter 
in the Default Arguments of a module.  

l Fixed problem with not being able to enter values for parameters that have 
properties defining them to be 16bit and HEX format only. The problem 
occurred when the entered value had a type specifier of 'h' at the end.  

l Fixed problem with the "Make Symbol Complete (Ctl+I) option on the right click 
menu of the Program Tree and Detail View. Not all Inputs were being 
commented out.  

l Fixed problem with no signal data being available for SIMPL Debugger.  
l Fixed crash when trying to autofill.  
l Fixed problem with Program Tree not updating addresses when accessing the 

Configuration Dialogs from the Program Tree to change network IDs.  
l Added the ability to change a module's model name on the Module Header 

Devices dialog.  
l Fixed issue in the testing done to verify if a program resynch is required. The 

test was reporting the need to resynch due to parameters that have changed 
but there weren't any parameters for the reported symbol.  

l Fixed issue with being asked twice for a password when trying to transfer a 
program via an SSL Enabled ethernet connection.  

l Fixed problem with importing default logic to some touchpanel or front panel 
devices resulting in different amounts of inputs than outputs on the touchpane-
like device symbols. Because touchpanel symbols typically will expand inputs 
along with outputs, and visa versa, the programmer was not always able to 
then collapse or futher expand the symbol.  

l Fixed problem with an "AND" symbol being added to the Logic Folder when an 
IR driver is added to the program by dragging and dropping it into the System 
Tree.  

l Fixed problem in replacing control systems when the original control system 
contained Out Of The Box Functionality. Sometimes device names in the 
converted program were given incorrect device names. 

SIMPL Windows Enhancements:  

l Removed the option to display signals in the Program Tree: 
¡ The "Don't Display Signals in Program View" checkbox on the Options-

>Preferences->General dialog was removed.  
¡ The Program Tree will no longer show Inputs, Outputs or Parameters.  
¡ The Signal Detail and Parameter Routings dialogs (available via the F2 

key), will now default to showing the selected items in the Detail View 
window. Previously, the default was to just show the signal or parameter 
in the Program Tree unless the programmer checked the box to indicate 
to also open up the associated symbol in Detail View. 

l SIMPL Windows: "Input/Output Groups": This feature will allow programmers to 
program Input and/or Output Groups in a module. When the module is then 
used in a program, the Detail View, users can Expand or Collapse the 
Input/Output Groups allowing them to see all cues inside the group or not. 

¡ When using the module as a symbol in the program: 
n Groups, when programmed, will be required to have group labels. 
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The labels will be displayed, in blue, inside the symbol box where 
cues are currently shown in red and should give the programmer 
some type of indication as to the purpose of the group.  

n If a group is currently collapsed (default state), there will be a "+" 
displayed in place of a signal name right above the first cue in the 
group (next to the group label shown in blue inside the symbol box). 
Clicking on the"+" will expand and show the cues that are in that 
group.  

n If the group is currently expanded, the input/output cues and 
programmed signals in that group will be shown. There will be a "-" 
displayed in place of a signal name right above the first cue in the 
group (next to the group label shown in blue inside the symbol box). 
Clicking on the "-" will collapse the group and show just the "+" next 
to the group label.  

n If a symbol has expandable input/output groups, there will be options 
on the Right Click menu to Expand All Groups (ALT+F10) or to 
Collapse All Groups (ALT+F11) in that symbol.  

n If the programmer selects and right clicks on the "+" or "-" (i.e. the 
beginning of a group), a menu will appear with actions that can be 
performed on the inputs/outputs within that group (e.g. copy all 
signals in the group, paste into this group, delete all signal in this 
group, select all signals in this group etc), in addition to actions that 
may be taken on the symbol as a whole (e.g. Find tree node, search 
and replace, set watch, etc).  

n Programmers can also drag and drop signals into a group by 
dragging onto the "+" or "-" indicators.  

n When a program is saved, the state (i.e. expanded or collapsed) will 
be saved for each group and thus, when the program is re-opened, 
groups will be shown in their last state. 

¡ When programming a Module: 
n Signal Group Tags are entered as [~BeginGroup~]GroupLabel and 

[~EndGroup~]GroupLabel. Note: the GroupLabel is programmer 
provided and optional on the [~EndGroup~].  

n Signal Group Tags are only valid on the Argument Definition symbol.  
n There is a Right Click menu option to "Create Input/Output Group". 

This will give the programmer the options to: Insert Empty Group, 
Insert Group Begin, Insert Group End. If inserting an empty group, a 
dialog will prompt the programmer for the Group Label. All items will 
be inserted below the currently selected input/output item. 

l Added "Import" buttons on the Input/Output/Parameter Property dialogs. When 
programming properties for the Argument Definition symbol in a module, 
clicking on the Import button will display the cues of all the same type items that 
currently have property definitions. The programmer can then select one of the 
shown cues and the property data from the selected item will be imported into 
the current property dialog.  

l CTRL+SHIFT+B will fill all the empty signals on a symbol in detail view with the 
default signal name (the default signal name is the name that is assigned when 
hitting enter twice on a blank signal.)  
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l Changed the "Rebuild User and Project Databases" option on the Options 
menu to "Rebuild User and Project IR Databases"  

l SIMPL will now rebuild the User IR Database if the programmer changes the 
User Database directory location via the Options->Preferences->Directories 
dialog. Note: due to technical constraints, this will only happen once the 
Configuration Manager view has been accessed.  

l Made sure that SIMPL is rebuilding User and Project IR Databases on startup if 
there is no database found but there are .ir files. Note: due to technical 
constraints, this will only happen once the Configuration Manager view has 
been accessed.  

l Selecting Refresh (F5) from the View menu will now refresh (i.e. re-read) the 
User and Project IR Databases in the Device Library tree, in addition to 
refreshing the Symbol Library and the Program tree. Note: due to technical 
constraints, this will only happen once the Configuration Manager view has 
been accessed.  

l Changed the "Rebuild All" option on the Project menu in SIMPL Windows, and 
on the Build menu in SIMPL+, to now read as "Recompile All".  

l Added support of multiple iodev.tio and symlib.tio files.  
l Updated the Help About dialog to now show Database, Library and Toolbox 

versions in a scrollable window.  
l If a device in an iodev.tio file requires a minimum version of SIMPL Windows, 

and the current version of SIMPL Windows is not new enough, the device will 
not be loaded into the device library.  

l Better VTPro-e Integration:  
l Will now access and/or launch the last run version of VTPro-e instead of the 

last installed. 
¡ Added option to Program Tree right click menu to Launch VTPro-e if a 

device has a VTPro-e project associated with it. When this option is 
selected, the last run version of VTPro-e will start up with that project.  

¡ Open project in VTPro-e: Will launch VTPro-e with the selected project in 
addtion to including the file in SIMPL archives.  

¡ Updated the UI Project configuration dialog to have the following options: 
n Include in archives: This is the default option and will basically use 

the selected project for documentation purposes. The selected 
project will be included in in SIMPL archives of the project.  

n Import joints: This will import all applicable Join data from the 
selected project in addtion to including the file in SIMPL archives.  

n Import joins and open project in VTPro-e: This will import all 
applicable Join data from the selected project and will launch VTPro-
e with the selected project in addtion to including the file in SIMPL 
archives. 

l When the Viewport application is started from SIMPL Windows, programmers 
will now be able to switch between the Viewport window and SIMPL Windows 
without having to first close Viewport.  

l Added logic to make sure Device Extenders cannot be added to symbols undr 
the Logic Folder.  

l Added enhancement to Replace Control System to try to copy programming to 
devices at the same address in the new program if possible. I.e. If an FM Tuner 
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card is at Slot3.Slot1.Slot3 in the original program, then if the new control 
system has the same extension cards at the same slots, try to copy the 
programming to the FM Tuner card at Slot3.Slot1.Slot1. 

SIMPL+ Bug Fixes:  

l Correct Issues with parameter properties with "unitTicks" and "unitCharacter"  
l Correct Issues with compilation when a list of values is used.  
l FindNoCase() corrected to be case insensitive. 

SIMPL+ Enhancements:  

l Allow Long Integers within Wait and Delay Functions 

Library Update Version 478:  

l INCLUDE.DAT version 1.53: 
¡ Modified all truncation issues for dynamic arrays to be Warnings instead 

of Errors. The warnings now include the old and new array sizes.  
¡ Resolved issues with losing data in a String or String Array when resizing 

and increase/decrase the number of rows/columns within the array.  
¡ Resizing a Structure Array to 0 will leave one element in structure. This 

has been done to allow out of bounds access to the structure array. When 
an out of bounds access occurs, the 0th element is used for that access 
(read and write).  

¡ Added a separate error printout for an empty structure array access (vs an 
out of bounds one).  

¡ Fix issue with RemoveByLength() which could cause memory corruption 
on the control system if the # of bytes to remove is greater than the 
current length of the string passed into the function. 

Fixes/Changes from 2.08.40 to 2.10.00: 

SIMPL Windows Bug Fixes:  

SIMPL Windows Enhancements:  

l SIMPL Windows: Cleaned up how signal names are generated when adding 
default logic for a device. Automatically generated signal names should have 
underscores (_) separating the programmer provided prefix, any slot 
designation that is added by SIMPL Windows, and the cue name that is used to 
create the signal name.  

l SIMPL Windows: Added Compiler Preference options to say whether or not to 
generate the Crosspoint Reference file and whether or not to launch Notepad 
and display that file at the end of a compile.  

l SIMPL Windows: Changed icon and subfolder name used to contain and 
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represent the OOTBF Logic modules. The previous "Out Of The Box 
Functionality" folder will now be named "System Control". Also, the icon for the 
module contained within that folder will now be the standard Crestron Module 
icon instead of the "Lock" icon.  

l SIMPL Windows: Internal compiler optimizations for slightly faster 2 Series 
compiles.  

l SIMPL Windows: Improved the import of VTPro-e project join data. Any join in a 
VTPro-e project that would translate to a signal in a SIMPL Windows project will 
now get imported and programmed. Will require VTPro-e version 3.07.00.07 or 
greater and Crestron Database 18.07.05 or greater. 

Fixes/Changes from 2.08.39 to 2.08.40: 

SIMPL Windows Bug Fixes:  

l Fixed a potential crash when trying to compile System Builder projects that 
have AAE for AMS Rooms 1-6, 7-12, or 13-18. 

Library Update 484:  

l Included to support above SIMPL Windows Bug Fixes. 

Fixes/Changes from 2.08.38 to 2.08.39: 

SIMPL Windows Bug Fixes:  

l SIMPL Windows: Fixed problem that was not allowing D3Pro to add RF 
Thermostats to anything but the first gateway in a program. 

Library Update 481  

l Fix MPS-200 System Builder model compilation issue. 

Fixes/Changes from 2.08.37 to 2.08.38 - PUBLIC WEB SITE 
RELEASE: 

SIMPL Windows Bug Fixes:  

l Fixed a problem with not being able to import device connection logic from user 
modules. The right-click menu was not being enabled when it should have 
been. 
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Library Update 472  

l Correct issue with AES and using database modules through System Builder to 
take advantage of new I/O on the AM & FM symbol. 

Fixes/Changes from 2.08.36 to 2.08.37 - PUBLIC WEB SITE 
RELEASE: 

SIMPL Windows Bug Fixes:  

l Fixed a problem with data integrity errors occasionally being introduced with 
replacing control systems via System Builder.  

Library Update Version 470:  

l "C2N-TXM" renamed to "C2N-TXM (old)" and moved to "Cresnet Control 
Modules (Discontinued)"  

l New model of "C2N-TXM" added to "Cresnet Audio Modules". This has some 
extra joins over the original C2N-TXM model. These joins require C2N-TXM 
firmware 1.15.00 or later to function, and will be ignored on older firmware revs. 

¡ New Digitial Inputs: 
n FocusOnlyEnable  
n SigStrengthDisable  
n ConcatSerialEnable  
n SkipCurrentChannel  
n RemoveSkipCurrentChannel  
n ReportSkippedInGuide  

¡ New Digital Outputs: 
n Power_F  
n Mute_F  
n CategoryMode_F  
n ProgMode_F  
n DiagnosticMode_F  
n SigStrengthDisable_F  
n CurrentChannelSkipped_F  

¡ New Analog Inputs: 
n GuideChMax  
n GuideChMin  
n PresetMode  

¡ New Analog Outputs: 
n PresetMode_F  

l Rename "ADG One-way serial driver" to "ADG/AMS One-way serial driver"  
l Correct power factor on MPS-100 models  
l Correct power factor on MPS-200 models  
l Revise MPS-200 Compiler Info to require 3.157 CUZ or later.  
l Correct issue with the following devices not being able to drop onto a PAC2M 
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Ethernet slot:  
l UPX-2_1GB (Ethernet) Universal Presentation Processor  
l C2N-FT-TPS4 (Ethernet)  
l TPMC-4X  

Fixes/Changes from 2.08.35 to 2.08.36: 

l SIMPL Windows: SIMPL compiler no longer flags duplicate crosspoints if the 
EquipID or ControlID is set to 0. The Crosspoint output text file also now 
includes a note that EquipID's or ControlID's set to 0 are not routeable. 

Fixes/Changes from 2.08.34 to 2.08.35: 

l SIMPL Windows: Fixed SIMPL Debugger scrolling and window size issues.  
l SIMPL Windows: Update to library 465 (Includes updates to XM portion of 

ATC-AMFMXM). 

Fixes/Changes from 2.08.33 to 2.08.34: 

l SIMPL Windows: Fixed issue with temporary paths that caused Crestron 
SIMPL+ modules to be compiled incorrectly (started in 2.08.33).  

l SIMPL+: _SKIP_, #DIGITAL_EXPAND, and #ANALOG_SERIAL_EXPAND 
keywords are no longer CUZ version dependent. 

Fixes/Changes from 2.08.32 to 2.08.33: 

l SIMPL Windows: If the system has Crosspoints used, a file {filename}
_CrosspointList.txt will be output to the project directory. i.e. if the SMW 
filename is MyProject.smw, the output file is MyProject_CrosspointList.txt. This 
file contains list of all Control Crosspoint Routing symbols in the program and a 
seperate list of all Equipment Crosspoint Routing symbols in the program. Each 
list is sorted by Crosspoint ID number. For now, the programmer needs to look 
in the project directory for the file and open it with a text editor such as 
Notepad. An example is: 

Crosspoint listing for C:\projects\crosspoints\MyProject.SMW 
 
Equipment Crosspoint Routing                                                            EquipID
===============================================================================================
S-2                                                                                     25
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S-3                                                                                     26
S-1.1.1 in macro S-1 (Module File C:\projects\crosspoints\xpoint macro.umc)             50
S-1.1.2 in macro S-1 (Module File C:\projects\crosspoints\xpoint macro.umc)             50
 
Control Crosspoint Routing                                                              ControlID
=================================================================================================
S-1.1.3 in macro S-1 (Module File C:\projects\crosspoints\xpoint macro.umc)             60

l SIMPL Windows: If the program contains a duplicate ControlID among the 
Control Crosspoint Routing symbols, all Control Crosspoint Routing symbols 
with that ControlID will be shown in the Error Log.  

l SIMPL Windows: If the program contains a duplicate EquiplID among the 
Equipment Crosspoint Routing symbols, all Equipment Crosspoint Routing 
symbols with that EquipID will be shown in the Error Log.  

l SIMPL Windows: Fixed problem with SIMPL Debugger dialog not having any 
menus and not being able to resize the data displays. 

Fixes/Changes from 2.08.31 to 2.08.32: 

l SIMPL Windows: Speed up SIMPL Windows startup time by improving 
efficiency of reading in OOTBF data into the Symbol Library.  

l SIMPL Windows: Will now save the position of the SIMPL Debugger window.  
l SIMPL Windows: Fixed issues with windows that were last displayed on a 2nd 

monitor not being accessible if only 1 monitor is in use.  
l SIMPL Windows: Fixed problem where selecting "No Selection" for the "Add 

Front Panel Definition For Selected Control System" option on the Module 
Header Connection Logic dialog was not being retained.  

l SIMPL Windows: Fixed problem where removing Models from a Module Header 
was not getting removed from the module when it is a symbol.  

l SIMPL Windows: Added logic to try to keep as much Input/Output/Parameter 
Property data as possible when a signal name is changed. If the cue type 
changes, then only the Short Description, Full Description and Notes fields will 
be retained.  

l SIMPL Windows: Fixed Replace Control system error reporting such that, if the 
new control system has an Ethernet Card, an error message won't be entered 
into the Error Log indicating that the original program's Ethernet Card could not 
be copied over. 

Fixes/Changes from 2.08.30 to 2.08.31: 

l SIMPL+: Fix issue where targets would be rebuilt even if they were up to date.  
l SIMPL Windows: Correct crash on exit if Toolbox was not installed. 
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Fixes/Changes from 2.08.29 to 2.08.30: 

l SIMPL Windows: Fixed problem with copying and pasting from one instance of 
SIMPL Windows to another instance. In some cases, it appeared as though the 
data wasn't pasted and in other cases, the ability to copy and paste from any 
application was no longer working. This has been resolved.  

l SIMPL Windows: Fixed problem with wrong Help topic display from Front Panel 
Editor. 

Fixes/Changes from 2.08.28 to 2.08.29: 

l SIMPL Windows: Fixed the intermittent crash when trying to start SIMPL 
Windows when database 18.7.0 or later is installed.  

l SIMPL Windows: Updated SIMPL Windows and SIMPL+ icons.  
l SIMPL Windows: The About dialog will now display build date and build 

number. 

Fixes/Changes from 2.08.27 to 2.08.28 - PUBLIC WEB SITE 
RELEASE: 

l SIMPL Windows: Fixed problem in AutoFill for not adding control systems with 
OOTBF correctly.  

l SIMPL Windows: Fixed problem on Parameter Properties dialog for default 
Numerical value. The default was showing up as percentage. It is now Decimal.  

l SIMPL Windows: Fixed problem where the "Open All Symbols" button on the 
"Show Details" dialog was not working if the Details dialog was displayed by 
clicking on a message in the error log.  

l SIMPL Windows: Fixed a problem during autosave of a module. If a module 
has blank inputs, a Message was being displayed to warn the programmer to 
add programming to the blank items before using the module in a program. 
Error messages should never be displayed during autosave. In addition, if the 
programmer let the Message display without dismissing it before the next 
autosave, the module file was getting wiped out and SIMPL would sometimes 
crash.  

l SIMPL Windows: Added a descriptive label to the display of Symbol and Device 
library versions. This can be used to help further identify the purpose of a 
particular Library version.  

l SIMPL Windows: Fixed problem with the Create Archive function not including 
SIMPL+ Library files.  

l SIMPL Windows: Enhanced the Set/Clear Watch capability:  
l In the Program Tree, a programmer can now right click and select to "Set 

Watch on all signals in folder" or "Clear Watch on all signals in folder". These 
options will set or clear the Watch status of all signals on all symbols located in 
the selected folder and below.  
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l In the Detail View, a programmer can now right click and select "Set Watch on 
all signals in this symbol" or "Clear Watch on all signals in this symbol". These 
options will set or clear the Watch status of all signals in the selected symbol 
window.  

l SIMPL Windows: Fixed a problem when importing VTPro-e projects. After an 
import of the join data, the Touchpanel Symbol, or the Virtual GUI symbol if 
importing for Virtual GUI support in a module, lost all of it's Serial Inputs. 

Fixes/Changes from 2.08.26 to 2.08.27: 

l SIMPL Windows: Fixed potential crash with AES systems on compilation if a 
system with an LCD front panel (i.e. Pro2, Rack2, etc.) was converted to an 
AES.  

l SIMPL Windows: Fixed problem with autofill not adding OOTBF Control 
Systems.  

l SIMPL Windows Will automatically limit signal names to 256 or less characters 
to avoid system crashes due to processing longer names.  

l SIMPL Windows: Added access to the Device Configuration dialogs from the 
Program Tree from the Right Click menu.  

l SIMPL Windows: Fixed a problem in generation of the default device 
connection logic for modules. Some buffers were getting too many outputs that 
could not be deleted and thus, were causing compilation issues.  

l SIMPL Windows: Changed the criteria for which devices can be selected to 
generate Device Connection Logic on the Module Header's Connection Logic 
dialog. This list will no longer contain non-Crestron or non-ethernet devices that 
may have shown up in the list in previous SIMPL Windows versions. The 
reason these used to be avaialable was if they were a subslotted device to a 
Cresnet or Ethernet device. Now, only the top level Ethernet or Cresnet 
Devices will be avaialable and, if the selected device is subslotted, then the 
subslot device(s) will automatically have programmng generated. This list will 
also exclude devices that cannot be automatically programmed to have 
"Connection Logic" such as Gateways or Remote Control Systems. Reminder: 
Any connection logic for Serial drivers or IR devices must still be programmed 
manually via use of the Virtual IR and Virtual Serial symbols. Refer to the on-
line help for instructions on how to program those symbols.  

l SIMPL Windows: Created a new folder to be located beneath the SIMPL 
Windows installation folder. This folder, "smpwinWk" will be a location for 
temporary files created during SIMPL Windows processing. This should 
minimize the effect that McAfee Anivirus version 7.0 and above is having on the 
Windows "Temp" folder that was causing some compilations to fail.  

l SIMPL Windows: Changed Import Archive dialog to automatically default the 
Destination Directory to the directory of the selected archive file.  

l SIMPL+: Fix issue that caused the [Reference Name] parameter to be 
removed. Existing SIMPL Windows programs will put up messages about the 
modules needing to be resynced. 
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Fixes/Changes from 2.08.25 to 2.08.26 - PUBLIC WEB SITE 
RELEASE: 

l SIMPL Windows: Fix crash with X Generation / CNMS generation compilation 
(problem introduced after 2.08.14 release).  

l SIMPL Windows: Fixed problem with Detail View display of the RoomView 7.0 
symbol.  

l SIMPL Windows: Will now always show the "Include Standard Commands" 
checkbox on the Module Header->Device Support dialog. If this is a brand new 
module and the very first time the Module Header is being edited, the "Include 
Standard Commands" checkbox will be enabled if the selected Device Family/ 
Device Type combo have standard commands. At all other times this checkbox 
will be grayed. For modules created with SIMPL Windows 2.08.26 or greater, 
this checkbox will also reflect whether or not the module has already been 
programmed with Standard Commands. 

Fixes/Changes from 2.08.24 to 2.08.25: 

l SIMPL Windows: Fixed error when trying to drag and drop RF device onto a 
Gateway using the top Control System view. If the default RFID was occuupied, 
no attempt was made the programmer was informed that the device could not 
be added. The device will now be added to the next available port.  

l SIMPL Windows: Fixed error with signal names created during automatic 
generation of programming for modules with Device Connection Logic. This 
was causing signals with no driving source.  

l SIMPL Windows: Changed the way the programmer is prompted if an operation 
will affect Input/Output/Parameter property definitions during the programming 
of a module. In past versions, if the operation (i.e. delete signal, append 
suffix/prefix, rename signal) is to be performed on more than 1 item at a time, 
the programmer was prompted for each item. Now, only 1 prompt will appear 
and the programmer has the option to either Continue or, Cancel the operation 
entirely. 

Fixes/Changes from 2.08.23 to 2.08.24: 

l SIMPL Windows: If a module is selected to have Device Connection Logic via 
the Connection Logic page of the Module Header, SIMPL Windows will now 
automatically generate all programming required for use in the SystemBuilder 
"User Database". The generated programming provides a means for the 
Programmer to interface with the device. Library Update 444: MPS-100 
Database tag change. 
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Fixes/Changes from 2.08.22 to 2.08.23: 

l SIMPL Windows: Fixed issue with Minimizing SIMPL Debugger window and not 
being able to redisplay. Instead of the minimization putting a task box into the 
Windows Taskbar, what Windows does is create a "floating" task box. This 
floating task box can become easily lost and thus makes it very difficult to 
restore the SIMPL Debugger window. Now, the programmer can always restore 
the SIMPL Debugger window by clicking on the SIMPL Debugger Toolbar 
button.  

l SIMPL Windows: Fixed errors in the AutoTile mode for Detail View. Pressing 
the Tile Vertical or Tile Horizontal button on the Toolbar was forcing the 
AutoTile mode to be set when it should have been just a one time tiling. Now, 
the toolbar buttons are one-time Tile requests and will only tile the current 
symbols in Detail view. These buttons are the same as "Tile Horizontal" and 
"Tile Vertical" options on the View menu. If the programmer wishes every 
symbol to be added to the Detail view to automatically be tiled Horizontal or 
Vertical, they must go to the View menu and make the appropriate selection. 
Nothing else should cause selection of an Auto Tile mode.  

l SIMPL Windows: Fixed error where Device Configuration dialog was not 
allowing Device Location to be cleared once there was a value entered.  

l SIMPL Windows: Fixed problem where certain User and/or Project IR files files 
could not be opened during compilation.  

l Library Update 443: 
¡ Changes to "TPMC-15/17-CH" System2 Reserved Joins", "TPMC-15/17-

QM" System2 Reserved Joins": 
n Add (Digital) "Hard Key Bklt Brt Up"  
n Add (Digital) "Hard Key Bklt Brt Dn"  
n Remove (Digital) "Save and Reboot", "Save and Reboot_fb"  
n Remove (Digital) "Show System Bar", "Show System Bar_fb"  
n Remove (Digital) "Hide System Bar", "Hide System Bar_fb"  
n Add (Digital) "Standby"  
n Add (Digital) "Enter Standby Timeout Setup", "Enter Standby 

Timeout Setup_fb"  
n Add (Digital) "Exit Standby Timeout Setup", "Exit Standby Timeout 

Setup_fb"  
n Add (Analog) "Hard Key Bklt Brt", ""Hard Key Bklt Brt_fb"  
n Changes to "TPMC-15/17-CH Video Properties Reserved Joins", 

"TPMC-15/17-QM Video Properties Reserved Joins":  
n Remove (Digital) "Freeze SVID-1 On", "Freeze SVID-1 On_fb"  
n Remove (Digital) "Freeze SVID-1 Off", "Freeze SVID-1 Off_fb"  
n Remove (Digital) "Freeze SVID-2 On", "Freeze SVID-2 On_fb"  
n Remove (Digital) "Freeze SVID-2 Off", "Freeze SVID-2 Off_fb"  
n Remove (Digital) "Freeze Composite-1 On", "Freeze Composite-1 

On_fb"  
n Remove (Digital) "Freeze Composite-1 Off", "Freeze Composite-1 

Off_fb"  
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n Remove (Digital) "Freeze Composite-2 On", "Freeze Composite-2 
On_fb"  

n Remove (Digital) "Freeze Composite-2 Off", "Freeze Composite-2 
Off_fb"  

n Remove (Digital) "Freeze YPbPr-1 On", "Freeze YPbPr-1 On_fb"  
n Remove (Digital) "Freeze YPbPr-1 Off", "Freeze YPbPr-1 Off_fb"  
n Remove (Digital) "Freeze YPbPr-2 On", "Freeze YPbPr-2 On_fb"  
n Remove (Digital) "Freeze YPbPr-2 Off", "Freeze YPbPr-2 Off_fb"  
n Add (Digital) "Freeze On", "Freeze On_fb"  
n Add (Digital) "Freeze Off", "Freeze Off_fb"  
n Add (Digital) "Video Fast Lock", "Video Fast Lock_fb"  
n Add (Digital) "Video Slow Lock", "Video Slow Lock_fb" 

l Change name of "RoomView Scheduling" extender to "RoomView Scheduling 
Data"  

l Change cues in "RoomView Scheduling" extender: 
¡ "RequestSchedule$" to "ScheduleQuery$"  
¡ "ReceivedSchedule$" to "ScheduleResponse$"  
¡ "MeetingCreated$" to "CreateResponse$" 

Fixes/Changes from 2.08.20 to 2.08.22: 

l SIMPL Windows: Fixed "Display OOTBF Programming" such that, when 
OOTBF Programming is hidden, there will not be huge grey areas in the 
symbols where the OOTBF Programming would normally be. Also fixed some 
issues with being able to navigate around such symbols (i.e. The UP/Down 
arrows were not always going to the next visible Input/Output) and displaying 
the correct curson when trying to drag and drop items onto symbols with 
OOTBF programming.  

l SIMPL Windows: Fixed problem with not being able to drag signals onto a 
Symbol that has OOTBF Programming.  

l SIMPL Windows: Fixed problem with Detail View's Goto Item (Ctl+G) not 
showing the correct starting item.  

l SIMPL Windows: Added ability, in the Detail View's Goto Item (Ctl+G) to enter 
a string and go to the first occurrance where a cue contains that string. Future 
enhancements will include being able to "Find Next" cue with entered text.  

l SIMPL Windows: Added Minimize/Maximize buttons to SIMPL Debugger 
window.  

l SIMPL Windows: Fixed problem that was causing User Modules created via 
System Builder's "User Database -\> New Serial Device", to have ambiguous 
signals and as such, projects with those devices/modules would not compile.  

l SIMPL+: Made improvements to the Function Search list. 

Fixes/Changes from 2.08.19 to 2.08.20: 
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l SIMPL Windows: Fixed crash that would occur if you have a protected control 
system and try to delete any symbol that is showing in Detail View.  

l SIMPL Windows: Fixed problem with Highlighted signals not showing up on 
Print Preview or printouts.  

l SIMPL Windows: Fixed problem with not being able to enter a "//" signal on an 
Analog or Serial Buffer unless there was a signal already connected to the 
opposite side. 

Fixes/Changes from 2.08.18 to 2.08.19: 

l SIMPL Windows: For systems that have Out Of The Box Functionality (OOTBF) 
such as the AES, AADS, AADS-XM and MPS-100, programming associated 
with the OOTBF processing can now be hidden via a new option, "Display 
OOTBF Programming", on the Options->Preferences->General dialog. This 
programming, when visible, will appear as signal names in grey. These signals 
cannot be deleted, renamed, copied, or replaced.  

l SIMPL Windows: If a file is in the user's Temp directory and cannot be opened 
due to Read-Only protections, SIMPL will now attempt to reset those 
protections. This is only for files that are created and used by SIMPL Windows.  

l SIMPL Windows: Added support of converting "TP GUI Transport font" 
characters in text assigned to objects imported from a VTPro-e project. The 
characters in this font were being converted to part of the signal name and as 
such, some signals were getting illegal characters in their names. Also added 
support to import joins assigned to Hex Gauge and Clock objects. Note: VTP 
file import still does not include all joins that may be assigned to an object but, a 
more robust import is planned for the future. When objects are imported and 
signals are created, the basic structure of the signal name (with deviations 
based on the actual objects of course) is: page name-Object type_object 
text_join number.  

l SIMPL+: Fixed typo in Template. 

Fixes/Changes from 2.08.14 to 2.08.18: 

l SIMPL Windows: Fixed errors when Replacing Control Systems: When trying to 
replace by dragging a control system from the Device Library tree to the Control 
System picture in the upper right windows, default logic modules were being 
added when they shouldn't have been.  

l Fixed an error in Replace Control System that was causing SIMPL Windows to 
crash on occasion.  

l SIMPL Windows: Fixed crash when trying to get Firmware Version on Program 
and Module Header dialogs if could not communicate with the device.  

l SIMPL Windows: Made sure that any Toolbox Session that is opened by a 
toolbox related task in SIMPL Windows, is closed at the end of the task such 
that viewport functions will still operate if requested by Viewport standalone or 
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other applications that may be using Viewport.  
l SIMPL Windows: Fixed the flickering of the Detail View when moving or 

resizing symbol windows. This fix may result in the re-introduction of the 
problem where some symbols may 'freeze' up when scrolling the detail view 
window. This typically would happen if a symbol is only partially shown and 
then scrolled out of and then back into partial view. However, the flickering 
problem was worse and more persistent.  

l SIMPL Windows: Fixed a few issues with the Device Support dialog of the 
Module Header: 

¡ If a Device Family and a Device Type was selected and the "Include 
Standard Commands" check box appears, selecting "No Selection" for 
Device Family would not remove the "Include Standard Commands" 
checkbox. This is now fixed.  

¡ Selecting "No Selection" for Device Type was not being recalled next time 
the Module Header was edited.  

¡ Entering in a value for Device Family, Device Type or Manufacturer was 
not being recalled the next time the Module Header was edited.  

¡ The option for "Filter Templates by Family" was not being saved the next 
time the Module Header was edited. 

l SIMPL Windows: Fixed error in "Convert To Module" where, if the Control 
System has Out Of The Box Functionality (OOTBF), the associated OOTBF 
symbols and signals were still included in the module and could never get 
deleted.  

l SIMPL Windows: Fixed problem with Detail View's GoTo Item (Ctl+G) not going 
to the correct output items.  

l SIMPL Windows: Fixed problem with multiple "Synch Signals?" dialogs being 
displayed if programmer starts SIMPL Debugger more than once in a SIMPL 
Windows session.  

l SIMPL Windows: Help for SIMPL Debugger (by hitting F1) is now available. 
This will be in Toolbox 1.04.10 or greater.  

l SIMPL Windows: Removed the ability to delete the control system from a 
program. This is due to the complexity of Control Systems with Out Of The Box 
Functionality. If a programmer wishes to change Control System, just replace 
the Control System if the programmer does not want to lose the logic. Or, 
create a new program with the new Control System. The programmer may also 
go to the File menu and select to Convert the program to a Module.  

l SIMPL Windows: Added faster signal connection processing for speedier 
program generation in System Builder and D3Pro.  

l SIMPL+: Fixed bug that caused issues entering a [Reference Name] or 
compiling a project that had a [Reference Name] parameter previously defined.  

l SIMPL+: Fixed _SKIP_ bug where _SKIP_[1] would be written. This bug would 
only occur if both ANALOG and STRING Inputs/Output variables were being 
declared. This also affected the expansion of Input/Output Arrays. Library 
Update 428  

l Update C2N-IRGW Firmware Name for Autofill  
l Expose "User Event Logger" Symbol (allows notice/warning/error to be inserted 

into the 2 Series message log from a user application from SIMPL)  
l Add standard helpers to C2N-FTB  
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l Add "Virtual GUI for Module Connection" 

Fixes/Changes from 2.08.13 to 2.08.14 - PUBLIC WEB SITE 
RELEASE: 

l Changes to SIMPL Windows icons, splash screen, and Help -> About screen.  
l Add F11 Hot Key in SIMPL+ GUI for Checking Syntax. 

Fixes/Changes from 2.08.10 to 2.08.13: 

l SIMPL Windows: Starting the SIMPL Debugger no longer asks for which file to 
load.  

l SIMPL Windows: Replace Control System Issue. Resolved a few issues in 
Replace Control System if the current control system and/or the new control 
system have default logic modules: 

¡ If replacing a system that has an Out Of The Box Functionality (OOTBF) 
module, programming that may have been added to the OOTBF symbol 
was not getting copied over. User generated programming will now get 
copied over.  

¡ Fixed problem when replacing systems with non-protected default logic 
modules, with the same control system. The error was that 2 copies of the 
default logic module were being added to the the resulting program: 1 
instance had all teh appropriate progamming; the 2nd instance was 
empty. Now, only one copy of the logic symbol will be in the resulting 
program with all the appropriate programming.  

¡ If replacing a control system that had a non-protected default logic 
module, with a different control system, the non-protected default logic 
module will now get copied over and will be commented out. This way, the 
programmer can salvage any of the programming that might have been 
done in the older system. The Error Log will no longer show messages for 
the protected signals/symbols that didn't get copied over. 

Fixes/Changes from 2.08.09 to 2.08.10: 

l SIMPL Windows: Fixed error with Tile Vertical and Tile Horizontal selections 
not being remembered when SIMPL closes.  

l SIMPL Windows: Fixed error in Configuration Manager on the Configuration 
Tree where programmer was not given the C2-ENET1 card as an option for 
replacement when the current card is C2-ENET2. This was only an error in 
what the Replace Device dialog was displaying as valid devices for 
replacement.  

l SIMPL Windows: Fixed errors in Replace Control System with trying to replace 
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with an AADS or MPS-100 control systems.  
l SIMPL Windows: SIMPL debugger is now fully functional from the Toolbar in 

SIMPL Windows. The toolbar button is same as was used for Test Manager. 
Test Manager was moved to the Tools->Legace Device Support menu.  

l SIMPL Windows: CTRL+G in Detail View should now be fully functional. This 
hotkey can be used to jump to specific Inputs, Parameters or Outputs on the 
symbol. The number to enter should be based on the actual Input, Parameter 
or Outputs shown in the Detail View window. If a symbol is tri-listed, the number 
entered should be relative from the start of the selected list (i.e. to Goto the 3rd 
Analog Input, the programmer should select Inputs, Analog and enter the value 
of 3).  

l SIMPL Windows: Fixed problem with front panel page flips.  
l SIMPL Windows: Correct "RF Dialog" to properly read "RF" and not "RF/IR." 

Fixes/Changes from 2.08.08 to 2.08.09: 

l SIMPL Windows: The "Test manager" button on the toolbar will now launch the 
new SIMPL Debugger (will need toolbox version 1.04.00 or later)  

l SIMPL Windows: Fixed address assignment of Cresnet devices resulting from 
an Autofill. Devices were being added to the base 10 address instead of the 
Hex address.  

l SIMPL Windows: Fixed error with General Preferences setting of "Don't show 
viewport toolbar button" not being remembered.  

l SIMPL Windows: Fixed SIMPL crash when trying to do an autofill while control 
system is in PassTo mode.  

l SIMPL Windows: Added "Import User Interface Logic" support to subslotted 
devices that have User Interface devices below them.  

l SIMPL Windows: Fixed problem with Front Panel page flip operations no longer 
working in projects compiled under 2.08.XX.  

l SIMPL Windows: Fixed problem with objects over hard buttons on LCD front 
panels not triggering the associated Join number (a problem only from 2.08.XX)  

l SIMPL Windows: Fixed error in signal typing on signal connections when 
symbols, such as an Analog Buffer, require both the input and it's 
corresponding output to be of the same type but, before signals are connected, 
the type can one of a few types.  

l SIMPL Windows: Added logic to support updated versions and backwards 
compatibility of the AES "Out Of the Box Functionality" module.  

l SIMPL Windows: Update the CTL+G ("Goto Input/Paramter/Output" dialog) to 
be more flexible.  

l SIMPL Windows: Fix compilation issue for CNMS/CNRACK control systems 
that would cause miscompilations of relay & digital input/output cards. Library 
Update 416 includes the following: 

¡ AADS control system model  
¡ AADS-XM control system model  
¡ PAC2M control system model  
¡ RoomView 7.0 model  
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¡ CEN-TIA (Cresnet) model  
¡ CEN-TIA (Ethernet) model  
¡ TPMC-8X model (Note: This model does NOT have panel-specific 

extenders as of this update)  
¡ SW-WMC (Note: No help available as of this update) 

Fixes/Changes from 2.08.07 to 2.08.08: 

l SIMPL Windows: Fixed error in saving list of Target Control Systems for a 
module that was causing Simpl Windows to crash.  

l SIMPL Windows: Added ability to import Front Panels from protected Modules.  
l SIMPL Windows: Fixed errors in Importing Front Panels from modules.  
l SIMPL Windows: Fixed errors in importing User Interface Connection and 

Device Connection logic.  
l Library Update 411: 

¡ CEN-TIA model  
¡ PAC2M model  
¡ AADS-XM model  
¡ AADS model  
¡ MPS-100 model 

Fixes/Changes from 2.08.06 to 2.08.07: 

l SIMPL Windows: Symbol Tree Category selection on the Module Header 
General dialog will now display all Custom Categories currently loaded into the 
Symbol Library.  

l SIMPL Windows: Fixed error with using F4 to autoname signals based on a "//" 
signal. If the cue types were different, the autonaming function would terminate 
instead of placing a "//" on all the selected inputs/outputs.  

l SIMPL Windows: Fixed error in function used by D3Pro that gets paramater 
properties for indication as to whether the item is 16 or 32 bit.  

l SIMPL Windows: Connection Logic on Module Header now supports 
SubSlotted devices.  

l SIMPL Windows: Fix compilation issue that potentially flagged the SIMPL+ size 
as being too big for the system if no SIMPL+ were present in the program. 

Fixes/Changes from 2.07.36 to 2.08.06: 

SIMPL Windows General Enhancements and New Features:  

l SIMPL Windows: Added support of Crestron Toolbox:  
l Added Toolbox button to the toolbar. This will launch the Crestron Toolbox as a 
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separate process.  
l Added "Legacy Device Support" to the Tools menu (see Tools menu section 

below)  
l All device interface, supported by the Crestron Toolbox, will now be used. If 

XGEN devices are being dealt with then the Viewport interface will be used.  
l The Viewport application will still be available via the Toolbar and the Tools-

>Legacy Device Support menu.  
l GoTo Specific Input/Parameter/Output: Added Ctl+G key sequence, that now 

allows the programmer to jump to specified Input, Paramter or Output in the 
Detail View. The value entered by the programmer is based on Absolute 
input/parameter/output numbers. In other words, if the programmer is on the 
Digitals display of a Touchpanel Symbol, and wishes to GoTo the 3rd Analog 
input, the number they should enter in on the GOTO dialog would be the 
number of Digital inputs + 3. 

SIMPL Windows Menu Bar  

l New "Options" menu  
l Moved "Preferences" from Edit menu to Options menu  
l Added "Crestron Toolbox Options" with following popup:  
l "Manage Toolbox Address Book"  
l "Disconnect Toolbox Server"  
l Moved "Reload Device and Symbol Libraries from Disk" from View menu to 

Options menu.  
l Moved "Rebuild User and Project Databases" from Tools menu to Options 

menu. 

Tools menu  

l Added "Legacy Device Support" to Tools menu with following popup:  
l "Viewport Communication settings…" moved from Edit menu to Tools->Legacy 

Device Support menu  
l "Viewport" moved from Tools menu to Tools->Legacy Device Support menu  
l "Network Analyzer" moved from Tools menu to Tools->Legacy Device Support 

menu 

SIMPL Windows Toolbar  

l Added "New Module" button to the right of the "New Program" button  
l Added "Launch SIMPL+" button to the to right of the "New Module" button  
l Added "Crestron Toolbox" button to the left of the Viewport button  
l Added option to Options->Preferences->General dialog hide or show the 

Viewport Toolbar button. 

SIMPL Windows Module Programming Enhancements and New Features:  

l Introduction of Automated User Interface Programming:  
l The module programmer can choose to have a "GUI Connection Symbol" in the 
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module. When selected, SIMPL will add a "VirtualGUI" symbol to the module.  
l Module programmer can choose to import VTPro-e projects and have 

programming, using joins from the VTPro-e project, automatically generated 
between the Virtual GUI symbol and the Default Argument symbol.  

l Using the Virtual GUI symbol, the module programmer will then connect signals 
from the Virutal GUI symbol to the Default Argument symbol of the Module 
thus, creating "Default User Interface Logic" for that module.  

l When modules with this User Interface Connection Logic are added to a 
program, the programmer can then drag that module onto a User Interface 
device (e.g. a touchpanel) and select to have the connection logic imported into 
the program. The programmer will be prompted for starting join numbers for 
Digitals, Analogs and Serials and then signals will be created in the program 
and will be position relative to the corresponding position in the module. 

Introduction of Automated programming of device connection logic:  

l Module programmer can select Cresnet and/or Ethernet devices from the 
Module Header and SIMPL will automatically add a "Virtual Device For Module 
Connection" symbol and generate programming for the selected device(s) 
between the "Virtual Device For Module Connection" symbol and the DefArg 
symbol. Note: This has already been available via the Module Header, 
Advanced Tab but was typically only used in generation of Crestron Modules. 

Front Panels in modules:  

l Allow Front Panels to be created and maintained in modules, and imported into 
programs from the module (available via Module Header) 

Updates to the Module Header Dialog:  

l Added Custom Category support so users can better organize their Symbol 
Tree.  

l SIMPL will now allow multiple Models to be associated with one module.  
l Created "Connection Logic" tab  
l Programmer can select if they want Gui Connection Logic (see above)  
l Programmer can select Cresent and/or Ethernet devices for which to generate 

Device Connection Logic (see above).  
l Programmer can select Target Control System for Front Panel to be stored in 

module. 

Symbol Tree and Program Tree treatment of "Default Logic" Modules:  

l Icons: Icons for modules that have any kind of Default Logic (for User Interface 
devices, Cresnet/Ethernet devices or Front Panel objects) will have 
distinguising icons that will appear to be reddish versions of the regular icons.  

l Context Menus: Right clicking on modules with Default Logic will allow the 
programmer to view which devices and/or Front Panels the module supports.  

l Drag and Drop in Program Tree: dragging (from Program Tree) and dropping 
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the module to a device symbol, while holding the Right Mouse Key down, will 
present the programmer with actions that can be implemented for importing the 
appropriate Default Logic. E.g. If the device is a touchpanel and the module 
contains GUI Connection Logic, the context menu will have an option to "Import 
User Interface Logic". 

SIMPL Windows Error Resolutions:  

l Fixed problem with Detail View freezing up sometimes after scrolling.  
l Fixed problem with Error Log being lost forever if it was placed on a 2nd 

monitor and then the user takes that monitor out of the configuration.  
l Fixed problem with allowing 4 digits to be entered in IP Address octects.  
l Removed support of PDF Help for Devices in Device Library Tree. This is 

because the Crestron Product Catalog CD is no longer distributed. Hitting F1 
on items in the Device Tree of Config Manager will bring up the associated 
SIMPL Windows help. 

SIMPL+ Enhancements:  

l Removed ability to launch Viewport from the menu.  
l Allow Custom Category Name for modules.  
l Added Expansion Compiler Directives values. 

Fixes/Changes from 2.07.35 to 2.07.36: 

SIMPL Windows: Fix issue where the following button panels would not compile 
correctly for a 2 Series Processor if any of the "fbck" or "press" signals were left out. 
This would manifest itself at runtime with button presses potentially triggering the 
wrong signal, feedback to the panel potentially showing up on the wrong LED, or 
error messages on the console/in the error log similar to "Error: Invalid join number -
1 in BuildCresnetReallyShortAnalog_XXh. (0011:0000:0011)" This issue was present 
in SIMPL Windows 2.07.24 through SIMPL Windows 2.07.35.  

l CNWPGB2-32  
l CNPI-48  
l CNWMBG-10A  
l CNWP-64  
l CNWMBG2-34A  
l CNWPGB2-64 

Fixes/Changes from 2.07.34 to 2.07.35: 

SIMPL Windows:  
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l Fixed error in Resych Program that was causing some signals to get connected 
to the wrong outputs.  

l Fixed an issue with System Builder not being able to open a program if it 
needed to be resynched.  

l Addressed issue of adding some devices with default logic causing the program 
data to become corrupt.  

l Updated Library to 391. 

Fixes/Changes from 2.07.32 to 2.07.34: 

Library Update 390:  

l Change APAD power factor to 3W  
l Change CEN-IPOD to CEN-IDOC  
l Correct CLF-DIMRF Firmware Name  
l Add "Activity Detection" Device Extender to: 

¡ TPS-12 (Ethernet)  
¡ TPS-15 (Ethernet)  
¡ TPS-17 (Ethernet)  
¡ TPMC-10  
¡ TPMC-15-CH (Ethernet)  
¡ TPMC-15-QM (Ethernet)  
¡ TPMC-17-CH (Ethernet)  
¡ TPMC-17-QM (Ethernet)  
¡ UPX-2 Ethernet (All Variations) 

l Fix HelpIDs for: 
¡ "Packet Transmission" Device Extender  
¡ "Ethernet Offline Manager" Device Extender  
¡ TPS-12G-QM Annotation Reserved Joins  
¡ TPS-15G-QM Annotation Reserved Joins  
¡ TPS-G-TPI Annotation Reserved Joins 

INCLUDE.DAT v1.45:  

l HexToI(), HextToL(), HexToSI(), HexToSL() now return 0 if the string passed 
has any invalid Hex digits.  

l Fix occasional problem where Nonvolatile strings in SIMPL+ that never had any 
programatic initalization would sometimes have lengths greater than which they 
were declared at.  

l SIMPL Windows: Fixed problem in Replace Control system when selecting a 
new control system that has default logic. If the programmer selects the version 
of the control system that implies not to add the default logic, the default logic 
was still being added.  

l SIMPL Windows: Fixed problem with Buffer, Analog Buffer, Serial Buffer (and 
other) symbols being considered complete when there were no signals 
attached to the required inputs.  
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l SIMPL Windows: Fixed problem with Limited Symbol mode not being updated 
to the INI file which was causing it to always be 'ON'.  

l Test Manager: Fix issue with period character in program names. 

Fixes/Changes from 2.07.30 to 2.07.32 - PUBLIC FTP SITE 
RELEASE: 

SIMPL+: Fix missing help links from SIMPL+ editor to help system.  

Fixes/Changes from 2.07.29 to 2.07.30: 

Library Update 387: Fix to "Analog Compare" symbol for proper compilation (Issue 
only resulting from Library 386)  

Fixes/Changes from 2.07.28 to 2.07.29: 

l SIMPL+: Fix issue where Gather() in the string/delimiter form (the original form 
of Gather) would cause control system crashes unless CUZ 3.154+ was used. 
2 Series issue only.  

l SIMPL+: Removed firmware requirement for _SKIP_, #DIGITAL_EXPAND and 
#ANALOG_EXPAND  

l SIMPL+: Require Firmware Version 3.154+ if a timeout value is specified within 
Gather(). 2 Series only.  

l SIMPL Windows: Further fixes for issues with "//" used on symbol inputs. This 
affects 2 Series & X Generation Compilers.  

l SIMPL Windows: Fixed system hang when trying to import a VTPro-e project 
(via the UI Project configuration dialog) if the VTPro-e project had any Sound 
objects.  

l SIMPL Windows Library 386: 
¡ New device models: 

n QM-RMCRX (With Autocompensation)  
n QM-RMCRX (With Autocompensation) Remote Cresnet Processing  
n QM-RMCRX (With Autocompensation) Remote Ethernet Processing  
n ST-1700CIR  
n C2N-IRGW  
n CLF-DIMRF  
n APAD (REQUIRES CUZ 3.154+)  
n AES (REQUIRES SIMPL WINDOWS 2.07.24+)  
n AAE 

¡ New symbols (REQURIES CUZ 3.154+, 2 SERIES ONLY) 
n Serial Substring w/Empty Pass  
n Serial Substring (Expandable)  

Page 50 of 116Release notes: SIMPL Windows Release notes:

7/1/2008file://C:\Crestron\Simpl\simpl_release_notes.html



n Serial/Analog Wave Pulse  
n Send As Unicode 

¡ Add "Annotation Reserved Joins" to the following panels (No help 
available yet) 

n TPS-12G-QM (Cresnet, Ethernet)  
n TPS-15G-QM (Cresnet, Ethernet)  
n TPS-G-TPI (Cresnet, Ethernet) 

¡ Add backchannel support for SMART screen for TPS-G-TPI 
(Cresnet/Ethernet)  

¡ Fix Power factor & HelpID for CLS-C6/CLS-C6M Scenes slot. 

Fixes/Changes from 2.07.27 to 2.07.28: 

l Fixed compilation issue that caused "//" on the input side of some symbols to 
behave incorrectly (noted ones are on String I/O, IR Ports, Serial Inputs to 
Macros, and using it on the RESET of a Stepper2. There are others that have 
not been reported, but revised algorithms should take care of them). This 
affects both X Generation (and below) and 2 Series compilers.  

l SIMPL Windows: Will now save the Limited Symbol Mode (2nd to last toolbar 
icon). When this button is enabled, Simpl Windows will count the current 
number of symbols in the Detail View window. As long as this button is 
enabled, that many symbols will be the maximum amount of symbols to be 
displayed in the Detail View at any one time. If more than this maximum 
number of symbols are selected for viewing, the first symbol to have been 
selected for display will be closed (i.e. First In First Out).  

l SIMPL Windows: Changed the default Auto Tile mode to now be Auto Tile 
Horizontal (selectable via the View menu). When displaying the symbols in the 
Detail View in Horizontal Tile mode, there is more of a chance of being able to 
read the full cue and Input/Output signal names. 

Fixes/Changes from 2.07.26 to 2.07.27: 

l SIMPL Windows: Fixed error in Replace Control system when performed via 
the Control System view pane. If the control system has default logic 
associated with it, the associated default logic module was getting added twice.  

l SIMPL Windows: Fixed the Auto increment last (F4) function in Detail view 
when dealing with "//" signals. Simpl will now automatically try to determine the 
type or prompt the user for the type. Previously, if the cue type didn't match, 
that cue was not connected to a "//" signal.  

l SIMPL Windows: Fixed error on Preferences->Program Editing page where the 
radio buttons for the Special Symbol set were not reflecting the correct 
selection.  

l SIMPL Windows: Replaced the key sequence Ctl+Shift on the Program Tree 
and the System Configuration tree, to F11. This key will toggle the dipsplay of 
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data that is meaningless to the programmer, and harmless to display, but can 
be used by Crestron support personnel for problem resolution. 

Fixes/Changes from 2.07.25 to 2.07.26: 

l SIMPL Windows: CTL+W will now be the keyboard shortcut for toggling 
between Configuration Manager and Program Manager views. This resolves 
the issue introduced in 2.07.24 where Ctl+Tab was no longer effective in 
switching between symbols in the Detail View because Ctl+Tab had been 
remapped to switch between configuration manager and program views in 
2.07.24.  

l Simpl Windows: Fixed a potential Data Integrity problem that could occur from 
adding devices with default logic and then deleting those devices before having 
saved the project.  

l SIMPL Windows: Changed wording on Compile Statistics dialog if an AES is 
being compiled. The previous message made it appear as though a transfer to 
control system had been attempted and failed. The intent of the original text 
("Cannot Transfer!") was to tell the program that transferring the project via 
Simpl Windows was not possible and as such, the programmer should use the 
Cresetron Toolbox. New text now reads: "Note: The Viewport software does not 
support this control system. To transfer this project to the control system please 
use the Crestron Toolbox for interfacing to this device."  

l SIMPL Windows: Fixed problem with Alt+F5 not inserting a "//" signal in detail 
view  

l SIMPL Windows: Fixed issue with Error Log getting cleared before doing a 
Drag and Drop of Signals in Detail View.  

l Simpl+: Removed Parameter text from default template file.  
l Removed firmware requirements for _SKIP_, #OUTPUT_SHIFT, 

#DIGITAL_EXPAND and #ANALOG_EXPAND. 

Fixes/Changes from 2.07.24 to 2.07.25: 

SIMPL Windows: Changed Detail View context menu option of "Comment 
out/Remove Comment on Input/Output" to now read as "Insert/Remove special "//" 
signal."  

Fixes/Changes from 2.07.22 to 2.07.24 - PUBLIC FTP SITE 
RELEASE: 

SIMPL Windows: Fixed an issue with not being able to drag and drop signals from 
the Detail view into an Input/Output folder in the Program Tree.  
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Fixes/Changes from 2.06.20 to 2.07.22: 

SIMPL Windows General Enhancements and New Features:  

l Added a new tab to the Edit->Preferences dialog entitled Program Editing.  
l Added selection on Edit->Preferences->General dialog to change Background 

Color of SIMPL Windows.  
l Added selection on Edit->Preferences->Compiler Settings dialog to disable 

showing the "Transfer?" dialog that appears at the end of each compile. If this 
dialog is disabled, the Transfer will not occur.  

l Changed default for "Don't Show Signals in Program Tree" option, on General 
Preferences dialog, to not to show the - Inputs/Output/Parameters in the 
Program Tree.  

l VTProe .HEX files will now be added to archive files.  
l Removed "Show Signal Tray" from the View menu and removed the Signal 

Tray.  
l Removed creation of <program name>.xml files on program save.  
l Added "Search and Replace" option to the Edit menu. This is the same search 

and replace function that can be performed from the Program Tree and Detail 
View.  

l Implemented keyboard sequence <Ctl><tab> to switch between Program 
Manager to Configuration Manager pages.  

l Opened up the Replace Control System logic to allow control systems with 
Default Logic associated with them (i.e. AES, MP2, MP2E etc) to add program 
the default logic at the end of the replacement process. If the control system 
has Out Of The Box Functionality, such as the AES, the logic will automatically 
be applied, otherwise the user will be asked if they wish to proceed. Note: If any 
signal is connected in the new control system where a default logic signal 
needs to be connected, the defautl logic signal connection will overrule the 
existing signal. An entry in the error log will identify such occurrances. 

SIMPL Windows Program Manager Enhancements and New Features:  

l Support for AES Out Of the Box Functionality: The Crestron Database will now 
contain a collection of Crestron Modules that will automatically generate default 
logic for certain Adagio systems. These modules will be added to a subsystem 
labled "Out of the box functionality". These modules have a lock icon next to 
them, and are incorporated for every AES system. They may not be 
commented out, deleted, copied, or imported and are considered "protected.". 
The signal connections on these modules may not be deleted or commented 
out and are also considered protected and thus, cannot be copied, deleted, 
connected elsewhere or commented out. Protected signals that appear in the 
Detail View are drawn in light gray when not selected, and red when selected. 
This is simply visual feedback so that the programmer realizes that these 
signals are special.  

l New special signal name "//". When a programmer does not want to use the 
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input or output of a symbol, they can give that signal the signal name "//" 
without worrying about jam issues - correct underlying signal maniuplation is 
performed by the compiler. Inputs/Outputs with this signal will be drawn in light 
gray so they stand out to the programmer. These signals cannot be watched in 
test manager. Note that the system needs to lock the "//" to a real type; analog, 
digital or serial. If the "//" as entered turns out to be ambiguous (such as 
entering "//" on the output of a Versiport symbol), SIMPL Windows will request 
that it is locked to a type via a dialog that is presented to the programmer. As 
such, the digital //, analog //, and serial // may be traced individually. Changed 
the Detail View right click menu option: "Comment Signal Alt+F2" option to now 
read as "Disable 'No Driving Source'/'No Destination ' Warnings Alt+F2" or 
"Enable 'No Driving Source'/'No Destination ' Warnings Alt+F2". This is the 
existing option that will add/remove a "//" in front of an existing signal name 
such that "Signal without driving source" & "Signal without destination" compiler 
warnings are suppressed for the signals. Note that there is NO CHANGE in 
compilation behavior, this is a terminology change to avoid confusion.  

l Added ability to Comment/Uncomment symbols from the Signal Detail (F2) 
dialog.  

l Added ability to associate a module with a Cresnet Device . This feature will 
typically be used to create User Modules that will then be used by System 
Builder such that programmers can now generate their own logic that they'd like 
associated with a particular device: 1. On the Module Header Advanced tab, if 
the selected Manufacturer is Crestron, the programmer can now select any 
Cresnet or Ethernet device that is in the iodev.tio. If a device is selected (via a 
combo box next to the Manufacturer combo box), that that device will be 
"associated" with the module. 2. Now, on Exit of Module Header, for the first 
time only on a new module, the programmer will be asked : "Would you like to 
add the 'Virtual Device For Module Connection' symbol and automatically add 
signals and the appropriate connections for the default logic generation? ". 3. If 
the programmer answers Yes, then a Virtual Device for Module Connection 
symbol will be added and Input and Output signals and parameters will be 
generated per the Input and Output cues of the selected Device. These signals 
will then be connected to the Default Arguments symbol as appropriate. Please 
refer to the on-line Help for more details. Module Header Dialog: Created a new 
Module Header Tab for entering comments. This was done because the 
module header dialog was too long and went off of some screens  

l Roomview 7.0 support (Roomview 7.0 release is TBD; will also require a 
Library Update)  

l Added Numeric32 to the Parameter Properties dialog and updated Parameter 
Validity algorithm to support signed parameters (old modules shouldn't be 
affected, but new modules or imported modules will need this option checked if 
they want to be able to enter negative values)  

l Added Copy and Paste commands to the Program Tree Right Click menu.  
l Changed "Signal Detail" dialog terminology based on what type of signal is 

being viewed. If the signal is a comment signal "//" or a "0" or "1", the context 
menu option will read "Show Use". The resulting dialog will be entitled "Use of 
\<signal name\>", and the top window of the dialog will be labeled "Occurrance 
as Outputs:" while the bottom window will be labeled "Occurrance as Inputs: In 
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the Program Tree, added error messages when trying to copy, paste or delete 
Device symbols. Also disabled the context menu options of Copy and Paste if a 
device symbol is selected.  

l Implemented a "Make Symbol Complete" feature to place "//" on inputs/outputs 
and 0's parameters for the inputs/outputs/parameters that are making the 
selected symbol(s) incomplete (i.e. symbols that are denoted with a "!*"). Note: 
this does not mean that all inputs, outputs and parameters will be filled in, just 
those that make the symbol incomplete by being empty. In Detail View, this will 
be available via the "Make Symbol Complete" option on the context menu, or 
<Ctl>I. This will apply to the currentlyselected symbol in the Detail View. In the 
Program Tree, this will be available via the "Make Symbol Complete" option on 
the context menu, or <Ctl>I. This will apply to the currently selected symbol in 
the Program Tree and all symbols beneath it.  

l Added ability to drop in a Front Panel definition when adding Out Of The Box 
Functionality modules to the AADS. 

SIMPL Windows Configuration Manager Enhancement and New Features:  

l Add/Replace Dialog on the Configuration Tree will now have an entry for 
devices that have Default Logic associated with them, in addition to just the 
'empty' device . The devices representing default logic will have a yellow device 
icon displayed. Currently, this capability exists in the Device Library in the form 
of Devices that can be Expanded where the expanded device represents that 
device with it's default logic. 

SIMPL Windows Error Resolutions:  

l Fixed problem with data entry of a negative parameter value when the 
parameter properties specified a negative low range and a positive high range.  

l Added code to try to reconnect child symbols with listed parents if a data 
integrity error code 134 was found. If this type of data integrity error occurs, 
Simpl will attempt to resolve it and let the programmer know about the 
resolution via a Warning number 254. If the User database file (i.e. the file that 
contains IR driver data) cannot be opened, SIMPL Windows will now ask the 
user if they want to Rebuild the User and Project Databases. This is because 
certain versions of DEAL (4.0.01 specifically) were creating the user database 
with a version of the MS Access driver that SIMPL Windows was not 
compatible with. This message will not appear if there is not User or Project 
Database file found.  

l Fixed a problem with Autosave files getting corrupted if Simpl hangs while 
doing operations that affected moderate amounts of data manipulation (e.g. 
drag/drop or rename of multiple objects) and the programmer had to abot Simpl 
Windows.  

l Fixed issue with not being able to add ST-1700C after having added a 
CNRFHT-30 via System Builder.  

l Fixed issues with drag and drop of Serial/IR/RF devices from within System 
Builder. Programmer was not able to drag and drop Serial/IR/RF devices onto 
the Serial, IR or RF card directly. They would have to make sure the "Hide 
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Unused" option was not checked, and drag the device onto the specific port.  
l Fixed Rename Signal process to report an error if the signal being renamed 

doesn't match the signal type of the new name if the new name belongs to an 
existing signal.  

l Module Header data will now allow brackets '[' and ']'  
l Fixed Serial String validation to allow special characters from languages such 

as French, German, Dutch, etc.  
l Programmers can no longer add Device Extender symbols to the "Logic" folder 

by entering the speedkey on the status bar. The right-click context menu is the 
only way to add them.  

l Fix "Find Symbol" dialog so it will no longer search for Device Extenders.  
l Fixed problem with device symbols being shown as "complete" if a device 

extender is added and it is deemed 'complete'.  
l If the Preferences setting for "Don't Display Discontinued Devices in Device 

Library" is set, then discontinued devices will also not appear in the System 
Configuration Tree's Add/Replace Device dialog.  

l Correct compilation issue that was not always posting CMCVT157, 
RLCMCVT157 - that the program is using NVRAM but the target control system 
does not have any hardware based NVRAM (only simulated NVRAM mapped 
into regular RAM). 

SIMPL Windows General:  

l The viewport is not capable of transferring programs to the AES. Until the 
Crestron Toolbox is integrated into Simpl, if the programmer compiles an AES 
program, the statistics dialog will appear with a message at the bottom 
indicating that SIMPL Windows cannot transfer the program at this time and 
directs the user to use the Crestron Toolbox.  

l If the compiled program is too large to fit in internal Flash & the processor does 
not support Compact Flash, the fatal error RLCMCVT201 is ussued: Program 
size exceeds built in flash capacity. The program either needs to be smaller or 
converted to a processor model that supports Compact Flash. This is for 2 
Series Processors only.  

l Promote the following compiler messages to FATAL errors: 
¡ RLCMCVT128, CMCVT128: Cannot subsitute parameter 

"0130hH" (prompt "maskword7") into S-4 inside module S-3 (Module File 
C:\mydir\test.umc), assuming 0 [-25].  

¡ RLCMCVT139, CMCVT139: Incompatible value "0130hH" after partial 
substitution in S-4 (prompt maskword7) in S-3 (Module File 
C:\Crestron\Cresdb\Modules\LHWIK10A.cmc), assuming 0. 

SIMPL+ Enhancements:  

l % is an alias for MOD (i.e. 5 % 2 is the same as 5 MOD 2)  
l Added new functions  
l HighWord()  
l LowWord()  
l GetGMTOffset() [Requires CUZ 3.154 and later]  
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l SetGMTOffset() [Requires CUZ 3.154 and later]  
l GetDST() [Requires CUZ 3.154 and later]  
l CompareStrings()  
l CompareStringsNoCase()  
l FindNoCase()  
l ReverseFindNoCase()  
l GetSymbolReferenceName() [Requires CUZ 3.154 and later]  
l GetSymbolInstanceName() [Requires CUZ 3.154 and later]  
l UpperChar()  
l LowerChar()  
l HexToI(), HextToL(), HexToSI(), HexToSL()  
l STRING GatherByLength(INTEGER length, STRING SourceString [,INTEGER 

timeout]); [Requires CUZ 3.154 or later]  
l STRING RemoveByLength(INTEGER length, STRING SourceString); 

[Requires CUZ 3.154 or later]  
l Augmented Gather() to have a Timeout (in hundreths of a second) as a 3rd 

optional parameter, as well as having a number of characters to Gather to as 
the first argument instead of a delimiter. Requires CUZ 3.154 and later.  

l STRING Gather(STRING delimiter, STRING SourceString [,INTEGER 
timeout]);  

l Added "_SKIP_" keyword which can be used in DIGITAL_INPUT, 
DIGITAL_OUTPUT, ANALOG_INPUT, ANALOG_OUTPUT, STRING_INPUT, - 
STRING_OUTPUT, and BUFFER_INPUT definitions. Each occurance of 
_SKIP_ will present a visual gap on the corresponding SIMPL Windows 
representation of the SIMPL+ symbol.  

l Added #DIGITAL_EXPAND, #ANALOG_SERIAL_EXPAND directives. 
Arguments are Separately (default if not specified) and InputsWithOutputs. 
InputsWithOutputs will make Analog/Serial or Digital I/O track on an ALT+ of 
the symbol depending on which # directive is used.  

l Allow Structure definitions within library files (.USL, .CSL)  
l User defined functions are now displayed in gray. Right clicking on that function 

will display a popup menu which will allow the user to jump to that function.  
l Implemented custom colors within the text editor (Edit|Preferences|Text Editor)  
l Enabled Windows XP Themes in Editor  
l Added bookmark hotkeys. CTRL+F2 toggles bookmark, F2 goes to next 

bookmark.  
l Added "Edit | Select All" via CTRL+A hotkey  
l Added "Edit | Find Next" with F3 hotkey. 

SIMPL+ Error Resolutions:  

l Fixed bug when #DEFINE_CONSTANT is used within another 
#DEFINE_CONSTANT (i.e. #DEFINE_CONSTANT MyVal 5 followed by 
#DEFINE_CONSTANT YourVal MyVal)  

l Prevent operators in #DEFINE_CONSTANT definitions that have string 
constants, i.e. #DEFINE_CONSTANT -"Crestron" is illegal.  

l Fixed bug when passing structures into SetArray()  
l Increased internal temporary string size from 64000 bytes to 65535 bytes, 
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alleviating overflow problems with temp variables  
l Fixed bug that allowed I/O declarations within structures  
l Fixed "LONG_INTEGER to INTEGER" compiler warning when using X within 

print() statements  
l Fixed bug so that now predefined structure (i.e. FILE_INFO) members show in 

the dropdown list  
l Fixed function list dropdown in application toolbar to show vertical scrollbars  
l Function list dropdown in application toolbar will automatically jump to function 

upon closing of dropdown box  
l Fixed bug when #USER_LIBRARY contained a file that was typed with a 

different case than then actual .USL file (i.e. #USER_LIBRARY - "MyLib" when 
the file on disk is "mylib.usl")  

l Fixed internal typecasting issue with U/ operator  
l Removed internal typecasting when using x and X within Print() statements, 

should allow values to print correctly.  
l Fixed bug when using a Structure STRING element within MakeString(). 

Spaces were being stripped from the format string. Ex: - MakeString
(MyStruct.MyString, “This was broken”) would set MyStruct.MyString to 
Thiswasbroken. 

Fixes/Changes from 2.06.19 to 2.06.20 - PUBLIC FTP SITE 
RELEASE : 

l SIMPL Windows: Fixed Replace Control System error when replacing an IM-
RX1 with an IM-RX3, relays that had been added from the database were not 
being moved over correctly.  

l Library 342: 
¡ Correct QM-RMCRX-BA compilation.  
¡ Correct C2N-SDC-DC Power Factor.  
¡ Expose models for QM-RMCRX-BA (Control System, Remote Cresnet, 

Remote Ethernet).  
¡ Expose model for C2N-SDC-DC.  
¡ Fix default Net Address for: 

n CNX-DVP4 Remote Ethernet Processing  
n Pro2 Remote Ethernet Processing  
n CP2E Remote Ethernet Processing  
n AV2 With Cardcage Remote Ethernet Processing  
n AV2 Remote Ethernet Processing  
n PAC2 Remote Ethernet Processing  
n MP2E Remote Ethernet Processing  
n Rack2 Remote Ethernet Processing  
n MC2E Remote Ethernet Processing  
n QM-RMC Remote Ethernet Processing  
n C2N-DVP4DI Remote Ethernet Processing 

¡ QM-RMCRX Remote Ethernet Processing  
¡ Fix firmware name for CP2E Remote Ethernet Processing.  
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¡ Fix Hint for PAC2 Remote Ethernet Processing.  
¡ Fix RoomView Help ID. 

Fixes/Changes from 2.06.18 to 2.06.19: 

l Compiler: Fix compilation of certain compiler methods that would occasionally 
cause a crash of SIMPL Windows when compiling.  

l Compiler: Fix compilation of SNMP device symbols to handle gaps between 
labels (i.e. label 1 filled out, label 2 not filled out, label 3 filled out) (not yet 
released). 

Fixes/Changes from 2.06.17 to 2.06.18: 

l SIMPL Windows: Fix version numbering inconsistencies.  
l Library 336 

¡ Expose QM-AE  
¡ Expose Roomview 6.0 Programming Model  
¡ Correct TPMC-15/17-CH/QM Cresnet/Ethernet Programming models 

(nothing was visible on the Program manager side of SIMPL Windows)  
¡ Expose C2N-SDC  
¡ Add "Activity" Device Extenders to subslots of the CHV-TSTAT/THSTAT  
¡ Correct Configuration Manager help topics for QM-AMP3x80, QM-WMC. 

Fixes/Changes from 2.06.16 to 2.06.17: 

l SIMPL Windows: Removed the "Do you want to configure the hardware for this 
program?" message box when a new program is created. Simpl will now 
automatically go to the Configuration Management view.  

l SIMPL Windows: Fixed autofill issue where devices with firmware names 
longer than 10 characters were being missed.  

l SIMPL Windows: Fixed problem with LIST paramters not showing the correct 
Default Values.  

l SIMPL+: Fixed minimum array expansion problems where the symbol in SIMPL 
Windows would not show correctly. 

Fixes/Changes from 2.06.15 to 2.06.16: 

SIMPL Windows: Fixed bug that could potentially cause SIMPL Windows to crash 
when saving a program file after having performed a Replace Device. This would 
only happen when Cresnet Upload Settings have been defined for the device being 
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replaced.  

Fixes/Changes from 2.06.14 to 2.06.15: 

l SIMPL Windows: Fix issue with compilation of Pro2/Rack2 Front panel where 
the "Front Panel Status" device extender outputs would not function if there 
were no objects defined on the front panel. Now, you don't need any objects or 
signals on the front panel for the extender to function. NOTE that the RACK2 
has a CUZ issue which prevents the LinkA_LED, LinkB_LED and Err_LED 
extender from working, regardless of this fix. This will be addressed in the next 
CUZ release after 3.137.  

l SIMPL Windows: Added capability to stack serial drivers on IR ports if the 
"Allow Serial Stacking" flag is set in the Compiler Preferences. 

Fixes/Changes from 2.06.12 to 2.06.14: 

l SIMPL Windows: Internal changes for System Builder.  
l Viewport: Support for MT-1000C. 

Fixes/Changes from 2.06.11 to 2.06.12: 

l SIMPL Windows: Modify X Generation/ST-CP/CNMS Compilation of RF 
Transmitters. If the Transmitter is marked as "Don't Allow RF ID \< 
0x10" (typically old/discontinued Transmitters), and the transmitter is dropped 
in at an ID less than 0x10, and the Gateway being used is a CNRFGW, then fail 
with the existing error message CMCVT117. The addition is for flagging the 
CNRFGW, specifically. The 2 Series compiler already does this.  

l SIMPL Windows: Added a checkbox to the Serial Upload, Ethernet Upload and 
Cresnet Upload configuration dialog boxes to indicate which Upload Settings 
should be used for uploads being performed by the Installers Toolbox. Only one 
of these checkboxes can be checed at one time for a given device (in the case 
where a device may have more than 1 upload method available).  

l SIMPL Windows: Fixed an error in Import Remote System Definition function 
that was placing signals with a name of "1" on the wrong cue. 

Fixes/Changes from 2.06.10 to 2.06.11: 

l SIMPL Windows: Advanced Settings property sheet for Module Header will now 
default the "Add Template Pages to System Builder" to be selected.  

l SIMPL Windows: Advanced Settings property sheet for Module Header will now 
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update the Templates List when the programmer checks/unchecks the "Show 
Only Templates for selected Device Family".  

l SIMPL Windows: Advanced Settings property sheet for Module Header will now 
update the selected Template to the Default Template when Device Type 
changes.  

l SIMPL Windows: Fixed problem causing Data Integrity Errors in programs built 
by System Builder that had devices that had Cresnet Upload Settings dialogs. 

Fixes/Changes from 2.06.09 to 2.06.10: 

l SIMPL Windows: Fixed an error in support of System Builder. 

Fixes/Changes from 2.06.08 to 2.06.09: 

l SIMPL Windows: Resolved an issue with the Cresnet/Ethernet/Serial Upload 
dialogs that could cause data integrity errors when loading a .SMW file. 

Fixes/Changes from 2.06.07 to 2.06.08: 

l SIMPL Windows: Fixed crash that can sometimes occur when trying to access 
Serial Upload Settings dialog on devices. 

Fixes/Changes from 2.06.06 to 2.06.07: 

l SIMPL Windows: Made it such that when trying to drag a Serial/IR/RF device 
from one Serial/IR/RF card to another, the user can now drop the device onto a 
Serial/IR/RFl card - instead of having to expand the card to select a specific 
Port/ID. 

Fixes/Changes from 2.06.05 to 2.06.06: 

l SIMPL Windows: Due to the the fact that the UPX is a slotted device, and the 
touchpanel associated with that device is a sub-slot, SIMPL Windows is not 
able to copy the programming on the UPX touchpanel to the touchpanel it is 
being replaced with. A note to the "Replace Device x with Device y" message 
box is now issued to let the user know that programming may be lost.  

l SIMPL Windows: Changed references of AppBuilder to SystemBuilder.  
l SIMPL Windows: Fixed data initialization error that was causing problems with 
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"Analog Out is Signed" property  
l SIMPL Windows: Fixed problem with Create Archive not getting embedded 

SIMPL+ modules when the SIMPL Modules were encrypted.  
l SIMPL Windows: Fixed problem with the function that creates the 

'<systemname>_files.XML' file. This function was being called after a compile 
was done via System Builder and, because of errors that occurred in the 
Creation of the XML file, it appeared as though the compile failed.  

l Library Update Changes: (NOTE: Below Library Update changes are from last 
standalone library update (v318) to current (v321)) 

¡ Expose QM-MD5x1, MT-1000, QM-FTB devices  
¡ Correct Power factors for QM-FTCC, QM-FTDC, QM-FTMC, MT-500C, 

ML-500, WPR-48 (IR/RF418/RF433)  
¡ Allow serial devices in the Crestron Database to be dropped on a DAP8 

COM port  
¡ Correct default ID for CNAMPX-16x60 to 3D  
¡ Fix Cues for C2N-VEQ4, C2VEQ-4 for system builder compatibility.  
¡ Create "Shades/Drapes" symbol category.  
¡ Correct Serial cues for QM-MD7x2  
¡ Correct No Mic To Mix cue for QM-MD7x2 mixers 

Fixes/Changes from 2.06.04 to 2.06.05: 

l SIMPL Windows: Added logic in to compensate for Parameter Cues that might 
have "==" in their names. The data after the "==" implies the default value. This 
logic was added in case some client application (D3Pro, System Builder, etc.) is 
making a function call to find a matching cue and does not pass in the default 
value data. 

Fixes/Changes from 2.06.03 to 2.06.04: 

l SIMPL Windows: Fixed logic for importing logic from Crestron Modules and 
connecting that logic to certain devices. An error occurred, via System Builder, 
when doing so with a CLW-DIMS. The analog input/output was no longer 
getting connected.  

l SIMPL Windows: Remove "Minimum CUZ" from the leading comment that 
appears on the console (or doing "Info -\> Rems" on a 2 Series front panel 
display) along with other program information. 2 Series only change. 

Fixes/Changes from 2.06.02 to 2.06.03: 

l SIMPL Windows: Added support of devices that will not allow programming via 
the SIMPL Windows visual interface.  
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l SIMPL+: Fixed toolbar icons that broke in the previous build. 

Fixes/Changes from 2.06.01 to 2.06.02: 

l SIMPL Windows: Fixed Processing of default RF ID's.  
l Library Update (v317 and later): Expose the following symbols: 

¡ Astroclock with Enable - Requires CUZ 3.132 or later; 2 Series only.  
¡ Time Offset with Enable - Requires CUZ 3.132 or later; 2 Series only.  
¡ Stepper with Progress & Cancel - Requires CUZ 3.121 or later; 2 Series 

only.  
¡ Double Precision Analog Initialize - Requires CUZ 3.117 or later; 2 Series 

only.  
¡ Double Precision Analog Variable Preset - Requires CUZ 3.117 or later; 2 

Series only. 

Fixes/Changes from 2.05.22 to 2.06.01: 

l SIMPL Windows: Fixed problem in System Configuration Tree where dragging 
an item to drop it somewhere else, didn't always drag the item that was actually 
selected.  

l SIMPL Windows: Fixed Range Checking on Analog Inputs, Analog Outputs and 
Parameters Property definitions. It was not allowing decimals in range values.  

l SIMPL Windows: Fixed Create Archive function to make sure if a file is of 
type .UMC, that it is looked for in both the Project and UsrMacro directories 
before an error is generated. System Builder Export was failing because SIMPL 
Windows was thinking the .UMC files should have been in the User DB 
directory.  

l SIMPL Windows: Added new property to Analog Inputs, Analog Outputs and 
Parameters Property defintions. The new property allows the user to indicate if 
the data item is Signed or Unsigned.  

l SIMPL Windows: Fixed problem with Import RSD assiging the first Analog Input 
to an ~UNUSED~ cue.  

l SIMPL Windows: Fix issue when trying to Search/Replace signal names in a 
program that has close to 65k signals, signals were deleted and disconnected, 
and symbols were being marked as incomplete.  

l SIMPL Windows: If program names are longer than 125 chars, make sure the 
SIMPL Windows title bar shows the full .SMW name so, chop of chars in the 
path instead.  

l SIMPL Windows: Fixed problem where Module Category was getting reset to 
Miscellaneous on subsequent edits of the module after the category had been 
selected and already saved.  

l SIMPL Windows: Added Help buttons to Program Header dialog, Copy to 
Compact Flash dialog, Create Archive Dialog, Import Archive dialog, Enter 
Password dialog, Import Crestron Module, Find Symbol In Program, Find 
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Symbol In Library, Front Panel Editor, Front Panel Object Editor, and Find IR 
file dialogs.  

l SIMPL Windows: Front Panel Editor - fixed problem where 255 Indirect Text 
Joins were not being allowed for 2 Series processors.  

l SIMPL Windows: Fixed issue with '[' ']' being put in module header and causing 
data to be lost if files were encrypted.  

l SIMPL Windows: Fixed problem where changing anything about a Device's 
configuration (ie. click ok on Config Dialog) would erase any extended 
comment that may have existed on the associated symbol. This was rendering 
re-import of RSD files unavailable once user set the IP address of the EISC.  

l SIMPL Windows: Fixed problem with AutoFill rack that occurs when the COM 
port is being used by some other application such as Test Manger. When trying 
to connect for autofill, a very misleading error message was being displayed 
instead of telling the user that the problem was due to another application had 
the port open.  

l SIMPL Windows: Added support of Default TCP/IP addresses for devices such 
as TPMC-10, XPanel, UPX-2, Roomview, ePower Applications and ActiveCNX. 
If the user adds such a device to their program, the default IP Address of 
127.0.0.1 (the loopback address) will be assigned to that device. They can still 
edit it in the configuration dialog.  

l SIMPL Windows: Fixed a problem when adding devices (specifically an ST-
1700C) that have Default RFID's, the devices were not always getting put at the 
Default RF ID location.  

l SIMPL Windows: Added new Configuration Dialogs to prompt user for Upload 
information. These dialogs will be present for devices that may have more than 
one method to upload via (i.e.serial, cresnet and/or ethernet), or that have a 
different method of uploading to than than the manner in which the device is 
connected into the program. For example: RF devices may have a Serial 
Upload method and as such, a Serial Upload Settings configuration dialog will 
be displayed for such devices. This information is currently ONLY used by the 
System Manager application.  

l SIMPL Windows: Fixed issue with Create Archive not always getting SIMPL+ 
files when called from System Builder.  

l SIMPL Windows: Will give operator a Message Box to let them know if an 
Input/Output/Parameter Property is going to be deleted on a Module's Default 
Argument if the signal is deleted or renamed etc.  

l SIMPL Windows: Made handling of Input and Output Property defintions for 
Define Arguments cues (on a User Module) a little more friendly. User should 
be told when property defintions are going to be deleted due to renaming of a 
cue or deleting a cue. Also added capability to copy a single Cue with property 
definition, to another cue on the same list (i.e. Input or Output) and have the 
property data from the cue being copied, be copied to the new cue.  

l SIMPL Windows: Fixed error in range checking of Parameter values. If the 
range for a parameter was defined as one format (e.g. seconds) and the user 
entered a value in another format, an error was given when it shouldn't have 
been.  

l SIMPL Windows: Fixed problem with Replace Control System sometimes 
losing RF and IR devices if more than one RF or IR device existed on a Built-In 
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Gateway card on the source control system.  
l SIMPL Windows: Fixed problem where the wrong signal was getting deleted 

when an <ALT><-> (i.e. collapse signals) was being performed on the Output 
list of a symbol  

l SIMPL Windows: The following are new (Fatal) errors to do with DST (Daylight 
Savings Time). Only one Clock Driver symbol (Currently "Clock Driver", 
"Extended Clock Driver") may define a NON-ZERO DST parameter. You can 
have any number of clock drivers with [dst] set to 0d or left undefined. The 
issue is that it causes confusion to have multiple DST's defined. The examples 
of the error are: RLCMCVT192: Symbol S-5 in module S-6 (Module File c:\User 
Modules\MyModule.umc) defined a DST Parameter of '2'. Symbol S-3 in 
module S-2 (Module File c:\User Modules\MyOtherModule.umc) already 
defined a Non-Zero DST of '1'. Only one non-zero DST can be used. 
RLCMCVT193: Symbol S-5 in module S-6 (Module File c:\User 
Modules\MyModule.umc) defined a DST Parameter of '2'. Symbol S-2 already 
defined a Non-Zero DST of '1'. Only one non-zero DST can be used. 
RLCMCVT194: Symbol S-5 defined a DST Parameter of '2'. Symbol S-2 in 
module S-1 (Module File c:\User Modules\MyModule.umc) already defined a 
Non-Zero DST of '1'. Only one non-zero DST can be used. RLCMCVT195: 
Symbol S-5 defined a DST Parameter of '2'. Symbol S-2 already defined a Non-
Zero DST of '1'. Only one non-zero DST can be used.  

l Test Manager: Tried to improve the success rate when trying to verify if the 
Program being loaded into Test Manager is the same as that which is in the 
control system.  

l Library Update: Lock out the following symbols from the QM-RMC: SDPM, 
SDPMB, DPM, NTX (these are Cresnet only symbols and as such do not 
function in the QM-RMC since it has no Cresnet)  

l SIMPL+: Fixed cross-compiler error to allow '.' in Library Names. Ex: 
#USER_LIBRARY "MyLib-1.2"  

l SIMPL+: Allow LONG_INTEGER, SIGNED_INTEGER, 
SIGNED_LONG_INTEGER in For Statements  

l SIMPL+: Allow String Arrays in Remove(). (Ex: str = Remove( "a", strArr[5] );  
l SIMPL+: Fixed cross-compiler error to allow negative numbers in CSwitch case 

statements  
l SIMPL+: Display Source Code Line Numbers in left margin (Show/Hide option 

in Edit|Preferences|Editor)  
l SIMPL+: Allow STRING_INPUTs to be used in minimum array declarations  
l SIMPL+: Fixed bug to prevent GetLastModifiedArrayIndex() from being used 

within Wait Statements.  
l SIMPL+: Fixed bug to evaluate the following predefined constants properly: 

_O_RDONLY, _O_WRONLY, _O_RDWR, _O_APPEND, _O_CREAT, 
_O_TRUNC, _O_EXCL, _O_TEXT, _O_BINARY ENOENT, EMFILE, EEXIST, 
EACCES, EBADF, ARDONLY, AHIDDEN, ASYSTEM, AVOLUME, ADIRENT, 
ARCHIVE, FILE_BAD_USER, FILE_NO_DISK, FILE_LONGPATH, 
FILE_INVNAME, FILE_PEMFILE, FILE_BADFILE, FILE_ACCES, 
FILE_NOSPC, FILE_SHARE, FILE_NOFILE, FILE_EXIST, FILE_NVALFP, 
FILE_MAXFILE_SIZE, FILE_NOEMPTY, FILE_INVPARM, FILE_INVPARCMB, 
FILE_NO_MEMORY, FILE_NO_BLOCK, FILE_NO_FINODE, 
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FILE_NO_DROBJ, FILE_IO_ERROR, FILE_INTERNAL  
l Viewport: Changed the "Load Network Device..." menu item to be more 

consistent with what it is doing for different devices.  
l Viewport: Fixed a memory leak in the Ops Prog dialog for certain transfer types.  
l Viewport: Fixed a bug with the transfer status that would cause the total time 

left parameter to be incorrect and flicker to zero between files.  
l Viewport: Added a menu item under file transfer "Upgrade Sub-Slot device 

firmware..." to allow loading of sub slot devices. This was added to support the 
AM radio.  

l Viewport: Added a line in the dialog for identify transmitter ID stating that it only 
works for 1-way transmitters whose gateway is declared in the currently loaded 
program.  

l Viewport: Changed name of SSL DLLs so as not to conflict with other apps on 
customer machines since differnet builds of libeay32.dll and ssleay32.dll are 
not binary compatable.  

l Viewport: Changed reboot timeout for 2 series control system updates. Actually 
change dthe watchdog from 20 seconds to thirty seconds to account for longer 
reboot times on the QM line.  

l Viewport: Added a provision in HandleConsolePassword where if no data is 
recieved after connecting, we exit. This was getting stuck on certain 
connections to old QM firmware and hanging the viewport.  

l Viewport: For identify transmitter id, if both button id and RF ID are 0, then 
leave the previous id displayed and just show that it was released.  

l Viewport: File transfer support for the UPX.  
l Viewport: Fixed a bug where Send generic files would only work for a limited 

number of files (10-14) depending on the lengths of thier names. The default 
buffer was too small. (260 chars) when now use (4096).  

l Viewport: Fixed issue where the serial port settings were loaded, no defaults 
were provided, so in those cases nothing would be checked off for stop bits, 
baud rate etc.. which would cause viewport to fail opening the serial port.  

l Viewport: Fixed a bug in SendWebPages so reclaiming file space status 
message was not always coming up on top of the proper window.  

l Viewport: Fixed a timing bug on really fast computers (3GHz+) where xmodem 
transfers were tossing the ends of commands when they clear the tx buffer, this 
was just a 250ms delay before an Xmodem transfer  

l Viewport: Fixed a bug with web page transfers where if the filename passed in 
as the default page is different than the one specified in the _config_ini_ file, we 
were overwriting with what was passed in which in most cases we cannot be 
sure is correct. Now we rely on the _config_ini_ file to be there.  

l Viewport: Added a warning when disabling an NVRAMDISK that all files will be 
deleted.  

l Viewport: Added a warning if one or more SIMPL files were not found in an 
SPZ file.  

l Viewport: Fixed logic for disallowing SSL settings on a Control System while 
connected over ethernet since the devices do not support that.  

l Viewport: Changed text during status callback for "Storing new firmware" to add 
"Do NOT disconnect during this process!"  

l Viewport: Added "Configure WPR-48" option to the Functions Menu. This will 
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display a dialog allowing the user to configure the WPR-48 waterproof remote 
control for either RF or IR and to define the button configuration (9 button 
functions, 18 button functions, 27 button functions or 48 button functions).  

l Viewport: "Update WPR-48 Firmware" function to the file transfer menu. This 
will prompt the user for the appropriate firmware file and upload that file to the 
connected WPR-48.  

l Viewport: Added 500ms delays before and after enterring passto mode and 1s 
delay after exiting passto mode. Without these commands were getting lost 
loading touch panels.  

l Viewport: Support updating the firmware & display lists for a TPMC-10.  
l Viewport: Fixed crash in Test Manager startup.  
l Viewport: Changed default for "retrieve program" to FALSE.  
l Viewport: Added better error detection and propagation so that if during a touch 

panel load, the "free" command does not return with a prompt in time, an 
appropriate error is displayed, rather than 0 bytes are left on your panel. 

Fixes/Changes from 2.05.21 to 2.05.22 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL Windows: Fixed problem that was causing creation of an Archive in 
AppBuilder to fail.  

l SIMPL Windows: Will now automatically rebuild the User and Project IR 
databases after an Import Archive is done, if there were IR files extracted.  

l SIMPL Windows: Fixed problem with Create Archive not always getting USL 
files associated with SIMPL+ modules.  

l SIMPL Windows: Fixed problem where right clicking on the Cresnet card in the 
Configuration was taking a very long time to display the context menu.  

l Test Manager: Fixed crash that occurred on some XP Pro laptops when trying 
to connect to a Control System and the connection couldn't be made. 

Fixes/Changes from 2.05.20 to 2.05.21: 

l SIMPL Windows: Fixed the problem where, on some computers, starting 
veiwport from SIMPL Windows would cause SIMPL Windows to lock up.  

l SIMPL Windows: Fixed the problem where doing anything in the System Tree 
on the Configuration Manager page was causing SIMPL Windows to lockup.  

l SIMPL Windows: Fixed the problem encountered in processing Project/User IR 
drivers that had commas in ther Manufacturer, Model or Filename.  

l SIMPL Windows: Added logic such that SIMPL Windows will add RF devices to 
the default RFID (if there is one defined) when dragged/dropped onto the 
appropriate RF Gateway, or when added to the program via the Add Device To 
System context menu option in the Device Library Tree.  

l SIMPL Windows: Made sure that when a device with a default ID is dropped 
into the program, and the default ID is occupied, that SIMPL Windows is 
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consistent about where it will try to add the device. It will try to drop to the 
device on the first available port on the card.  

l SIMPL Windows: Added an option to Compiler Preferences: "Allow Stacking IR 
and Serial devices on same port". Selecting this will allow the user to drop one-
way serial drivers on the same IR/Serial port where there may already be an IR 
driver or another one-way serial driver. This option comes with a warning 
stating: "This is not a recommended practice. If you chose this option, you 
should try to comment out either the IR or the Serial devices such that both 
device types on the same port don't get compiled into the same executable)". 
This option is being made available such that some basic SIMPL Windows 
programs may be created as 'templates' containing all the potential devices. 
These templates will then be copied and customized to the specific project. In 
these cases the user may want to have both the serial and IR drivers on the 
same port and the programmer who customizes the program will comment out 
the device not used in that specific project.  

l SIMPL Windows: Fixed problem with device extenders not always being copied 
over when replacing a control system.  

l Test Manager: Fixed problem where using context menu in the Trace window 
was causing selected items in Status window to no longer be highlighted in the 
Trace Window.  

l Test Manager: Added display of Signal Type and if triggerable to the Add 
Signals dialog.  

l Test Manager: Added different icons for signals in Status Window if those 
signals have been excluded. If a signal is excluded, the icon will have a black X 
through it.  

l SIMPL+: Correct issue with using SetArray() on string arrays where if the new 
string to write to the array was shorter than the string previously written in the 
array, fragments of the old string would still appear in the string.  

l SIMPL+: Correct issue with #LARGE_STACK directive being written incorrectly 
to .USH file.  

l SIMPL+: Correct GUI crash when compiling when arguments were left off of a 
print() statement.  

l SIMPL Windows: Correct graphical issues with "Compile Complete" dialog box. 

Fixes/Changes from 2.05.19 to 2.05.20 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL Windows: Fixed problem with not being able to swap Serial Devices 
within a Serial Card or across cards.  

l SIMPL Windows: Fixed problem in printing error logs. Sometimes multiple 
copies of the same log was being printed.  

l Test Manager (version 2.04.02): Fixed problem with what appeared to be the 
Trace Window was being forced into Scroll Lock mode.  

l Fixed possible string overflow error when calling a function that returns a string 
(STRING_FUNCTION) within library files. 
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Fixes/Changes from 2.05.18 to 2.05.19: 

l SIMPL Windows: Updated the Detail View display of parameter cues such that 
if a param cue has a "==" in it's name for signifying default values (e.g.p1==1d) 
only show the actual cue name (e.g. only show 'p1' )  

l SIMPL Windows: Don't add "Devices with Default Logic" to device library tree if 
the associated .CMC/.CSP is not in the Symbol Library.  

l SIMPL Windows: Resolved issue when a Device name was not being updated 
if the device comment was changed on the Program View via the F9 
(search/replace) function.  

l SIMPL Windows: Fixed problem in TIO file reads where 2 instances of Simpl 
Windows would not be allowed to read the same .TIO file at the same time.  

l Test Manager/Network Analyzer: Fixed help so that the correct Help Topic 
shows up instead of the 1st page of SIMPL Windows help.  

l Network Analyzer: Fixed toolbar so that the Y&Z Overlap button isn't greyed 
out.  

l SIMPL Windows: Fixed problem with symbol PDF help not showing up when 
selected in the Detail View  

l SIMPL Windows: Fixed problem where default logic for devices that have 
default devices associated below them (e.g. the CPC-CAMI has a serial driver 
that should be added) was not getting connected because the default device 
was not being added.  

l SIMPL+: Fixed compiler optimization issue which caused SIMPL+ modules to 
be compiled even if they were up to date, which slowed down compilation 
through SIMPL Windows.  

l Install: Fix issue where Viewport DLL's were not getting updated by the install.  
l SIMPL Windows: Resolved issue where the same IR driver would appear 

multiple times under the User/Project DB nodes in the Device Library tree.  
l SIMPL Windows: Resolved issue where some IR drivers were appearing in the 

Device Library tree with no names. If there is no model provided by the .IR file, 
SIMPL Windows will now display "No Model" as the name.  

l SIMPL+: Correct issue with advisor where WaitForInitializationComplete() did 
not correctly advise that 3.090 was the minimum CUZ needed (2 Series only).  

l SIMPL Windows: Fixed issue when printing the error log (sometimes an entry 
would get printed multiple times).  

l SIMPL Windows: Show device extenders for the front panels of various 
processors (also available in Library Update 273 and later) (2 Series only).  

l SIMPL Windows: Fix AV2 (with and without card cage) Remote 
Cresnet/Ethernet processing models - remove slot 8 (which accepts an 
Ethernet card) from the slave control system model, as networks off of a slave 
are not allowed (also available in Library Update 273 and later).  

l SIMPL Windows: Change default parameter type to hex for the Serial to Analog 
(OP103) symbol (also available in Library Update 273 and later) .  

l SIMPL Windows: Fix complation error when using the SDPMOLD symbol (also 
available in Library Update 273 and later) (2 Series Only). 
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Fixes/Changes from 2.05.17 to 2.05.18: 

l Internal build only - not released. 

Fixes/Changes from 2.05.16 to 2.05.17 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL+: Correction for SIMPL+ encryption for X Generation Compiler. 

Fixes/Changes from 2.05.15 to 2.05.16: 

l SIMPL+: Add file encryption for X Generation SIMPL+ compiler.  
l SIMPL Windows: Analog Input Properties, Analog Output Properties and 

Parameter Properties will now allow negative values in the Range selections.  
l SIMPL Windows: Fix issue when changing control systems: Touchpanel 

models that had Sleep/Wake inputs would get the sleep/wake copied to 
feedback 1 & 2, and feedback 1 from the old definition would get copied to 
feedback 3 of the new definiton, etc. The fbck inputs are now copied correctly. 
The signals tied to sleep/wake will be lost, however, - SIMPL Windows will 
notify you of this. It is suggested to use a Sleep/Wake Device Extender instead 
(Also available in Library Update 269 and later). 

Fixes/Changes from 2.05.14 to 2.05.15: 

l SIMPL Windows: Double clicking on the Logic Folder or any subfolder icon will 
result in expansion of that part of the tree (instead acting like Ctrl+D and 
showing a window in the Detail View)  

l SIMPL Windows: Added a Right Click context menu option to the Device 
Library for devices that have Default Programming available. For those devices, 
the menu option "Show Inputs/Outputs/Params" will be available. When 
selected, a dialog will display listing all inputs, outputs and parameters for the 
associated Crestron Module that will be used in programming that device with 
the default logic.  

l SIMPL Windows: Correct issue where CNX-DVP4 helpers were seen on the 
C2N-DVP4DI instead of the C2N-DVP4DI helpers (Also available in library 
update 267 and later). 

Fixes/Changes from 2.05.13 to 2.05.14: 
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l Fix front panel for MC2E to show C2I-MC2E-FRONTPANEL, not C2I-MC2W-
FRONTPANEL. (Also available in library update 257 and later.)  

l Fix C2I-RMC-DI4 to show cues i1-i4 instead of all 4 being i1. (Also available in 
library update 257 and later.)  

l Show C2N-TXM Radio model (Also available in library update 259 and later).  
l SIMPL Windows: Fixed problem where dropping a device on the System 

Configuration tree control from D3Pro or System Builder was displaying a 
'Device already exists' message.  

l SIMPL Windows: Added ability to program a Crestron device with logic from 
a .cmc file (i.e. devices in the Device Library that are not under the User 
Devices node). If a Crestron device has 'default' logic, a node will be drawn in 
the Device Library tree under the node displaying the name of the Crestron 
Device. The name displayed on these new levels will be a descriptor defining 
the capablity that would be provided by the associated logic module. There can 
be more than one set of default logic per device in which case, there will be a 
different node for each logic file. If the user selects to add the top level device, 
then no automatic programming will be performed when the device is added to 
the program. However, if the user selects to add an instance of the device with 
it's logic, the user will be prompted for a Prefix to be used in uniquely naming 
the signals during the programming process. If the user requests Help for one 
of the instances of the device with logic, SIMPL Windows will attempt to display 
the Help that is available for the associated logic module. If no help for the 
module exists, then SIMPL Windows will attempt to display Help for the generic 
Crestron device.  

l Test Manager: Added option to View menu to display a signal's driving source if 
that driving souce is a device.  

l Test Manager: Added new File Menu options to Open Port, Close Port and 
Close Debugging Session.  

l Test Manager: Added Scroll Lock toolbar button to stop the Trace Window from 
scrolling but will still take in data from the system. When turned off, data 
received during lock will be available.  

l Test Manager: Added test of selected program versus program in control 
system. will present warning if they're not the same.  

l Test Manager: Added context menu to Status window: include in trace, exclude 
in trace, remove signal from status window.  

l Test Manager: Added context menu to Trace window: exclude from trace, add 
signal to status window. 

Fixes/Changes from 2.05.12 to 2.05.13: 

l SIMPL Windows: Change Stepper symbol so that it shows delay1/len1 through 
delay100/len100 (100 steps). (Also available in library update 252 and later.)  

l SIMPL Windows: Expandable RoomView symbol now requires SIMPL 
Windows 2.05.13 or later and Library Revision 256 or later. 
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Fixes/Changes from 2.05.11 to 2.05.12: 

l SIMPL Windows: Add proper device extenders to CN-TVAV Remote 
Processing, C2N-DAP8, C2N-DAP8RC, and C2VEQ-4 (Also in library update 
251 and later).  

l Viewport: Correct issue where the last digit of an IP Address would get cut off if 
all octets used a full 3 digits (i.e. 132.149.112.224 would get treated as 
132.149.112.22). This problem only existed in Viewport 3.69.  

l SIMPL Windows: Fixed problem with Save As dialog being displayed when 
user cancels out of the "Enter Password" dialog.  

l SIMPL Windows: Added Undo support for: typing over a signal name, changing 
a parameter value, changing device/folder/symbol comments, using F9 to 
search/replace, commenting out symbols, commenting out signals, moving 
Logic symbols or folders around under the Logic node. 

Fixes/Changes from 2.05.10 to 2.05.11: 

l SIMPL Windows: Fix crash when trying to access IP ID config dialog for non-2 
Series control system.  

l SIMPL Windows: Updated Module Header Dialog's Advanced Tab to now ask 
for Device Family and the Device Type associated with the family. It will be the 
selection of both Device Family and Device Type that will used to determine if 
there are any Standard Commands that can be included into the program.  

l SIMPL Windows: Updated Digital Input Properties dialog to now show the 
selected Device Family and Device Type for the current module (if such 
selections exist) and to obtain the list of Standard Commands using both the 
Device Family and Device Type.  

l Viewport: Fixed a problem with the modem connection feature. When you 
exited the viewport and stayed connected, and when you later entered the 
viewport or other software (i.e. Test Manager), the control system would not 
respond even though you are still connected. The "+++" when viewport exits 
was being echoed and put the remote modem into command mode. This is a 2 
Series only issue. 

Fixes/Changes from 2.05.09 to 2.05.10: 

l Viewport: Fixed a bug where viewport would not find an 2 Way Gateway (i.e. 
STRFGWX) when it really was there when connected to an X-gen system and 
was is the last device listed.  

l Viewport: XM Radio support for ID Dialog.  
l Viewport: Changed compacting timeout for touch panels to 15 minutes from 6 

minutes  
l Viewport: When sending a SIMPL program to a 2 Series system, if the program 

requires more NVRAM than is available becuase there is an NVRAM disk 
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allocated, prompt the user to erase the disk to allow the program to fit. If it won't 
fit even without the NVRAM disk, it will fail without prompting. SIMPL+: 
Implement function WaitForInitialization(). This can only be used in function 
Main() and is used to suspend the SIMPL+ module until the first logic solution 
has been run, which will guarantee that inputs to the SIMPL+ module that occur 
at startup have been propagated and have the correct value when reading 
them. Requires CUZ 3.086 or later; 2 Series only.  

l SIMPL Windows: Fixed problem where a signal was being duplicated in the 
program (i.e. 2 instances of same named signal) if an Undo was performed 
previously.  

l SIMPL Windows: Added UNDO for appending Suffix or Prefix in the Detail 
View.  

l SIMPL Windows: Added display of errors if pasting a symbol from the clipboard 
and not everything below it could be pasted.  

l SIMPL Windows: Fixed problem where, if the F4 function was used in Detail 
View to autoincrement a signal name, and an existing signal was part of the 
selection but there was no signal to start autonaming from, the existing signal 
was being deleted. F4 will no longer delete signals if no autoincrementing was 
implemented.  

l SIMPL Windows: Added logic such that IR and Serial drivers cannot be stacked 
on the same port. Also, only 1 serial driver will be allowed on an IR port.  

l SIMPL Windows: Added logic to the Resync process that will now disconnect 
signals from any cue that has been re-labeled as [~UNUSED~]  

l SIMPL Windows: Fixed issue with pdf help files for symbols. If user defines a 
file then removes that from the module header, the system was still looking for 
the pdf file whenever Help was requested.  

l SIMPL Windows: Fixed problem with incorrect symbols being added to a 
program when replacing something like a VEQ4 with a COM card.  

l SIMPL Windows: Fixed problem when replacing an Ethernet InterSystem 
Communication device with an Ethernet InterSystem Communication with RCB 
device. The analog input signals were being transferred over to the wrong input 
cues. Note that the RCB device is not currently released.  

l SIMPL Windows: Fix issue when converting QM-RMC to another 2 Series 
system where the digital output trigger signal names would get lost (Also in 
library update 250 and later).  

l SIMPL Windows: Make UDP/IP device visible. Requires CUZ 3.037 or later. 
(Also in library update 249 and later). 

Fixes/Changes from 2.05.08 to 2.05.09: 

l SIMPL Windows: Fixed problem with user database not allowing .IR files with 
names longer than 50 characters.  

l SIMPL Windows: Fixed SIMPL Windows crash when trying to add a device to a 
program using the System Tree (either via Drag/Drop or right click and select 
Add/Replace Device menu option).  

l SIMPL Windows: Updated Device Library and Symbol Library folder names for 

Page 73 of 116Release notes: SIMPL Windows Release notes:

7/1/2008file://C:\Crestron\Simpl\simpl_release_notes.html



better clarification of where SIMPL Windows is getting it's data (i.e. from a 
Library Update file versus the Crestron Database install). The "Device Library" 
node in the Device Library tree will now read "Crestron Devices (CresLib xxx). 
The "Logic Symbols" node in the Symbol Library Tree, will now read "Logic 
Symbols (CresLib xxx)". The "Crestron Modules" node in the Symbol Library 
Tree will now read "Crestron Modules (CresDb xx.xx.xx)".  

l SIMPL Windows: Added logic to the processing of the "Include Standard 
Commands" option on the Module Header dialog. When this option is selected, 
SIMPL Windows will create a Digital Input, in the Default Argument Definition, 
for each standard command associated with the selected device type and will 
now also create a Digital Input Property item for each of these inputs. 

Fixes/Changes from 2.05.06 to 2.05.08: 

l SIMPL Windows: Implemented 1 level of UNDO for undoing actions that would 
result in symbol/folder/signal deletion, signal renames and signal replacements. 
The Edit menu will show the UNDO option enabled, with a description of what 
action would be undone, if there is something in the 'undo buffer'. In addition, 
there is the Ctl+Z key sequence and a ToolBar button with an 'undo arrow' that 
will also perform an Undo of the last action taken by the operator, if there is 
something in the 'undo buffer'. Note: The Edit->Undo menu option and the 
toolbar button will only be enabled when there is something in the 'undo buffer'.  

l SIMPL Windows: Updated the Device Help processing such that if the Product 
Catalog CD can't be found, or if the CD is found but the appropriate PDF file is 
not found, SIMPL Windows will fall through and try to find a help subject in the 
SIMPL Windows HTML Help.  

l SIMPL Windows: Disable Help option from the Right Click menu in the Device 
Library for devices that come from the CrestronDB. These devices are typically 
3rd party and do not have Help information available.  

l SIMPL Windows: Added logic to the Search and Replace (F9) dialog to replace 
spaces with underscores if Comments and Parameters are not to be a part of 
the search.  

l SIMPL Windows: Removed "Find Next" button from the Edit Menu->Find Ir File 
in Crestron/User/Project Database option as this selection never had any 
processing.  

l SIMPL Windows: Made sure a message is displayed if the "Add Device To 
System" option is selected via right click menu in the device library, and the 
device could not be added.  

l SIMPL Windows: Fixed issues causing AppBuilder to crash.  
l SIMPL Windows: Made sure error messages are displayed in Error Log if a 

device is being replaced by another, or during a replace control system, and 
signal connections in the new device/control system, could not be copied over.  

l SIMPL Windows: Fixed problem with not being able to delete a Module's 
parameter if parameter properties have been defined for that parameter.  

l SIMPL Windows: Fixed problem with user database not allowing .IR files with 
names longer than 50 characters. 
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Fixes/Changes from 2.05.05 to 2.05.06: 

l Fix for CLX lighting module compilation where curve types for Fluorescent 2-
Wire, Electronic Low Voltage, and Magnetic Low Voltage would work only as 
Non-Dim circuits (i.e. on or off). 

Fixes/Changes from 2.05.04 to 2.05.05: 

l SIMPL Windows: Fixed system crash when trying to change the Net ID of 
devices in Configuration Manager.  

l SIMPL Windows: Fixed problem where User/Project Modules that have the 
same name (minus the same file extension) as a User/Project SIMPL+ were 
being flagged as Duplicates and the SIMPL+ module was never getting loaded 
in the Symbol Library.  

l SIMPL Windows: Fixed problem with Replace Control System not transferring 
over some signals if the system had a Poll Accelerator in it.  

l SIMPL Windows: Enforced some legality rules for Passwords on File 
Encryption:  

l Passwords will be 1-16 characterss long  
l Passwords must be printable ASCII characters  
l Passwords are case insensitive  
l SIMPL Windows: Made Password Dialog wording clearer  
l SIMPL Windows: If doing a SAVE AS of a SIMPL Windows program, the file 

will be saved under the same password protection state as the original file (e.g. 
if the current program is encrypted, the new file will be encrypted with the same 
password. If not encrypted, the new file won't be encrypted).  

l SIMPL Windows: Fixed issue with "Edit Module" not bringing up the Simpl+ 
application as the active window if selecting to Edit a Simpl+ module that was 
encrypted.  

l SIMPL Windows/SIMPL+: Stack Checking Implemented for 2 Series systems; 
In SIMPL+, the new directives are #ENABLE_STACK_CHECKING and 
#LARGE_STACK. When #ENABLE_STACK_CHECKING is used, the 2 series 
will give an error and abort the current event in progress 
(push/release/change/etc.) if there is a potential stack overflow condition. The 
user can attempt to fix this by specifying the #LARGE_STACK directive. 
USAGE OF THESE DIRECTIVES WILL REQUIRE 2 SERIES FIRMWARE 
3.083 OR LATER.  

l SIMPL Windows: Correct issue where several Ethernet Remove Processing 
modules did not have the correct Ethernet IP Dialog in the Configuration 
Manager (Also available in Library Update 246 and later.)  

l SIMPL Windows: Correct issue where MC2E remote processing modules listed 
the Internal RF Gateway. This processor does not have the Gateway, and as 
such, it should not be listed (Also available in Library Update 246 and later.) 
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Fixes/Changes from 2.04.14.05 to 2.05.04: 

l SIMPL Windows: File Encryption incorporated: User can now password protect 
a SIMPL Windows program or SIMPL Windows User/Project module via the 
File Menu->Password Protect option, or via a new toolbar button located next 
to the Save File button. When this option is selected, the user will be prompted 
for a Password, and the file will be encrypted. User can remove password 
protection on SIMPL Windows programs or SIMPL Windows User/Project 
modules if they enter the password used to protect the file. This is available, 
when an encrypted file is open in SIMPL Windows, via the File Menu->Remove 
Password Protection option, or via the new toolbar button located next to the 
Save File button. Encrypted modules may be used by other users in their 
programs, and will appear in the Symbol Library Tree even if the user does not 
have the password, however, without correct entry of the password, encrypted 
files may not be opened for editing, nor will the source be available for viewing 
in any text editor. To have encrypted files available for use within SIMPL 
Windows, the hard drive must have privileges for file deletion by the current 
user. If this is not the case, error messages will be placed in the Error Log 
identifying which files could not be made available. File encryption also 
implemented for SIMPL+ modules.  

l SIMPL Windows: Removed middle window (the view that showed card or 
network device detail) on Configuration Manager Page. The lower tree view 
should be used for all card/network device configuration.  

l SIMPL Windows: Incorporated CmSmplLt into Simpl Windows processing (no 
visible User Interface changes due to this)  

l SIMPL Windows: System Configuration Tree will now allow users to move 
relays within the tree.  

l SIMPL Windows: Module Header has been reworked to now have 3 Tabbed 
pages: General Information page: allows for selection of the same Module 
Header data that has always been available (i.e. programmer info, symbol tree 
category, target control system, help file, and comments). Advanced 
Information will allow the user to select Device Type, Manufacturer, Model, 
Template, and if Panel Pages should be added by default. These settings are 
used by AppBuilder/D3Pro. If a module has not yet had the Default Arguments 
programmed, the user can also select to have the Standard Commands 
associated with the selected Device Type be added as Default Arguments 
Inputs. Protected Information is a page that will only be available to users with 
Crestron or Expert priveleges. This page allows entry of a 'Private' comment 
field that will be used by AppBuilder and D3Pro systems. The data in this field 
should never be modified by users.  

l SIMPL Windows: Device Library User Database now has subfolder categories 
of Manufacturer and Device Type to User and Project IR devices displayed in 
the Device Library Tree.  

l SIMPL Windows: Updates to Input/Output/Parameter Property data (note, 
these dialogs and the data entered, are for use by the Module programmer to 
be able to convey information to the user of that module. In addition, this data is 
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also used by the D3Pro and AppBuilder applications): Added message box to 
tell user if properties exist when they delete a Parameter in the Default 
Arguments of a Module. If the user wishes to continue, the properties will be 
deleted. Added "Reset" buttons to the Input/Output/Parameter Properties 
dialogs  

l SIMPL Windows: Fixed issue with Error Log that was causing system crash 
due to trying to access non allocated memory. This was causing AppBuilder to 
crash on some computers.  

l SIMPL Windows: Changed the 'Copy Program' option on the File Menu to now 
read as 'Create Archive'.  

l SIMPL Windows: Remote System Definition Updates There are now 2 Ethernet 
InterSystem Communication (EISC) devices that can be used to import/export 
Remote System Defintion files. The newly added EISC supports Ramp Control 
Blocks (RCB). Because of this, the following changes have been made to the 
Remote System Definition processing in SIMPL Windows: 

¡ Exporting to Remote System Definitons Either type of EISC may be 
exported to an .RSD file. It is recommended that the newer EISC w/RCB 
be used in future programs.  

¡ Importing If a new import is being done, then the EISC from which 
the .RSD file was created will be added to the program.  

¡ If an RSD is being imported as a 'Refresh' (i.e. the same RSD file has 
been imported previously), the EISC device in the program must be the 
same as the EISC in the updated .RSD file or an Error message will be 
generated to the error log. 

l SIMPL Windows: Drag and Drop of Remote Processors - Added logic to allow a 
remote processor to be dragged on top of the cresnet card or the ethenet card 
and have the plus sign show it as a potential valid drop. This is the way it is with 
other cresnet and ethernet devices but until this change, the remote processors 
weren't working that way.  

l SIMPL Windows: Fixed crash that occurred when trying to compile a program 
that had empty User Modules (i.e. no logic whatsoever, just Default 
Arguments), embedded into other modules used by the program.  

l SIMPL Windows: Removed the always-greyed out "Arrange Icons" option from 
the View menu. Network Analyzer: Fixed issue with Network Analyzer tool not 
being able to open the help file.  

l SIMPL Windows: When compiling 2 Series programs, flag any transmitter 
(except the CNWM) under a CNRFGW set to below ID 10 as being an illegal 
transmitter ID. This is already present in the X Generation compiler. 
Transmitters below ID 10 that communicate with the CNRFGW are not 
compatable with Cresnet II RF Transmission format. Implemented function, 
SendMailWithAttachments.  

l SIMPL+: Added error code IDS_SMTP_FAILURE_MAIL_COMMAND to 
SendMail function (IDS_SMTP_FAILURE_MAIL_COMMAND = 2)  

l SIMPL+: Modified Function Main in SIMPL+ default file template to include note 
about when to read Input/Output variables.  

l SIMPL+: Fixed translation error when using return values for functions that 
contain structure arguments. Ex: integer = MyFunc( MyStruct arg );  

l SIMPL+: Fixed translation error when using non-volatile FILE_INFO arrays. Ex: 
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Print( "%s", finfo[i].name );  
l SIMPL+: Fixed translation error when full path is contained in 

#USER_LIBRARY function.  
l SIMPL+: Fixed translation error when '0' precedes numeric constant in 

#define_constant. Preceding 0's are now removed from constants. Ex: 
#define_constant MyConst 09.  

l SIMPL+: Fixed compiler error when using break statements within embedded 
CSwitch statements.  

l SIMPL+: Implemented error checking on STRING_OUTPUT assignments.  
l Viewport: Added a command and dialog to get the XM subscription number 

from the new xm device.  
l Viewport: Fixed a bug dealing with iptables on Pro2. If the system did not have 

an iptable on it, and viewport did a GETIPTABLE, the system would come back 
with an error that was not checked, then the viewport would sit there waiting for 
the file. This was introduced in Rev 3.52 when a change was made to always 
get the file without checking how many entries it reported in INFO since that is 
not updated until after a reboot.  

l Viewport: Fixed a bug where if Shift-F10 or Ctrl-F10 were pressed, which is a 
system command, F10 shortcut would not work again.  

l Viewport: Fixed a logical bug with Touch Panel IP tables where it would just 
toss any entries not marked as master since it is only allowed to have masters. 
Added some checking so if any are not master, it'll show an error dialog and not 
change anything.  

l Viewport: Fixed SSL connections when viewport functions are called from other 
apps (Netlyzer, Test Manager, SIMPL Windows, etc.) A delay is incurred the 
first time each application accesses the SSL connection when it is started up. 
For example, SIMPL Windows incurs a delay of approximately 10-20s when 
you first transfer a file to the control system over SSL through SIMPL Windows.  

l Viewport: Removed the long DLL load wait when viewport is loaded from 
SIMPL the first time.  

l Viewport: For SendTouchPanel if the device doesn't support a display list we 
now do an old style transfer rather than reporting an error.  

l Viewport: Fixed memory leaks dealing with SSL objects (nothing to do with 
actually connecting to SSL). 

Fixes/Changes from 2.04.14.04 to 2.04.14.05: 

l Library Update: Fixed completness check for CLI lighting modules in 2 Series 
systems so that both the input signal & the parameter must be filled in to be 
complete. Filling in one or the other is not sufficient (now behaves like CLX 
modules). 

Fixes/Changes from 2.04.14.03 to 2.04.14.04: 
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l Replace Control System: Fixed issue with not all cards getting copied over 
during a replace control system. 

Fixes/Changes from 2.04.14.02 to 2.04.14.03: 

l Library Update: Fixed issue with Serial Drivers on QM-RMC not displaying 
correctly. There is a new input called [RESERVED]. This input should not be 
used! (Also available in Library Update 236 and later).  

l Simpl Windows Compiler: Fixed issue introduced with 2.04.14. The 2 Series 
compiler would not compile ports that were empty on the following cards: 
TVAVCOM-1, DAP8COM-1, CNXRMCOM-1. "Empty" meant none of the 
optional I/O (denoted by [] around the name) was filled in. This meant that if the 
user tried to simply use match strings or trigger strings, the port would not work 
correctly. The optimization is now fixed; if digital inputs for triggering strings or 
digital outputs for matching strings are the only I/O present, the device will still 
function.  

l Simpl Windows: Fixed system crash when trying to compile a program that had 
an empty (i.e. no symbols) module nested within another module.  

l Viewport: Fixed a bug in the ethernet dialog where selecting LAN B would clear 
any DHCP or WINS settings (check boxes also if either of them were enabled 
on the control system, when the dilog pops up the check boxes for those items 
would not be checked.  

l Viewport: Fixed a bug where if connected securely, under certain conditions 
(updating a touch panel firmware) it may not re-connect to the control system 
properly. It would fail with a dialog msg "Write error".  

l Viewport: Fixed bugs in sending NVRAM files. 

Fixes/Changes from 2.04.14.01 to 2.04.14.02 : 

l SIMPL Windows: Fixed installation problem.  
l Library Update: Fixed issue with Serial Drivers on QM-RMC not displaying 

correctly. There is a new input called [RESERVED]. This input should not be 
used and will be removed in later versions of SIMPL Windows. (Also available 
in Library Update 236 and later).  

l Viewport: Version 3.56 - fixed several bugs with the DLL call 
vptSendMailboxDef where it would not use the proper connection parameters. 
There was also a bug with error reporting if the file was overwritten. 

Fixes/Changes from 2.04.14 to 2.04.14.01: 

l SIMPL Windows: Fixed issue with not being able to comment/uncomment 
symbols in the Program Manager program tree.  
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l SIMPL Windows: Fixed Simpl Windows crash when compiling a program with a 
module whose disk file could not be located. 

Fixes/Changes from 2.04.13 to 2.04.14 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL+: Fix issue when compiling programs that have SIMPL+ components on 
network drives. An error message "An Unnamed file could not be accessed" 
would sometimes pop up and cause the compile to be aborted. Library Update: 
Correct 2 Series compilation of the CNWM-8 panel so that "Update Request" 
messages are not continuously generated by the CNWM-8 (Also in Library 
Update 230 and later).  

l Library Update: Finish support for "Ethernet Offline Manager" which can be 
dropped as a device extender on the following ethernet devices (ONLY IN A 2 
SERIES PROGRAM): - CEN-IO, CEN-COM, CEN-CN, Virtual Communications 
Port, e-Server (OEM), Ethernet Intersystem Communications, CEN-TVAV 
(Remote & Mixed Processing), TPS-5000/6000/TPI w/TPS-ENET, all 2 Series 
Slave models. (Also available in Library Update 231 and later).  

l Library Update: Change order of signals for on the "DAP8 Analog Audio 
Switch". The inputs used to be CAT5_Src, DSP/OutB_Src, OutA_Src. They are 
now OutA_Src, DSP/OutB_Src, CAT5_Src. The DAP8 firmware always 
recognized the first input as OutA_Src and the third input as CAT5_Src (Also 
available in Library Update 231 and later).  

l Library Update: Prevent C2N-DAP8 and C2N-DAP8RC from dropping on X 
Generation control systems (Also available in Library Update 232 and later).  

l SIMPL Windows: Fixed Replace Control System Issues: 
¡ Incorrect serial drivers were sometimes being used when replacing one 

COM card with another.  
¡ A Remote Processing Module was being added to the Cresnet 

unnecessarily.  
¡ Replacing a CNX-DVP4 with a C2N-DVP4DI wasn't copying over the C2I-

TPS symbol nor it's Device Extender symbols appropriately.  
¡ Replace control systme logic will not allow a Remote Processing Module 

to be added to the new program just to support moving over one of the 
devices. Note: if a Remote control system is a part of the original program, 
it will be moved over.  

¡ Fixed problem where some Device Extender symbols were not getting 
moved to the new program. If a Device Extender exists in the original 
program and is not allowed on the new control system, the symbol will still 
be moved over but will be commented out such that programming will not 
be lost. However, the user will not be allowed to uncomment out these 
symbols, they will only be able to copy the program to something else 
and/or delete the symbol.  

¡ Fixed problem with moving over devices that are part of a 'group' of 
devices (such as the '3 Low Voltage Relays' from the crestron database) 
and not maintaining knowledge of which devices were supposed to be 
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grouped together. 
l SIMPL Windows: Added a test at Program open to tell user if a Resynch may 

be required.  
l SIMPL Windows: Fixed problem with not being able to access Crestron IR files 

larger than 10k  
l SIMPL Windows: Removed display of "Logic Node Commented Out" warning 

message every time a program with a TPS Series Panel as the control system 
is opened. When the control system is added the first time, the Logic Node is 
commented out and the user is given the Warning message. However, Simpl 
Windows will no longer display that message each time the program is opened.  

l SIMPL Windows: Fixed problem where, if Simpl Windows was not full screen 
size and then minimized, and the open program was then modifed by some 
other process (such as another instance of Simpl Windows), the minimized icon 
could never be restored if the user answered NO to the message box that 
asked if the program should be reloaded.  

l Viewport: Fixed bug where WINS would not be enabled or recognized properly 
in Configure IP dialog.  

l Viewport: Added support for SSL  
l Viewport: Fixed bug in Identify Transmitter ID where any hex digits ('a' - 'f') 

were not converted properly so it would give an incorrect transmitter ID.  
l Viewport: Fixed bug in updating firmware to a DVP4 where the "MESSAGE" 

command was incorrectly being sent after the system rebooted.  
l Viewport: Fixed bug in IP table config. This would give a warning when closing 

the ip table dialog after adding any entries to an empty table.  
l Viewport: Fixed bug in CNX-ENET card update.  
l Viewport: Added "STOPPROGRAM" and "PROGRESET" commands when 

configuring a CNXTA card to ensure reliable communications.  
l Viewport: Fix problem in exit pass-through function. This was causing problems 

becuase the viewport tried to find the control system, but since it was in pass-
through it wouldn't be found.  

l Viewport: Added support for the TPS-RFGWX with band selection capabilities. 
Reworked the channel / band / low power selection dialog to detect the 
capabilities of the gateway and verifiy the settings were actually set correctly.  

l SIMPL Windows: Change CLW-SW/SWS/DIM/DIMS to require CUZ 3.053 or 
later (Also available in Library Update 234 and later).  

l SIMPL Windows: Add support for STX-1700CXP, QM-RMC, *C2N-IADS, *C2N-
IVDS, *C2N-NPA8 (Also available in Library Update 234 and later). Note that 
items marked with "*" do not currently have help available.  

l SIMPL Windows: Correct issue with CHV-TSTAT/THSTAT Basic Symbol where 
the following inputs would not function correctly: FRONT_PANEL_LOCKOUT, 
OUTDOOR_TEMP, OUTDOOR_HUM, INDOOR_HUM, and correct issue 
where the following outputs would not function correctly: 
REGULATION_HUMID_F, OUTDOOR_HUMID_F. The Advanced symbol has 
no issues. (Also available in Library Update 234 and later).  

l SIMPL Windows: Add Volume feedback for the C2N-VEQ4 General Audio 
Controls. If you have an existing program and wish to gain access to the new 
feedback outputs, you will have to perform a ReSync Program in SIMPL 
Windows. (Also available in Library Update 234 and later.) 
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Fixes/Changes from 2.04.12 to 2.04.13: 

l SIMPL Windows: Fixed problem with handling of a Serial Poll Accelerator in a 
replace control system operation.  

l SIMPL Windows: Fixed problem with getting "TIO: File opened for write" error 
when doing a File->Save if have more than 2 other instances of Simpl Windows 
open and all with 'Untitled' modules.  

l SIMPL Windows: Fixed problem with Rename Signal function not working 
properly.  

l SIMPL Windows: Added support in compiler for new QM-RMC device (TIO 
support still pending).  

l SIMPL Windows: Fixed problem where adding a Prefix to a set of selected 
signals was also adding the prefix to the reserved signals "0", "1", and "Local".  

l SIMPL Windows: Correct long-standing compiler issue where percentages 
w/out a leading 0 before the decimal point (i.e. ".1%") would not convert 
properly. 

Fixes/Changes from 2.04.11 to 2.04.12: 

l SIMPL Windows: Add Poll Manager to CHV-TSTAT/THSTAT Thermostats 
(also available in Library Update 222 and later).  

l SIMPL Windows: Fixed Live Update to not show the "Updates Available" on 
every start of Simpl Windows when there really weren't updates available.  

l SIMPL Windows: Fixed problem with Replace Control System not copying over 
device locations.  

l SIMPL Windows: Fixed problem with Replace Control System not copying over 
bookmarks with Device Symbols correcltly.  

l SIMPL Windows: Fixed problem with SIMPL Windows crashing if too many 
errors are added to the error log. Since it is possible for tens of thousands of 
notices/warnings to be generated during a compile as a result of undriven 
signals and/or signals without destinations, Simpl Windows now limits the 
amount of errors to be shown and puts up a message in the error log that there 
are more errors that could not be shown (fix existing issues and recompile). It 
should be noted that certain warnings/notices can be turned off in Edit -> 
Preferences (i.e. don't display signals without destinations, etc.).  

l SIMPL Windows: Fixed issue with the end of some Module Comments being 
lost when the comments were really long.  

l SIMPL Windows: Fixed problem on Copy to Compact Flash dialog where typing 
in a drive letter was not being recognized.  

l SIMPL Windows: Removed generation of Data Integrity error if a program is 
opened or saved and unused signals are found. Simpl Windows will now 
perform the appropriate clean up.  

l SIMPL Windows: Implemented a quicker signal lookup algorithm to help speed 
up AppBuilder and D3Pro program generation. This should also shorten the 
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time SIMPL Windows takes to display the list of signals in the Program View.  
l SIMPL Windows: Added a Warning message to be displayed in the error log if 

a program/module is opened (including if opened from the compiler) and a 
symbol file refrenced in the program (.umc or .ush) can't be found in the User or 
project dir (Also see related compilation messages below).  

l SIMPL Windows: Fixed problem where SIMPL Windows was allowing 
programs to be saved to a .CMC (crestron macro) file extension.  

l SIMPL Windows: Implement several new errors for missing user/Crestron 
modules during compilation. Below are examples of the new messages. These 
the errors associated with user modules often result in manually copyin a 
program and forgetting to include a .UMC or .USH file. For this reason, we 
HIGHLY encourage using the Copy Program feature in - SIMPL Windows. The 
errors associated with Crestron modules are less frequent, but may be the 
result of an older database that didn't include a particular module. 

¡ Symbol S-5 (mymacro.umc) cannot be opened. Check location in User 
modules or program folder.  

¡ Symbol S-5 (crestronmacro.cmc) cannot be opened. Check location in 
Crestron database or verify installation of latest database.  

¡ Symbol S-5 (mysplus.USH) cannot be opened. Check location in User 
SIMPL+ or program folder, or recompile the associated .USP file.  

¡ Symbol S-5 (crestronsplus.csh) cannot be opened. Check location in 
CRSSPLUS.DAT or verify installation of latest SIMPL Windows.  

¡ Symbol S-5 (mymacro.umc) in macro S-6 (Module file c:\user 
macros\wrapper.umc) cannot be opened. Check location in User modules 
or program folder.  

¡ Symbol S-5 (crestronmacro.cmc) in macro S-6 (Module file c:\user 
macros\wrapper.umc) cannot be opened. Check location in Crestron 
database or verify installation of latest database.  

¡ Symbol S-5 (mysplus.USH) in macro S-6 (Module file c:\user 
macros\wrapper.umc) cannot be opened. Check location in User SIMPL+ 
or program folder, or recompile the associated .USP file.  

¡ Symbol S-5 (crestronsplus.csh) in macro S-6 (Module file c:\user 
macros\wrapper.umc) cannot be opened. Check location in 
CRSSPLUS.DAT or verify installation of latest SIMPL Windows. 

l SIMPL Windows: Remove .SIG file from inclusion in .SPZ file. The size 
computation for what gets uploaded to the control system is now accurate. 
Previously, when the .SIG file was included in the .SPZ, there was a chance 
that the .SPZ file would claim to be too large to upload, even though the .SIG 
file doesn't actually get uploaded. 

Fixes/Changes from 2.04.10 to 2.04.11 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL+: Further bug fixes for compile optimization problems.  
l Issue fixed with duplicate information in the .SIG file that caused Test Manager 

to show signals that didn't really have changes. 
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Fixes/Changes from 2.04.09 to 2.04.10: 

l SIMPL Windows: Fixed problem on Configuration Manager page, when a 
Cresnet/Ethernet device is replaced,the associated icon in the upper rack view 
would disappear.  

l SIMPL+: Fixed compile optimization bug when compiling with a newer version 
of SIMPL+ and/or INCLUDE.DAT file, which would result in a "Could not copy 
SIMPL+ output file to {name}.spl" error. 

Fixes/Changes from 2.04.08 to 2.04.09: 

l Correct further issue with IR compilation slowdown.  
l Correct power factors on MP2, MP2E, CNXFXZ, TPS-2000.  
l Correct symbol now appears for XPanel device.  
l Correct compilation issue with MC2E, MC2W control systems where it 

mistakenly assumed it was a TPS Remap compilation (Library 219 and later). 

Fixes/Changes from 2.04.07 to 2.04.08: 

l Internal build only - not released. 

Fixes/Changes from 2.04.06 to 2.04.07: 

l SIMPL Windows: Added 'Live Update at Startup' option to General Preferences 
dialog in case Live Update dialog can't display and user wants to disable this 
option.  

l SIMPL Windows: Replace Control system will not automatically add 
'discontinued' devices if user has selected NOT to show discontinued devices 
via the General Preferences dialog.  

l SIMPL Windows: Fixed compiler crash when sometimes compiling program 
with IR files under Simpl versions 2.04.04 and 2.04.05.  

l SIMPL Windows: Updated rules for when to allow a Poll Accelertor to be added 
to a program: Only 1 Poll Accelerator is allowed in a system at this time.  

l SIMPL Windows: Poll Accelerators are not allowed on Remote Processing 
Modules (Slave control systems).  

l SIMPL Windows: Correct compilation issue where IR drivers took a long time to 
compile (Introduced in 2.04.XX).  

l Viewport: Fixed bug where message wasn't being shown during 2-series 
program transfers.  

l Viewport: Expanded error message for when pre-2-series control system 
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versions don't match during program upload.  
l Viewport: Fixed bug in SendWebPages that would pop up innacurate message 

box.  
l Viewport: Adjusted precision of SendWebPages "Changed only" heuristics for 

better matching.  
l SIMPL+: Don't allow I/O variables to have a minimum array size of 0.  
l SIMPL+: Don't allow Nonvolatile or Volatile keywords within structure 

definitions.  
l SIMPL+: Fixed bug when using strings inside of a Nonvolatile structure 

variable.  
l SIMPL+: Fixed bug when using arrays inside of file read functions. (ex: i = 

ReadInteger(iHandle, myStruct[1].int[2]);) 

Fixes/Changes from 2.04.05 to 2.04.06: 

l SIMPL Windows: Compatability issues fixed with MP2 Wizard. 

Fixes/Changes from 2.04.04 to 2.04.05: 

l SIMPL Windows: Fixed problem with some areas allowing commas in 
filenames and other areas not. Commas are now only prohibited from Module 
file names.  

l SIMPL Windows: Fixed problem with Input/Output/Parameter Property menu 
being enabled in the Detail View if more than one signal is selected. This menu 
option is only available for a single signal selection.  

l SIMPL Windows: Made error reporting of symbols under the Logic folder a little 
cleaner. The error message will now only show the full node heirarchy of the 
symbol (e.g show only S-1.1.2 instead of S-1.S-1.1.S-1.1.2)  

l SIMPL Windows: Add seperate symbol for CNX-PVID8x3J13S rather than tie it 
to same symbol as CNX-PVID8x3. The symbol I/O is the same, however.  

l SIMPL Windows: Add seperate symbol for CNX-PVID8x4J13S rather than tie it 
to same symbol as CNX-PVID8x4. The symbol I/O is the same, however.  

l SIMPL Windows: Move CNXENET card to Discontinued folder under "Cards 
(DPA, Discontinued)"  

l SIMPL+: Allow negative constants in CSwitch statement.  
l SIMPL+: Fixed compiler crash for syntax errors like: Nonvolatile var1; (missing 

type declaration, should be Nonvolatile integer var1; for example).  
l SIMPL+: Output # character in I/O variable names within .ush file to be 

displayed properly in SIMPL Windows.  
l SIMPL+: File | Open dialog allows multiple selection of files for opening.  
l Viewport: Fixed problem where IP Table setup could crash if using address 

"0.0.0.0".  
l Viewport: Fixed problem where program would sometimes not get restarted 

after program upload.  
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l Viewport: Improved delays in IP Table management when no IP entries were 
already present.  

l Viewport: Fixed bug where Project Name would no longer appear in program 
upload progress dialog.  

l Viewport: Fixed bug where IP Table Add dialog would not allow valid 
hostnames.  

l Viewport: Fixed error when trying to exit touchpanel setup mode.  
l Viewport: Added warning for users who have disabled NTFS 8.3 support.  
l Viewport: Fixed bug where default IP table would be sent automatically when 

sending a program from SIMPL Windows.  
l Viewport: Added TSID field to "Set Cresnet ID by Serial Number" Dialog.  
l Viewport: Added checks for multiple devices when broadcasting set serial 

number. 

Fixes/Changes from 2.04.03 to 2.04.04: 

l SIMPL Windows: Completed support for Property definitions for all types of 
Inputs/Outputs and Parameters. To define property information, while 
programming a Simpl Module, in the Detail View the user can select a Default 
Argument Input, Output or Parameter and right click and select to Edit the 
Property option(Alt+F3 will also bring up the appropriate dialog). Property 
definitons are typically used to provide information to the user of a module. To 
view an item's property definition at any time, in the Detail View the user can 
select the desired item, then right click and select the View Property option 
(again, Alt+F3 will also work). See discussion in Release Notes for 2.04.00 for 
more detail regarding properties.  

l SIMPL Windows: Fixed problem in Import Crestron Module where the Target 
Control System (for both Simpl and Simpl+ modules) was not being imported.  

l SIMPL Windows: Added selection of a Device Type on the Module Header 
dialog. The list of device types comes from the Crestron Database (e.g. 
Generic, Audio, Mixer, Tuner, etc) and allows the programmer the option of 
assigning a Device Type that the module will support. This device type is used 
on the Digital Inputs Property definition dialog to allow the programmer to 
assign a Standard Command to the particular digital input. The list of Standard 
Commands also comes from the Crestron Database. Selectio of these items 
are optional.  

l SIMPL Windows: Added an "Add Files" selection to the Copy Program dialog 
such that the user may choose to add files, other than those presented by 
Simpl Windows, to the archive.  

l SIMPL Windows: Fixed problem with system crash if user tried to replace 
device with exact same device.  

l SIMPL+: Implemented minimum array sizes for declaring fixed sized Input and 
Output arrays. The declaration, DIGITAL_INPUT digIn[10,5], specifies that the 
digIn has a fixed minimum of 5 indices.  

l SIMPL+: #DEFINE_CONSTANTs in library files are accessible from the .usp 
file.  
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l SIMPL+: File | Import Crestron SIMPL+ Library will preserve original target 
types.  

l Viewport: Added menu item for NVRAM Disk sizing.  
l Viewport: Added menu item for uploading and download NVRAM Disk images.  
l Viewport: Fixed bug where some messages displayed during file transfers 

would appear oddly (introduced in viewport v3.35).  
l Viewport: Passthrough status now displayed in Communication Status box in 

Ethernet mode.  
l Viewport: SetNetId function now more reliable when checking verifying that an 

ID was set.  
l Viewport: Changed "Send Web Pages" to use VTPro-e generated 

_CONFIG_INI_ if it exists, instead of generating one.  
l Viewport: Fixed bug in Configure Ethernet Dialog where the DHCP setting 

wasn't getting changed properly.  
l Viewport: Fixed bug in "Send Web Pages" where the Viewport could try to send 

the invalid files, "." and ".."  
l Viewport: Added LiveUpdate support to Help menu.  
l SIMPL Windows: Implement models for C2COM-2, CLX-1FAN4, CLX-1DELV4, 

MC2E, MC2W (Also available in Library update 210 and later)  
l Viewport: Fixed problem where IP Table setup could crash if using address 

"0.0.0.0"  
l Viewport: Fixed problem where program would sometimes not get restarted 

after program upload.  
l Viewport: Improved delays in IP Table management when no IP entries were 

already present. 

Fixes/Changes from 2.04.02 to 2.04.03: 

l Changed install to use Stand Alone viewport.  
l SIMPL+: Implemented minimum array sizes for declaring fixed sized Input and 

Output arrays. The declaration DIGITAL_INPUT digIn[10,5] specifies that the 
digIn has a fixed minimum of 5 indices. This applies to all I/O types.  

l SIMPL Windows: Finalized support for properties on inputs and outputs of 
macros (introduced in 2.04.00).  

l SIMPL Windows: Fixed problem with trying to open Modules via the "Edit In 
New Instance" method. Modules that had a '-r' anywhere in it's name were not 
being opened.  

l SIMPL Windows: Added Notice to be shown to user during Replace Control 
System to let them know if any devices were added 

Fixes/Changes from 2.04.01 to 2.04.02: 

l SIMPL Windows: Added support for Digital Output and Analog Input Property 
definitions (see discussion in Release Notes for 2.04.00 for more detail 
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regarding properties).  
l SIMPL Windows: Fixed problem with trying to open Modules via the "Edit In 

New Instance" method. Modules that had a '-r' anywhere in it's name were not 
being opened.  

l SIMPL Windows: Added Notice to be shown to user during Replace Control 
System to let them know if any devices were added.  

l Viewport: Removed bug where '\x00' characters embedded in Sequence 
Strings would end transmission of the string and not be transmitted.  

l Viewport: Fixed support for "Level 2" IP Tables.  
l Viewport: Added support for setting the control system Domain Name.  
l Viewport: Added support for reconnecting by hostname.domainname when 

enabling DHCP.  
l SIMPL+: Compile error and warning codes are displayed in Compile Output 

Window. Pressing F1 on the highlighted line in the Compile Output Window will 
display the corresponding error topic within the help file. (2-Series only) 

Fixes/Changes from 2.04.00 to 2.04.01: 

l SIMPL Windows: Fixed problem with importing certain VTPro-e UI projects that 
was causing SIMPL Windows to lock up.  

l SIMPL Windows: Replace Control System will now copy BookMarks when 
possible.  

l SIMPL Windows: Display of Current Bookmark: Detail View window will now 
display the name of the current Bookmark if there is one selected. However if a 
bookmark is being displayed and symbols are added, symbol windows closed, 
or multiple bookmarks are being displayed at one time, then the name of the 
bookmark will no longer be displayed.  

l SIMPL Windows: Copy Program will now include SIMPL+ Library files used by 
any Simpl+ modules within the program. To take advantage of this, you MUST 
rebuild all of the - Simpl+ modules that reference a Library File. This can easily 
be achieved by using the Project Menu->Rebuild All command.  

l SIMPL Windows: Symbol Names on Signal trace enhanced: When a signal 
traces to a device's symbol, the symbol name will now reflect it's full location 
within the Central Control Module's tree (e.g. if a signal is mapped to IR Port A 
of slot 1 at ID 03 of the cresnet card in slot 9, then the symbol name will now 
appear as: Slot 09.ID-03,Slot-01,Port-A instead of just 'Port-A'). This enhanced 
name display will also appear in a device's symbol window title bar when 
displayed in Detail View.  

l SIMPL Windows: Added processing to catch filenames that have been 
shortened into DOS 8.3 format when opening Simpl Windows by double 
clicking on an .smw file. Although Simpl Windows is not capable of translating 
the shortened filename behind the scenes, it will at least inform the user before 
the file is opened with the shortened name, and give the user the option to 
select and open the long file name.  

l SIMPL Windows: Provided more informative error messages if a device could 
not be moved or added.  
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l SIMPL Windows: Better Data Integrity error processing for unknown Devices or 
Symbols on program open: Error log will now provid more information (code, 
name and library version under which program was saved) when Simpl 
Windows encounters a Device or Symbol that is not in the currently loaded 
Library. If an unknown device is encountered, the program will not be allowed 
to be opened.  

l SIMPL Windows: When the Device Info Configuration Dialog is displayed, if 
there is an associated Driver File, it will also be displayed on the Status Bar at 
the bottom of the Simpl Windows window.  

l SIMPL Windows: Added SIMPL Windows support for Poll Accelerators: The 
Cresnet Arrow in the Configuration Manager page will show 2 arrows if there is 
a Poll Accelerator in the system. Also, the bitmap used for the Cresnet Card in 
the System Configuration tree will also change to indicate when there is a Poll 
Accelerator in the system.  

l SIMPL Windows: Changed terminology on Front Panel Editor to use "Join" 
instead of "Channel" and to use "Page Jump" instead of "Page Flip".  

l SIMPL Compiler: Fix problem with pre-CLX lighting modules with 
INCANDESCENT and NON-DIM curve types being reversed.  

l Viewport: Fixed "Remoted Console Disconnect" to not look for rack at 
command start  

l Viewport: Fixed "Report Network" to print command sent to Outgoing window  
l Viewport: Fixed IP Table dialog so that when an entry is modified it lists as a 

PC entry  
l Viewport: Restored 0.0.0.0 as a valid address in the IP Table (primarily for use 

with TCP/IP Server symbols)  
l Viewport: Fixed bug where characters from 0x7F to 0xFF wouldn't be printed 

properly in the Viewport terminal, although they would be sent.  
l Viewport: Updated "Send Program" dialog to automatically get program 

information from pre-2-series processors as well as 2-series processors  
l Viewport: Added workaround to TPS bug with long MESSAGE text in 

touchpanel uploads.  
l Viewport: Added Web Port configuration to Ethernet Configuration dialog  
l Viewport: Finalized support for DHCP  
l SIMPL+: Write user library filenames into .ush file  
l SIMPL+: Additional bounds checking for accessing elements of arrays of 

structures.  
l SIMPL+: Added the following in the SIMPL+ new template module: 

¡ Structure Definition section  
¡ Reminder to initialize all declared string variables. 

l SIMPL+: Fixed bug that allowed a function parameter to be the same name as 
the function. (ex: Function MyFunc( integer MyFunc ) )  

l SIMPL+: Added new functions (Requires 3.032 CUZ or later, 2 Series only) 
¡ GenerateUserNotice()  
¡ GenerateUserWarning()  
¡ GenerateUserError()  
¡ CheckForNVRamDisk() 

l SIMPL+: SendPacketToCresnet() will require 3.032 or later CUZ (due to 
internal changes) - 2 Series only issue.  
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l SIMPL+: The compile output window will indicate if it is skipping the module's 
compile if it is already up to date.  

l SIMPL+: Fixed control system crash with ReadInteger, ReadSignedInteger, 
ReadLongInteger, ReadSignedLongInteger.  

l SIMPL+: Compile error and warning codes are displayed in Compile Output 
Window (2-Series only) 

Fixes/Changes from 2.03.17 to 2.04.00: 

l SIMPL Windows Compiler: Fix compilation so that clock object on front panel of 
Pro2 has "AM" or "PM" after the "HH:MM:SS" text.  

l SIMPL Windows Compiler: Fix issue with using "0" on a Define Arguments 
Symbol (the first symbol in a macro definition) that could cause the macro, 
when used in a 2 Series sytem, to prevent the program from loading & 
initializing properly.  

l SIMPL Windows: Clean up CEN-ISC(R) and CN-ISC(R) for CEN-TVAV, CN-
TVAV Mixed processing mode to eliminate unnecessary startup traffic.  

l SIMPL Windows: Fixed issue where you cannot always move a serial device 
from one serial card to another if the cards are different types (i.e. cannot move 
a serial device that is currently on a CNXCOM-2 to a C2COM-3 card).  

l SIMPL Windows: DHCP support For 2 Series control systems: Added the 
option to enter either a DHCP host name or IP Address on the IP Address 
Configuration Dialog. Also added ability to enter a Port and define it as TCP or 
UDP, however, this feature is currently disabled until support is provided by 
other Crestron applications (CUZ , viewport etc).  

l SIMPL Windows: Digital Input and Parameter Properties: Added a new feature 
that will now allow the programmer of a module to define properties for Digital 
Inputs and Parameters for the "Defined Arguments" of the macro. These 
properties can be viewed by users when they are using the modules within a 
program to obtain documentation and guildelines of how the author of the 
module may have intended the input or parameter to be used. In addition to 
providing programmers with more information, these properties will be used 
within Simpl Windows to set Default Values (if defined) when the modules are 
added to a program. The programmer may always override these default 
values at any time. Simpl Windows will also use defined Parameter Properties 
to ensure data entry validity. This feature is not yet complete and will be 
expanded in the future to also allow property definitions of Digital Outputs, 
Analog and Serial Inputs/Outputs.  

l SIMPL Windows: Added support for having PDF help files for symbols: 
¡ The Module Header dialog was updated to allow the user to specify a 

PDF file to be displayed when help for that module is requested.  
¡ PDF filenames will be stored without a path. If a PDF exists for a symbol 

and is requested, Simpl Windows requires the file to be in the directory 
where the symbol defintion is located (if it is a user module, the PDF file 
should be in the USRMACRO directory, if it is a Project Module, the PDF 
file should be in the project directory.  
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¡ The Copy Program function was updated to make sure all applicable PDF 
files are also copied.  

¡ The Import Archive function was updated to extract all PDF files to the 
location where User Modules. 

l SIMPL Windows: Added the ability to view programming Help on a program's 
Control System by selecting the Central Control Modules node in the Program 
Tree and then hitting F1 or right clicking and selecting Help from the context 
menu.  

l SIMPL Windows: Fixed power calculator to provide a more accurate report of 
Power Consumed and Power Supplied.  

l SIMPL Windows: SIMPL Windows will now allow users to copy the Crestron 
Product Catalog to their Hard Drive and access the Product Catalog, containing 
the Device manuals, from the hard drive instead of having to have the CD 
inserted into their CD drive.  

l SIMPL Windows: Fixed an error in the System Tree where serial devices were 
being prohibited from being moved from one card to another.  

l SIMPL Windows: Fixed Autofill for a case where there were 2 devices of the 
same type. If Autofill was performed more than once, the second instance of 
the duplicate device was being lost.  

l SIMPL Windows: Fixed problem with Import Crestron SIMPL+ failing due to 
read only attributes on the IMPTCSP.DAT file.  

l SIMPL Windows: Fixed problem with the Commented Symbols dialog 
appearing to be empty when it really wasn't.  

l SIMPL Windows: Added Help Menu option to view Release Notes.  
l SIMPL+: Fixed RetimeWait()  
l SIMPL+: Allow multiple Digital, Analog and Serial I/O arrays (only the last one 

of each type will be variable in SIMPL Windows)  
l SIMPL+: Allow arrays as arguments in file read functions (ReadInteger, etc)  
l SIMPL+: Fixed a few translation errors that results in the error, "Error 

copying .spl output file…". The following cases would cause this error: A 
SIMPL+ statement such as, "myString ;" The SIMPL+ statement, "Print( "s", );" 
Accessing 2 dimensional arrays within structures inside of the following 
functions: chr(), date(), itoa(), itohex(), left(), right(), mid().  

l SIMPL+: Added reminder in the SIMPL+ new template module.to initialize all 
declared string variables.  

l SIMPL+: .USH file retains original capitalization for I/O cue names  
l SIMPL+: 'Total Memory Used' is no longer displayed after compilation (Total 

NVRAM is still calculated & displayed)  
l Viewport: Fixed crash when opening "Set CS IP Info" dialog with no connection 

established.  
l Viewport: Added support for e-Control 2 on an ENET+.  
l Viewport: Fixed problem when trying to send a panel/firmware to incorrect 

(unassigned) ID.  
l Viewport: Added program advisor support to verify NVRAM requirements are 

met in control system.  
l Viewport: Fixed problem uploading firmware (Monitor) to pre-2-series systems.  
l Viewport: More reliable transfers all around (especially web pages to ENET+).  
l Viewport: Removed single-file size limit on web page uploads to ENET+ 
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because of new firmware.  
l Viewport: Fixed OPS upload to CNMS (and similar) processors.  
l Viewport: Fixed bug where Ethernet program uploads to 2-series processors 

could flag the error light. Tcp/Ip reconnections are now initiated by the remote 
side.  

l Viewport: Restored program load output on ethernet uploads of 2-series 
projects.  

l Viewport: Fixed intermittent problems with using "Functions/Set Network ID" 
with CNMS-style processors.  

l Viewport: Changed "File Transfer/Update Touchpanel Firmware" to "File 
Transfer/Update Touchpanel/Keypad Firmware".  

l Viewport: Fixed error with "File Transfer/Get Mailbox..." on MSX.  
l Viewport: Fixed false error condition when performing a "Configure IP" on a 

CEN-CN whose TCP stack had not previously been configured.  
l Viewport: Fixed problem where 2-series program files wouldn't go to the right 

directory.  
l Viewport: Resolved problems when working with a TSID of the form xFxxxxxx.  
l Viewport: Added support for new-style 2-series IP Table.  
l Viewport: Added new "Configure Ethernet" dialog with DHCP, IP Address and 

other ethernet options for 2-series systems.  
l Viewport: Fixed bug in CNXTA dialog where "Hide Unused Slots" could be 

selected and slots would still be shown.  
l Viewport: Added 7-digit, purely numeric serial number as a valid form for 

TSID/Serial conversions.  
l Viewport: Fixed IP Table support for TPS panels.  
l Viewport: Fixed error where some valid IP addresses in Configure Ethernet 

dialog were being rejected. 

Fixes/Changes from 2.03.17 to 2.03.18 - PUBLIC FTP SITE 
RELEASE: 

l Viewport: Fixed problems updating firmware over RS-232 to direct-connected 
TPS panels (introduced in Viewport 3.15)  

l Viewport: Fixed problem with X-Gen version advisor warning even when UPZ 
was adequate (introduced in Viewport 3.15)  

l Viewport: Fixed timing issue introduced when sometimes exiting passto and 
starting a new action.  

l Viewport: Fixed problem with Status messages not being drawn to screen 
properly (introduced in Viewport 3.10) 

Fixes/Changes from 2.03.16 to 2.03.17: 

l Viewport: Reduced querying of rack type and 2-series control system 
information during several viewport operations.  
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l Viewport: Speed up Touch-Settable ID Operation through reduction of info-
querying.  

l Viewport: Fixed crash when opening Configure ControlSys IP dialog in 
viewport.  

l Viewport: Fixed bug where cancelling a touchpanel transfer thru a 2-series 
would return success.  

l Implement C2N-MMS Model (without Scan Converter card). Also available in 
Library Update 200 or later.  

l Fix for App Builder where IR ports would show names like "Port AA", "Port BB", 
etc. 

Fixes/Changes from 2.03.15 to 2.03.16: 

l Fix completeness check on CLX lighting modules.  
l Viewport: "Connecting..." dialog appears if TCP connection takes >3 seconds 

to be established.  
l Viewport: Fixed a bug where "EControl2" dialog would not give proper status 

info if the Control Systems EControl2 trial has not yet been started.  
l Viewport: Change DVP4 program load to reboot the system after the load is 

complete.  
l Viewport: Fixed intermittent bug when opening the viewport dialog if a 

connection failed could sometimes cause a crash.  
l Viewport: Fixed bug where transmitter ID of 0 was not being printed in Dialog.  
l Viewport: Improved efficiency of Rack finding algorithm.  
l Viewport: Fixed bug where Options/FindRack could fail if AutoBaudSearch was 

not enabled.  
l Viewport: First release of Touch Settable ID functionality.  
l SIMPL+: Fixed SetArray for local integers and long integers (signed & 

unsigned).  
l SIMPL+: Allow string function arguments to be passed into Remove().  
l SIMPL+: Don't allow strings within SetArray (String Arrays are still legal).  
l SIMPL+: Fixed return values for ReadStructure and WriteStructure.  
l SIMPL+: Translate escape characters in #DEFINE_CONSTANTS properly .  
l SIMPL+: Fixed application crash when return variables are not declared with 

signed expressions.  
l SIMPL+: Added functions: 

¡ RotateLeft (same as {{ operator)  
¡ RotateRight (same as }} operator)  
¡ RotateLeftLong  
¡ RotateRightLong 

Fixes/Changes from 2.03.14 to 2.03.15: 

l Add CHV-THSTAT and CHV-TSTAT models (Library update 198 and later).  

Page 93 of 116Release notes: SIMPL Windows Release notes:

7/1/2008file://C:\Crestron\Simpl\simpl_release_notes.html



l Add Logic to try to place relay devices, that take up multiple relays, onto 
contiguous relay ports if at all possible.  

l Added ability to apply the 5 predefined Signal Suffices (i.e. Alt+1, Alt+2, Alt+3, 
Alt+4 and Alt+5) at the symbol level.  

l Fixed Open dialog: this dialog will now start at the last directory from which an 
SMW/UMC file was opened, and not at the default program dir. Also, .ASV 
(autosave) files will no longer show up in the default set of files displayed in this 
dialog unless the user selects the "Files of type" to be "Auto Saved SIMPL 
Programs".  

l SIMPL+: Force Rebuild All if target type is changed.  
l SIMPL+: Fixed default directory when saving new template files.  
l SIMPL+: Remove extraneous Crestron Module files (.csp) after program 

compile.  
l SIMPL+: Fixed bug with passing integers within structures as arguments to 

functions.  
l SIMPL+: Added bookmarks, available from the Edit menu.  
l Fixed problem where IR devices were not getting the correct device names 

when added from the Crestron Database. 

Fixes/Changes from 2.03.14 to 2.03.15 (Internal Build Only, See 
notes for 2.03.15). 

l See notes for 2.03.15 

Fixes/Changes from 2.03.12 to 2.03.13: 

l Fix touch panel chaining for 2 Series systems. No special CUZ is needed for 
chaining, the fixes are solely on the SIMPL Windows compilation end. This 
issue has been present SIMPL Windows supported 2 series systems.  

l Commenting out of signals: Added ability to comment out signals. When signals 
are prefaced with "//", they will not be flagged as a "signal without destination" 
or "signal without driving source" when the program is compiled. However, the 
signal is still in the program (if you have the signal "//VCR_PLAY" between a 
touch panel defintion and an IR driver, for example, you will still be able to hit 
the button and have it function) - it only suppresses the compiler warning 
messages. A Detail View context menu option, and shortcut key (ALT+F2) have 
been provided to toggle the comment status of all selected signals in Detail 
View.  

l CNRFGW-418 now compiles correctly for X Generation Systems (Also 
available in library 196 or later).  

l e-Outlook 3 device is available (Also available in library 196 or later).  
l Fixed Simpl Windows crashes when running on Chinese Windows.  
l Fixed problem with Test Manager not being able to open files whose names 

were longer than 128 characters.  
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l Fixed error in Autofill for AV2 With Card Cage.  
l Enabled Alt+Shift+6 (Prepend Prefix) and Alt+6 (Append Suffix) for the 

symbol/subsystem level. When these options are selected at the 
symbol/subsystem level, all inputs and outputs will be updated with the given 
prefix or suffix. Parameters remain unchanged.  

l Added creation of a <program name>.smw.err file whenever a data integrity 
error is encountered on program open. This file is created such that it can be 
sent to Crestron Technical Support for more efficient resolution.  

l Added display of Device Name Suffix when a device requiring multiple slots is 
added to the program, regardless of whether the default logic is used. 

Fixes/Changes from 2.03.11 to 2.03.12 - PUBLIC FTP SITE 
RELEASE: 

l Added an error message to be displayed when the user selects 'Add Device' 
from context menu in Device Library and the device is not added.  

l Updated processing for PDF help files (help via the Device Library AND the 
Help Menu->Control CD Product Directory) to now look for and bring up the 
product manuals from the Product Catalog CD. Note: Help menu option is now 
"Product Catalog CD". Updated the configuration dialogs to now only show 
available Port/IR/RF/Card ID's that are valid for the currently selected device. 
Prior to this, all IDs were being shown even if it may not have been valid.  

l SIMPL+: Added and fixed SendMail return error codes  
l SIMPL+: Force a Rebuild All if the SIMPL+ module’s .ush file does not exist.  
l SIMPL+: Fixed an issue where if a module was set to 2 and X generation, and 

it was saved and compiled, then saved, the proper target control systems would 
not be saved properly with the module.  

l Viewport: Transfers of VTPro-e 2.4+ generated web pages to ENET+ cards 
works - no longer uploads duplicate _CONFIG_INI_.  

l Viewport: Web page transfers generally more reliable in error conditions.  
l Viewport: Web page transfers of files greater than 750KB to ENET+ devices 

now prohibited by software.  
l Viewport: Fixed problem where opening e-Control 2 activation dialog with no 

connection would cause a crash.  
l Viewport: E-Control Activation dialog now checks if control system supports e-

Control 2 before opening.  
l Viewport: Added Help/Help Contents and Help/About to user menu. 

Fixes/Changes from 2.03.10 to 2.03.11: 

l Device Extenders now work when placed on CPC-CAMIs/CNXFZ Cresnet 
devices. Programs must be recompiled for the Device Extenders on CPC-
CAMI's/CNXFZ Cresnet devices to function. This is a 2 Series only issue. 
However, no CUZ change is needed.  
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l Added ability to open AutoSave files (.ASV). The selected .asv file will be 
renamed to it's .smw file name. User will be asked if they wish to allow the 
Rename and proceed.  

l Provided support for entering Chinese/Japanese/Korean literals in a symbol's 
parameter field if the Chinese/Japanese/Korean version of Windows is running. 
Even though the characters can be entered, a seperate step to post-process 
the serial strings will be required before sending the text to a touch panel (multi-
byte fonts need to have their bytes swapped before being sent).  

l Added ability to refresh a remote system definition file (.RSD) to a different IP 
ID than the original import may have been imported to.  

l Provided an option on the Copy Program dialog for sending the zipped file to 
the control system mailbox.  

l Updated the Copy Program feature to now include any VT-PROe project files 
(.VTP) in the .zip file/directory copy. When an archive is imported, any .VTP 
files in the archive will be extracted to the project directory.  

l Added an option on the UI Project device configuration dialog to allow the user 
to say whether or not to inherit the Join assignments from the selected .VTP file 
into the associated panel.  

l Fixed problem where SIMPL Windows was allowing carriage returns and/or 
linefeeds to be a part of a Device Name which was causing data integrity errors 
the next time the program was opened.  

l Viewport: Wait cursor used more appropriately during busy sequences.  
l Viewport: "Send Default IP Table" dialog no longer appears when program 

being AutoSent.  
l Fix "Analog Comparison (Full Set)" so that only the desired outputs may be 

filled in. Previous versions required all outputs to be filled in.  
l Fixed problem where SIMPL Windows might crash when trying to cut and paste 

symbols in the program tree. 

Fixes/Changes from 2.03.09 to 2.03.10: 

l Fixed problem with compiling program that have Crestron SIMPL+ modules 
that are only valid on 2-Series systems.  

l Prevent a SIMPL Windows Program to be opened if the minimum SIMPL 
Windows version required by that program is newer than the version trying to 
open the program. In the past, an error was reported in the error log, but the 
program was still being opened. This was causing data integrity errors.  

l Remote System Definition 'Auto-Refresh' implemented: There is now an option 
on the Import Remote System Definition dialog (available via the Project menu 
or the context menus in the Program Tree and Detail View windows) that will 
allow the user to indicate that they would like SIMPL to check for a newer 
version of the imported .rsd file. - This option is stored, along with the refresh 
options (i.e. what to do when signals in the .RSD file have been 
deleted/changed) for each Imported Ethernet Intersystem Communication 
(EISC) symbol. When a program is opened, SIMPL will look at the value of the 
AutoRefresh flag for each imported EISC. If the flag is set and a newer RSD file 
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exists, the user will be then prompted as to whether or not they wish to continue 
with a refresh of the EISC data.  

l Viewport: Fix upload issues to ST-1700 and TPS-2000 panels.  
l Expose MT-500C & CNRFGWA-418 model for the MT-500C. 

Fixes/Changes from 2.03.08 to 2.03.09: 

l Fixed crash from editing a front panel after a replace control system has been 
peformed.  

l Added "Refresh" functionality to the Import Remote System Definition feature. 
Now, if a .RSD file is selected for Import, and that same filename has already 
been imported, the signals on the existing Ethernet Intersystem Communication 
symbol will be refreshed appropriately per the user's change/delete options. For 
deleted signals, the user has the options to remove signals if they no longer 
exist in the RSD file or to just leave the signal(s) as they are in the current 
program. For changed signals (i.e. if a signal name has changed in the RSD 
file) the user has the option to change the signal name on the Ethernet 
Intercommunication Symbol only, change the signal name throughout the whole 
program or to leave the signal as it is in the program.  

l Fixed problem with failing SIMPL+ compiles activated via the Lighting software.  
l Viewport: Found and fixed problem where Function keys would stop working if 

a user pressed certain key combinations.  
l Viewport: Added support for E-Control II Licensing. 

Fixes/Changes from 2.03.07 to 2.03.08: 

l Fixed problem in a function used by Lighting software program generation for 
connecting signals.  

l Import Remote System Definition (RSD) Fixes:  
l Improved the dialog that Simpl Windows displays at the beginning of an Import 

RSD that asks user whether or not to replace existing devices.  
l Fixed error that said there was no control system when the control system is a 

PAC2.  
l Fixed issues with the error log being empty but reporting there were errors.  
l Changed the Copy To Compact Flash function to allow copying to a non-

bootable (Project) folder on the compact flash.  
l Added a check and balance scheme when saving Programs to make sure the 

correct symbol codes are being written to the SMW file.  
l Device Extenders now adhere to User Level. All current Extenders are 

available in all levels, except for Packet Transmission which is Expert.  
l Added "Rebuild All" function to the Project Menu. Selecting this option will start 

a Rebuild All compile, ensuring that all Simpl+ modules contained within the 
program will be compiled. This feature would typically be used when Simpl+ 
files are copied around from computer to computer (especially if over a 
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network) and file date/timestamps cannot be relied upon for accuracy as to 
when that module really was last compiled.  

l Viewport: New Menu Item in Functions for converting Serial Numbers to Touch 
Settable ID (TSID) numbers.  

l Viewport: Fix bug where cancelling a TPS upload while 'Initializing...' would 
cause control system to hang in PASSTO mode.  

l Viewport: Reduced flashing during file transfers to active touchpanels.  
l Viewport: IP Tables may be set up for TPS panels using the same dialog as for 

control systems.  
l Viewport: Updates/Improvements of TSID support.  
l Viewport: Serial Number Assignment dialog adjusted for barcode reader 

support.  
l Viewport: Serial number prefixed with 'Z' are all invalid serial numbers.  
l Add other CNX-Bxx series button panels. (Library 182 and later)  
l Add User Interface tab in Configuration Manager to CNX-Bxx panels to allow 

specification of VTPro-e Project.  
l Add model for PAC2 as a 2 Series control system (Library 182 and later)  
l SIMPL+: Added & Fixed SendMail() return codes.  
l SIMPL+: Force a Rebuild All if the SIMPL+'s .USH file does not exist.  
l Add CNX-TS model (Library 184 and later).  
l Resolve issue with replacing a control system with a PAC2 and logic not 

transferring (Library 184 and later). 

Fixes/Changes from 2.03.03 to 2.03.07: 

l Fixed a crash that can occur when trying to drag a High Voltage Generic relay-
controlled device driver on to a C2I-RY8 card.  

l Fixed problem with using CmSmplLt.dll (i.e. Lighting Software's access to Simpl 
Windows functions) on Windows NT systems.  

l Added Export/Import Remote System Definition Feature: this feature provides 
the ability for 2 systems to be aware of the same signals via an Ethernet 
Intersystem Communication device. Exporting a Remote System Definition 
requires a program to have an Ethernet Intersystem Communication device 
programmed. When the user selects and right clicks on an Ethernet 
Intersystem Communication from the Program Tree, or in the Symbol Detail 
view, the context menu will have an option to Export Remote System Def file. 
Selecting this Export option will cause Simpl Windows to save the IP ID, IP 
Address and all the signal information into a specially formatted ".rsd file". 
This .rsd file can then be Imported into another system. Programming Note: 
Don't forget to assign an IP Address to the Ethernet Intersystem 
Communication device before an Export operation, as this will be needed for 
the 2 systems to communicate. Importing a Remote System Definition is an 
available option on the Program menu. Selecting to Import a Remote System 
Defintion will prompt the user for the .rsd file to import, a Prefix that will be 
prepended to all the signals read in from the .rsd file and whether the user 
wishes to override any other device that may be located at the IP ID defined in 
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the .rsd file. The import process will then first add an Ethernet Intersystem 
Communication device to the IP ID defined in the .rsd file and set the IP 
Address to the IP Address that is also defined in the .rsd file. Once the Ethernet 
Intersystem Communication device is added at the appropriate IP ID, Simpl 
Windows will then read the signal information from the given .rsd file. An import 
of a Remote System Definition will result in all INPUT SIGNALS from the 
exported Ethernet Intersystem Communication device being imported as 
OUTPUT SIGNALs and visa versa.  

l Fixed compilation issue where buttons didn't press on a Pro2's front panel, but 
buttons in the same position on a Pro's front panel would work.  

l Fixed issue where CNIRHT-15 transmitters would not work on a Pro2 (Also 
available in library update 179 and later).  

l Fixed crash on compilation if a macro file had no logic that could be compiled 
(i.e. everything commented out, etc.)  

l Added CTRL-G (Goto) in the SIMPL+ GUI to allow the user to jump to a line 
number.  

l SIMPL+: Fix for Bit() and Byte() functions to check the indexed position 
specified in the function against the current length of the string, rather than the 
maximum length. 

Fixes/Changes from 2.03.02 to 2.03.03: 

l Fixed problem with Autofill failing on a MSX-PRO when connection to rack is 
via ethernet.  

l Changed the "Search/Replace/F9" function to default to SELECTED when the 
user has selected 1 or a group of signals to do a string replace on. If the user 
selects at the Symbol level (i.e. selection of symbol in the Program Tree), the 
setting will still default to ALL.  

l Fixed problem with Power Supply devices having their Net ID showing up as 01 
instead of NONE. Also fixed problem where the user was being allowed to 
change the Net ID of a Power Supply. This is no longer allowed.  

l Fixed problem with deleting control entry devices that take up more than 1 slot.  
l Added logic to force an Imported CMC module's symbol tree to MISC if there is 

no category assigned in the original .CMC file.  
l Test Manager: Optimization so that large programs will no longer cause test 

manager to take a long time to start up.  
l When transferring a program from SIMPL Windows to a 2 Series processor, the 

standard viewport dialog will come up asking whether or not you want to 
transfer the project to compact or internal flash.  

l Add more device topics to help file.  
l Fixed problem where copying a project symbol from one instance of SIMPL 

Windows to another program in another instance of SIMPL Windows was 
causing SIMPL Windows to crash.  

l Correct compilation of CNX-MIDI card in 2 Series systems. This also requires 
CUZ 2.009 or later in the 2 Series processor. 
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Fixes/Changes from 2.03.01 to 2.03.02: 

l Viewport: Fix for a problem where accessing the IP info of a CP2E would could 
cause an access violation on the PC  

l Viewport: Fix for a problem introduced in 2.84 where having AutoBaudRate on 
would actually lose the found baud rate setting, rather than store it  

l Viewport: Improved reliability of communication with the MT-500C touchpanel  
l Viewport: Improved support of cancelling a TPS upload in the early stages  
l Added Import Archive Program to the Opening Dialog.  
l SIMPL+: Don't allow ReadStructure and WriteStructure within expressions or 

assignments (2 Series Only).  
l SIMPL+: ReadStructure and WriteStructure no longer have a return value. 

Instead, an optional third argument is allowed to passed into the function that 
will contain either the total number of bytes read or written, or if negative, a 
return error code. (2 Series Only).  

l SIMPL+: Fixed LONG_INTEGER format specifiers in Print() and MakeString() 
(2 Series Only).  

l SIMPL+: Allow x-generation compiler directive functions to compile correctly  
l SIMPL+: Fixed local variables within Wait Statements (2 Series Only)  
l SIMPL+: Fixed __FN_DST_STR__ string overflows with STRING_OUTPUTs (2 

Series Only) 

Fixes/Changes from 2.03.00 to 2.03.01: 

l Fixed potential problems with Test Manager crashing. This would only happen 
in 2.03.00; it would not affect 2.02.XX versions.  

l Fixed problem with AppBuilder not getting complete lists of potential controllers 
for a Serial device.  

l SIMPL+: Fixed problems with using I/O datatypes with file read/write functions.  
l Viewport: Fix issue where CP2E would show 2 Ethernet IP Entry dialog boxes 

(same as a Pro2), when it should only be showing one. 

Fixes/Changes from 2.02.11 to 2.03.00: 

l Fixed problem where directory navigation buttons on File Open dialogs stopped 
working on Windows 2000 & Windows XP systems.  

l Changed filenaming restrictions to once again allow commans in .SMW 
filenames (commas are still not allowed in .UMC [user macro] filenames).  

l Fixed problem where holding the SHIFT key down while clicking on the new 
program icon in the toolbar would once again refresh the program tree to show 
the new program (this is a shortcut way to bypass the program header dialog 
and having to add devices right away).  
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l SIMPL+: CSwitch() Case statement blocks now require a 'break' statement to 
terminate it's statement block. NOTE THAT THIS IS A CHANGE FROM ITS' 
PREVIOUS BEHAVIOR - ANY PROGRAMS USING CSWITCH WILL HAVE 
TO BE MODIFIED TO HAVE THE BREAK STATEMENT AS THEIR LAST 
LINE OF A CASE!  

l SIMPL+: Implemented SendMail().  
l SIMPL+: Increased maximum variable length for the 2-Series compiler to 120 

characters.  
l SIMPL+: Fixed compile optimizations so that previously compiled modules 

should not recompile every time a SIMPL Windows program is compiled. This 
should significantly decrease compile times.  

l SIMPL+: Allow "-" and "+" in #define_constant (ex: #define_constant 
MYCONST -1).  

l SIMPL+: Fixed incorrect compile warning when assigning to a structure 
variable of LONG_INTEGER datatype.  

l SIMPL+: Fixed storage of nonvolatile strings within structures.  
l SIMPL+: Fixed name mangling (prefix variables with double underscore instead 

of single underscore).  
l Viewport: Better error handling for timeouts/dead connections during transfers. 

Fixes/Changes from 2.02.10 to 2.02.11 - PUBLIC FTP SITE 
RELEASE: 

l Added support for AppBuilder/System Manager's Set ID functionality. Provided 
better determination of a how a Cresnet device's ID may be set (i.e. manually, 
via software command, via Setup mode, etc).  

l Fix problem when Application Builder tried to upload a project and there was a 
communications error, you would no longer be able to upload any projects. 

Fixes/Changes from 2.02.09 to 2.02.10 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL+: Fixed string allocations for strings and string arrays.  
l Show CNX-DVP4 as a Control System model.  
l Show CNX-DVP4 as a Remote Cresnet Processing model.  
l Fixed problem with context sensitive help on folder icons in Symbol Library 

bringing up unrelated help topics.  
l Fix issue with "Copy to Compact Flash" where an error would be reported if the 

compact flash was empty. 

Fixes/Changes from 2.02.08 to 2.02.09: 
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l SIMPL+: Fixed "_FN_DST_STR_" string overflows.  
l SIMPL+: Fixed allocation of last element within structure arrays.  
l Made sure that if a symbol is commented out and it is deemed incomplete, the 

system will not act on the incomplete status until it is commented back in. 

Fixes/Changes from 2.02.07 to 2.02.08: 

l Fix so that SIMPL Windows will no longer show an empty error log.  
l SIMPL+: Fixed GUI crash when using ReadStructure() and WriteStructure() 

with syntax errors in argument list.  
l SIMPL+: Fixed file routine functions when return values are not checked 

programmatically.  
l SIMPL+: Fixed memory leak in the GUI with SetArray().  
l Move CNXRMIRD from "Card Slots -\> Room Box Accessories" to "Wireless 

Receivers -\> IR" 

Fixes/Changes from 2.02.06 to 2.02.07: 

l SIMPL+: Fix compilation problem that would sometimes result in the error 
"Could not instantiate SIMPL+ module" coming from the rack (2 series only).  

l Fixed autofill problem where it was only getting the first Cresnet device.  
l SIMPL+: Fix problem with IsSignalDefined() where ANALOG_INPUTs and 

ANALOG_OUTPUTs were reversed.  
l Viewport: Extended the reboot timeout for TPS panels to 30 seconds, up from 

20 seconds.  
l Viewport: The error log is cleared when a new program is uploaded (2 series 

only)  
l Viewport: Transferring to/from the mailbox now uses the proper directory on the 

control system - "\\MAILBOX" (2 series only).  
l Viewport: The IP Table can once again be opened even where there is no 

control system attached.  
l Implement "Text Append" (Speedkeys: TEXTAPPEND, TAPP) symbol for 2 

Series systems. This requires version 1.014 CUZ or later, and will work on TPS 
panels and later. 

There are 3 inputs - CLEAR (Digital), MODE (Analog), IN$ (Serial). There is a single 
output, OUT$ (Serial). IN$ typically comes from any logic that can drive a serial 
string, such as "Serial Send", "Serial I/O", etc. OUT$ goes to a serial input of a touch 
panel definition. On the rising edge of CLEAR, OUT$ will be cleared, causing the 
indirect text field to be cleared. MODE has 3 valid values, which cause the text 
behave differently on the touch panel. When mode is initialized to 0d, any data sent 
to IN$ will be formatted such that it will cause OUT$ to be cleared and have the new 
data sent (the way touch panels work now). When mode is initalized to 1d, any data 
sent to IN$ will be appended to the next line of the indirect text field. For example, if 
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the field currently looks like:  

HELLO  

and "Every\\rBody" is sent to IN$, then the text field will look like (Note - \r is a 
carriage return)  

HELLO Every Body  

When mode is initialized to 2d, any data sent to IN$ will be appended to the end of 
the last line of the indirect text field. In the above example, if "Every\\rBody" were 
sent to the field, the text field would look like:  

HELLOEvery Body  

Any Carriage extra returns become empty lines, regardless of the mode. In the 
above example, if "Every\\r\\rBody" were sent to the field containing "HELLO", the 
output for mode 1 would be:  

HELLO Every  

Body  

The output for Mode 2 would be:  

HELLOEvery  

Body  

Advanced Usage: If you are writing a SIMPL+ module and want to use indirect-text 
append features, but do not want to use the symbol, the string sent to the touch 
panel can be modified to do this. For Mode 1, "\\xFE\\x01" should be put at the 
beginning of the string. For Mode 2, "\\xFE\\x02" should be put at the beginning of 
the string. No modifications are needed for Mode 0.  

For example, if you wanted to append "Every\\rBody" to the end of the current line, 
the following SIMPL+ code snippet could be used:  

STRING_OUTPUT OUT$; STRING NewText$[50];  

NewText$ = "Every\\rBody";  

OUT$ = "\\xFE\\x01" + NewText$;  

Fixes/Changes from 2.02.05 to 2.02.06: 
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l Changed wording on the Power Usage dialog.  
l Add "Connection_Status" output to e-Outlook interface.  
l Fixed problem where App Builder was adding a Crestron & User serial device 

to the same serial port.  
l Fixed crash when autofilling an X Generation sytem.  
l Fixed situation where a "File cannot be found" message box was coming 

numerous times and no filename was given. This message box will no longer 
be displayed, rather, more meaningful errors will be written to the error log.  

l The Detail View will now be closed when a Control Sytem is replaced.  
l Fixed problem where updates to the Edit Preferences dialog weren't being 

applied real time.  
l On the Edit Module Header dialog, the "No Selection" option for Target Control 

Systems was changed to now read as "Unspecified". Selecting this option 
means that the module has no requirements as to which control systems it 
must work on (it should work on all systems).  

l Fixed compilation problem where Date objects drawn on a 2 Series LCD front 
panel (such as a Pro2) would have a 4 Digit year. It has been corrected to show 
only the last 2 digits, the same as the front panel editor shows.  

l SIMPL+: Fixed optimization bug that forced SIMPL+ modules to always be 
rebuilt.  

l SIMPL+ general purpose Functions added: 
¡ Ltoa() (Long Integer to ASCII; similar to ItoA() )  
¡ Ltohex() (Long Integer to Hex; similar to ItoHex() ) 

l SIMPL+ File Functions Added: 
¡ ReadStructure()  
¡ WriteStructure()  
¡ WriteInteger()  
¡ ReadInteger()  
¡ WriteLongInteger()  
¡ ReadLongInteger()  
¡ WriteSignedInteger()  
¡ ReadSignedInteger()  
¡ WriteSignedLongInteger()  
¡ ReadSignedLongInteger()  
¡ WriteIntegerArray()  
¡ ReadIntegerArray()  
¡ WriteLongIntegerArray()  
¡ ReadLongIntegerArray()  
¡ WriteSignedIntegerArray()  
¡ ReadSignedIntegerArray()  
¡ WriteSignedLongIntegerArray()  
¡ ReadSignedLongIntegerArray()  
¡ WriteString()  
¡ ReadString()  
¡ WriteStringArray()  
¡ ReadStringArray() 
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Fixes/Changes from 2.02.04 to 2.02.05: 

l Fixed problem with error log where AppBuilder was not getting list of errors in 
order of severity.  

l Simpl+: Fixed compilation error when compiling Crestron Simpl Plus Modules 
previously compiled using Simpl Windows versions prior to the 2.02.xx series. 

Fixes/Changes from 2.02.03 to 2.02.04: 

l Viewport: Fix problem where send touchpanel through an MSX would fail over 
a slow connection.  

l Viewport: Fix problem transferring to a TPS-2000 through an ST-CP.  
l Viewport: Fix problem transferring .csu files from a long path.  
l Viewport: Add support for transfer of CCF files to a ProntoPro remote.  
l Viewport: Add "Program Advisor" support for Simpl uploads to 2-series 

systems.  
l SIMPL+: Fixed DIGITAL_OUTPUT arrays within Pulse().  
l SIMPL+: Fixed assignments of structure arrays to strings.  
l SIMPL+: Fixed translation of FILE_INFO local variables  
l SIMPL+: Fixed translation of LONG_INTEGER datatype  
l SIMPL+: Fixed translation of #define_constant - if #define_constant name was 

a subset of a declared variable name  
l SIMPL+: Fixed calculation of total NVRam bytes for Crestron modules when 

compiling project for the first time.  
l SIMPL+: Fixed application crash when cursor was place over structure data.  
l SIMPL+: Changed keyword LONG_FUNCTION to 

LONG_INTEGER_FUNCTION.  
l SIMPL+: Added SIMPL+, Include.dat and Cross Compiler version information 

to .USH file.  
l Made updates to device library for e-Outlook symbol.  
l Fixed problem where a newly created AppBuilder system was inheriting data 

from the last opened system.  
l Enhanced Error Messages presented to the user when an IR Driver file is read 

in from a location other than where it came from the last time a program was 
saved.  

l Updated "Invalid File" message on File Open attempts to also advise of 
potential filename length error.  

l Fixed problem where AppBuilder was not able to add an ST-LT. This fix will 
require CrestronDB version 15.7.3 or higher.  

l Added display of Model to the IR File Info Dialog.  
l Added prompt to ask user if they want to overwrite previously existing files in 

the compact flash boot directories during the Copy To Compact Flash process.  
l Added test of a Module's Exclusion list when loading a program. If the current 

control system is in a module's exclusion list, the symbol(s) representing that 
module will be commented out and the user will be informed. Please note that if 
this situation occurs, the user does not have to save the program and risk 
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having to go back and uncomment a bunch of symbols. The program can be 
closed, the situation remedied and then the program can be re-opened without 
incident.  

l The Module Header dialog will no longer show TPS Panels on the list of target 
control systems.  

l Compiler Fix for Pronto not working properly through a CNX-RMCLV when 
CNX-RMCLV hooked up to a 2 Series. 

Changes from 2.02.02 to 2.02.03: 

l SIMPL Windows will now register the ctrldbx.ocx that is located in the 
application directory when it starts up. This will ensure that any older versions 
of Simpl Windows that are started, after newer versions have been installed, 
will still be able to access the Crestron Database.  

l Fix problem where retrieve program from the transfer dialog was not working.  
l Display SIMPL+ Cross Compiler Include File version number in SIMPL+ Help 

About.  
l Fixed optimization logic when compiling modules  
l Added context sensitive drop down box in editor for easy selection of structure 

fields.  
l Added CSwitch construct. 

Fixes/Changes from 2.02.01 to 2.02.02: 

l Fixed problem when trying to open read only files. The changes made to allow 
for opening files with names longer than 128 chars caused an error when trying 
to open a read only file. This was generating a message box that was killing 
AppBuilder. Read only files can now be read.  

l Fixed library issues (v153 or later) with copying over serial signals in a control 
system Made updates to device library for e-outlook symbol.  

l Fixed problem where a newly created AppBuilder system was inheriting data 
from the last opened system.  

l Enhanced Error Messages presented to the user when an IR Driver file is read 
in from a location other than where it came from the last time a program was 
saved.  

l Updated "Invalid File" message on File Open attempts to also advise of 
potential filename length error.  

l Fixed problem where AppBuilder was not able to add an ST-LT. Note: This fix 
will require CrestronDB version 15.7.3 or higher.  

l Added display of Model to the IR File Info Dialog.  
l Added prompt to ask user if they want to overwrite previously existing files in 

the compact flash boot dirs during the Copy To Compact Flash process.  
l Added test of a Module's Exclusion list when loading a program. If the current 

control system is in a module's exclusion list, the symbol(s) representing that 
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module will be commented out and the user will be informed. Please note that if 
this situation occurs, the user does not have to save the program and risk 
having to go back and uncomment a bunch of symbols. The program can be 
closed, the situation remedied and then the program can be re-opened without 
incident.  

l The Module Header dialog will no longer show TPS Panels on the list of target 
control systems.  

l Compiler Fix for Pronto not working properly through a CNX-RMCLV when 
CNX-RMCLV hooked up to a 2 Series. 

Fixes/Changes from 2.01.05 to 2.02.01: 

l SIMPL+: 
¡ Added STRUCTURE datatype  
¡ Added LONG_INTEGER datatype  
¡ Added Compact Flash File Functions  
¡ Added LONG_FUNCTION function type (returning LONG_INTEGER 

types from functions)  
¡ Allow Structures and LONG_INTEGER datatypes to be passed as 

function arguments  
¡ Allow #define_constant values when declaring local array variables  
¡ Allow Return statement within Wait Statement blocks, and warn that 

return only will return from the Wait() statement's scope.  
¡ Disallow TerminateEvent() from Function Main(). 'Return' should be used 

instead.  
¡ Fixed rack's "Failed to load SIMPL+ module" error due to incorrect 

NVRam value  
¡ Fixed program crash with 'Return' statements within PUSH, CHANGE, 

RELEASE  
¡ Fixed Remove() when no default start position is specified  
¡ Fixed u format specifier in Print() and MakeString()  
¡ Fixed compiler crash when variable name lengths exceed 30 characters  
¡ Fixed GetLastModifiedArrayIndex()  
¡ Fixed file name mangling with '(', ')', '[', ']', '{', '}', '|', '~'  
¡ Fixed TerminateEvent statement within Wait Statement blocks - it 

becomes a Return() statement, and the compiler will warn that it will only 
return from the Wait statement's scope.  

¡ Fixed Return statement within function Main.  
¡ Fixed problem with string expressions containing parenthesis. ex: if( str = 

(str2) );  
¡ Fixed #DEFAULT_VOLATILE and #DEFAULT_NONVOLATILE compiler 

directives in X-Generation compiler  
¡ Fixed bug if last character typed in SIMPL+ module was not a carriage 

return  
¡ Added new function: ATOL : LONG_INTEGER = ATOL( string )  
¡ Added "Display Compile Warnings" checkbox in Edit|Preferences|Target 
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Devices  
¡ Check version of INCLUDE.DAT file when compiling modules - forces 

recompilation if different (makes it easier to use newer versions of SIMPL 
Windows without having to manually recompile all SIMPL+ files a program 
uses if the INCLUDE.DAT file changes)  

¡ Display "Total Warnings" in compile output window  
¡ Fixed problem with using Find() for multicharacter match strings.  
¡ SetClock() and SetDate() now can interpret their integer arguments as 

signed.  
¡ Fix context sensitive help from the error log (notably, it hitting the HELP 

button after a compilation did not bring up the correct help topic, it only 
brought up the main page of help). 

l Add "Copy to Compact Flash" option in SIMPL Windows file menu. The user 
must specify a .SPZ file (2 Series only) and a destination drive (the compact 
flash drive). The proper target directories will be created on the compact flash 
to make it "bootable." NOTE: When inserted, the compact flash will only boot if 
the CFAUTORUN option is turned on from the console of the Pro2. If it is 
turned off, the program on the compact flash will be loaded and run only when 
the program is reset (F10 in the viewport, cycling power, hitting HW-R, Hitting 
SW-R, etc.) The syntax for CFAUTORUN is "CFAUTORUN ON" or 
"CFAUTORUN OFF". Typing CFAUTORUN and hitting enter will show the 
current status.  

l Change file save routines to prohibit commas in filenames.  
l Fixed problem with program/pathnames being limited to 128 characters. The 

limit is now 256 characters.  
l Viewport: Add a "Make this the Default Setting" checkbox in the TCP/IP 

address book dialog. When checked and Connect is clicked, the selected IP 
address will be used the next time the Viewport starts or when other 
applications such as Test Manager or SIMPL Windows attempt to communicate 
to a control system.  

l Viewport: In Report Mailbox size, report the size available on internal flash even 
if the current directory is in compact flash.  

l Viewport: Add an option to the Functions|2-Series menu to erase the mailbox.  
l Viewport: Add passto support for an ST-CP (requires UPZ 4.02.00 or higher).  
l Fix compilation problem for Pro2 front panel where Date and Clock objects 

were compiled improperly (specify a clock, it compiled into a date; specify a 
date, it compiled into a clock).  

l Any signal marked as multiple types in SIMPL Windows (i.e. Analog+Serial, 
etc.) will now show up as a green line. Black is now reserved for Serial signals. 
When saving a Macro (.UMC), SIMPL Windows will verify that all signals are of 
a discrete signal type (Analog, Digital, or Serial). If they are not, it will produce 
warning 155 to let the user know. 

Fixes/Changes from 2.01.05 to 2.01.06: 

l SIMPL Windows will now register the ctrldbx.ocx that is located in the 
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application directory when it starts up. This will ensure that any older versions 
of Simpl Windows that are started, after newer versions have been installed, 
will still be able to access the Crestron Database.  

l Fixes to e-Outlook Interface Symbol (fix is also present in Library files 154 and 
later)  

l Implement symbol for C2COM-3 expansion card (2 Series only; present in 
Library files 155 and later).  

l Add "Extended Clock" driver (2 Series Only) symbol - same as the current 
Clock Driver, but it also has an "in_DST" digital output which is high if the 
system is currently in Daylight Savings Time. No specific CUZ is required for 
support (present in Library files 155 and later)  

l 3 New symbols have been created to facilitate resolving the ambiguous signal 
problem - Analog Force (Speedkeys: AFORCE, ACAST), Serial Force 
(Speedkeys: SFORCE, SCAST), and Digital Force (Speedkeys: DFORCE, 
DCAST). These symbols can be placed in a program and connected to a signal 
to force the type. For example, if an analog+serial output of an Intersystem 
Communications (XSIG) symbol is run to analog+serial input of another 
Intersystem communications symbol, the ambiguous warning will be produced. 
The signal can be tied to an "Analog Force" (or "Serial Force", depending on 
what type the programmer wanted it to be) to resolve the issue. The Force 
symbols have no impact on the final program that is transferred to the rack; 
they are used on to help resolve save/compile time ambiguities. These symbols 
can be used inside of a Macro (.UMC) or in a SIMPL Windows program 
(.SMW). (2 Series Only; Present in Library files 155 and later.)  

l Fix ST-LT compilation (2 Series only). 

Fixes/Changes from 2.01.04 to 2.01.05 - PUBLIC FTP SITE 
RELEASE: 

l SIMPL+: Fix resource problem between the X Generation and 2 Series 
compilers.  

l Fix autofill issue - sometimes autofill will report errors that certain devices did 
not autofill correctly even though the actually did.  

l Fix replace control system issue where serial ports would get moved to 
incorrect positions. 

Fixes/Changes from 2.01.03 to 2.01.04: 

l SIMPL+: Fix problem with Remove() requiring the last parameter. The last 
parameter is now optional, as documented.  

l Fix driver drop problem with CNX-FZ & CPC-CAMI (fix is also present in Library 
files 150 and later).  

l Viewport: Fix problems transferring to a TPS panel through a control system 
(introduced in v2.66 of the viewport)  
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l Fix autofill problem - CNWMBG2-34 would not properly autofill. 

Fixes/Changes from 2.01.02 to 2.01.03: 

l Fix missing symbol for e-Datalog  
l Fix problem where Application Builder would not launch (due to changes in 

2.01.02 install)  
l Move LC-3000 from "Discontinued" back to "Touchpanels"  
l Rename "Obsolete" as "Discontinued" in Configuration Manager's Device 

Library.  
l Fixed issue where the "Help" option in the SIMPL+ GUI did not bring up the 

help system.  
l Fixed TPS Join Number Remap project to allow 127 Serial Inputs/999 Serial 

outputs on both the TPS Cresnet and TPS Ethernet interfaces. 

Fixes/Changes from 2.01.01 to 2.01.02: 

l Fix issue with 2.01.00's fix for SIMPL+ target compilation. (Third item on 
2.01.00's fix list).  

l Fix problems with copying to a similar symbol when converting a control 
system.  

l Fixed LiveUpdate for proper version number checking.  
l Correct compilation of 1 Way Serial drivers on CNXIR-8 cards on 2 Series 

systems. 

Fixes/Changes from 2.01.00 to 2.01.01: 

l Fixed problem where Simpl+ modules within User Modules were replaced 
whenever a SAVE AS was performed.  

l Clear All Watch Signals in SIMPL Windows now clears the status window in 
Test Manager (if it's opened) and clears out the last status window information 
from the .tm file (if it exists).  

l Viewport: Speed up Initialize time for each file in an SPZ during a program 
transfer (Requires CUZ 1.010 or later; 2 Series Only)  

l Viewport: Restrict TCP/IP Console password to 14 characters for compatability 
with 2-series (previously was limited to 30 chars)  

l Viewport: Remove file name length limit for web page transfers for 2-Series 
control systems (Limit is 66 chars for CNXENET+)  

l Viewport: Programs that sent data to the console (i.e. TEST symbols, print() 
statements, etc.) would sometimes interfere with uploading a new program. 
This has been fixed.  

l Added racktypes CP2, CP2E (library 144 or later) - requires CUZ 1.010 or later.  
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l Fixed help links for various Ethernet devices. 

Fixes/Changes from 2.00.28 to 2.01.00: 

l Fix compilation of CNXIR-8 cards in a 2 Series control system when using a 
CNXIR One Way Serial Driver (would give an "Unknown Device" error in the 
viewport). This is fixed in library 144 or later.  

l Fix compilation error when a SMW program name had ( or ) in it, and it 
contained SIMPL+ (2 Series only).  

l SIMPL+: Fix issue with SIMPL+ target compilation. If a module is developed & 
compiled for both 2 and X series, and used in a 2 Series program, after 
compilation of the 2 Series program, the module would no longer be available 
for use with an X series system until it was compiled for the X target in the 
SIMPL+ GUI. 

Fixes/Changes from 2.00.25 to 2.00.28 

l Fix problem with modules in a program being reassigned to other modules 
when Duplicate modules existed in both User and Project directories.  

l Fix problem with Module Hint being cleared sometimes.  
l Fix problem where certain macros would cause the SIMPL Windows compiler 

to crash (macros that were programmed with the [~UNUSED~] signal name in 
order to create gaps)  

l Fixed problem where TPS Join Number Remap projects would crash the 
SIMPL Windows compiler if serial strings were used.  

l Viewport TPS Transfers: Fix 20 second timeout problem when reading a TPS 
directory - this would occur when transferring larger projects to a TPS panel.  

l Viewport TPS Transfers: Speed improvements  
l Viewport TPS Transfers: Fix problem where if the size of the files needed to be 

sent is less than the total capacity of the panel, the files would be sent even if 
the total project size wouldn't fit in the panel. 

Fixes/Changes from 2.00.24 to 2.00.25 

l Fix problem with Application Builder generated programs - when opening the 
SMW file in SIMPL Windows, there was potential to get a "User Lock" error. 

Fixes/Changes from 2.00.23 to 2.00.24 (2.00.24: Internal Release 
Only) 
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l In prior versions, opening a SIMPL+ module from SIMPL Windows (right click 
on the module in your program and choose "Edit User Module") or a SIMPL 
module (right click on the module in your program and choose "Edit User 
Module" and then "In New Instance") and saving the file (with your original 
program still open in the first instance of SIMPL Windows) would sometimes 
cause the modules within your main program to get randomly reassigned as 
other modules. This has been fixed.  

l Fixed problem with Search/Replace not working: When the search and/or 
replace strings were single digit numbers, they were being turned into 
underscores.  

l SIMPL+: Fix for 2 Series system crashing when an out of bounds array write 
was performed. The 2 Series system will now issue an error message about the 
out of bounds array. 

Fixes/Changes from 2.00.22 to 2.00.23 (2.00.23: Internal Release 
Only) 

l Fix so that uninstalling or running this version (or later) of SIMPL Windows will 
not affect uninstalling or running older versions of SIMPL Windows (or vice-
versa).  

l Allow 0's on the outputs of a JK Flip Flop (2 Series only).  
l SIMPL Windows compiler: Fix COM ports so that if TX$ or RX$ is left out and 

signals are put on the transmit or receive side of the com port (for triggering or 
matching data that is coded directly into the parameters of the port), it will 
trigger or match properly. (2 Series Only). 

Fixes/Changes from 2.00.18 to 2.00.22 

l Fix compilation of the UP and DOWN arrow buttons on the front panel (2 Series 
only)  

l Fix so that Application Builder can upload to a 2 Series system. This will require 
a newer Crestron Database (newer than version 15.6.5), but only when using 
Application Builder.  

l SIMPL+: Fix compilation of For() loops with a negative step (2 Series only)  
l SIMPL+: String comparisons are now case sensitive, as they were with the X 

Generation. (2 Series only)  
l SIMPL+: Fix compilation errors for modules that contained Direct device access 

functions (i.e. SetSlot(), etc.) or passing STRING_INPUT, BUFFER_INPUT, 
ANALOG_INPUT, or DIGITAL_INPUT variables to functions (X Generation 
Only)  

l SIMPL+: If a 1D or 2D Integer array overflowed, the control system would 
crash. It now correctly reports the array overflow (2 Series only)  

l SIMPL+: Fixed compilation of the NOT operator.  
l SIMPL+: Fixed compilation MakeString(0, ...  
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l SIMPL+: Display message in compile output window if SIMPL+ Cross Compiler 
is not installed. An error message is also printed to the SIMPL Windows error 
log if the SIMPL+ cross compiler is not installed and an attempt is made to 
compile a program that contains SIMPL+.  

l SIMPL+: Display SIMPL+ Cross Compiler version in SIMPL+ About box.  
l Change title on front panel editor to "Front Panel Editor" for the LCD front panel 

for both X Generation and 2 Series systems.  
l Allow TOGGLE symbol to have "0" on it's OUT output and a signal on the OUT* 

output and work correctly in the control system (2 Series only)  
l Clean up error message for "\\x" errors within strings in macros. "\\x" in a string 

must always have 2 valid hex characters after it; the error message now prints 
the macro number in the main program as well as the symbol within the macro, 
if the error occurred in a macro. Be aware that this holds even for partial 
substitution, i.e. if a string parameter has "\\x25\\x\\[\#SECOND_BYTE\\]\\x26", 
that the user must type in 2 hex digits on the macro when putting in a value for 
SECOND_BYTE; i.e. for 0, they need to type 00, not 0. This is not a change; 
just a clarification for both X Generation and 2 Series.  

l Mark program as needing to be saved if a DPA card is changed from a 
CNXENET+ to a CNXENET or CNXENET to CNXENET+ (X Generation Only)  

l Fix "TCP/IP Client" device problem when converting between an X Generation 
system and a 2 Series system.  

l Fix ST-LT operation for 2 Series systems.  
l Viewport: Remember last ID for remote console.  
l Viewport: Fix problem where exiting remote console mode on an X Generation 

system could fail.  
l Viewport: Fix problem where file system wasn't initialized on CNXENET+ card 

before entire web project was sent (this resulted in duplicate files with same 
name in CNXENET+ card).  

l Viewport: Fix problem where web pages could only be sent to a PRO2 and no 
other 2-series systems.  

l SIMPL+: Fixed SetArray() with STRING_OUTPUT and STRING_OUTPUT 
Array variables.  

l Simpl+: Fixed issue where control system type was not properly stored when 
selecting "2 Series" or "X Gen" buttons from the SIMPL+ GUI.  

l Macro corruption fix: When a user had a program open, opened a macro in that 
instance of SIMPL Windows, edited and saved the macro, then opened the 
program again, the edited macro was sometimes replaced in the program with 
a completely different macro.  

l Various fixes for Application Builder support.  
l Test Manager: Fix crash when moving the cursor up/down in the Status View.  
l Viewport: Fixed problem (introduced in 2.00.14) transferring VTZ files that 

contained certain characters in the internal filenames. 

Fixes/Changes from 2.00.16 to 2.00.18 

l Fix problem with Autofill putting up an error message (no communication) if 
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there were no Cresnet devices.  
l Fixed problem where Application Builder could not add ST style touch panels.  
l Viewport now stops the currently running program before sending a new 

program. This resolves issues where the firmware and/or filesystem was 
corrupted and the control system would not boot. (2 Series only)  

l Fix problem with Autofill not properly identifying plug-in cards in the 2 Series 
systems.  

l Fix target types for module development.  
l SIMPL+: "%d" specifiers in MakeString() and Print() will now print negative 

numbers correctly (i.e. 65535 will now print as -1 using d)  
l SIMPL+: \x format specifier in MakeString() and Print() verifies that a valid 2 

digit hex number exists afterwards  
l SIMPL+: Remove Read-Only file attributes when extracting Crestron Modules 

into Windows Temp directory  
l SIMPL+: Correct problems with optimized compiles through the SIMPL+ GUI (if 

a module had errors, it wasn't always showing the errors, but a compile through 
SIMPL Windows would show that a .SPL file could not be copied)  

l SIMPL+: Correct problem where if a SIMPL+ module failed compilation, all 
subsequent compilations would print that they failed. (X Generation and 2 
Series compilations) 

Features introduced in Version 2.00.16 include: 

l Support for the 2-Series control systems in SIMPL Windows itself, Viewport, 
Test Manager.  

l New Symbols added (2-Series systems only): Multiple NOT, Logic Wave Delay, 
Wave Pulse, Make String Permanent, Toggle-Interlock, Variable Oscillator, 
Ring Counter with Seed, Variable Delay, Console, Mouse Simulator, 
Astronomical Clock, Time Offset.  

l SIMPL+ v3. Direct device access and debugging capability is coming shortly. 
Much faster SIMPL+ with much larger programs permitted. Ability to specify the 
target control system for SIMPL+ to run on either the X-generation class 
machine or the 2-Series machine or both.  

l Ability to organize modules, IR files, and SIMPL+ files into individual project 
folders as well as in the Crestron and user folder. Organize your user and 
project folders into the same categories as the Crestron folder by specifying a 
category in the Program Header.  

l Improved Symbol & SIMPL+ help.  
l Some resource optimization to cut down on memory usage. You may notice a 

delay the first time you run this version of SIMPL Windows or when installing a 
new Crestron database as optimization files are built.  

l Ability to note a location for each device to facilitate installation. Smart 
propagation of that location to all associated devices, e.g. if a control system is 
in a particular room, so are all of the cards installed in it. Supports AppBuilder.  

l Reorganization of symbols in Program Manager to place the CresNet and 
Ethernet nodes underneath the cards which supply the network. This is 
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absolutely necessary to display multiple Ethernet and CresNet networks in a 
single control system without confusing units from different networks. The 
control system type is noted as a comment on the Central Control Modules 
node.  

l Reorganization of the Crestron device library in Configuration Manager into 
multiple nested levels for better organization, as well as classifying some 
devices as obsolete. This does not mean that you cannot use the devices! It is 
merely a way of removing the clutter for improved access.  

l Enhanced error management from the Viewport (2 Series only): Clear the Error 
log, save it to disk, copy it to the clipboard, or view it in the Viewport. 

Installing the Crestron Database 

Along with the SIMPL Windows application, you should download and install the 
Crestron Database. This database is a collection of support files that SIMPL 
Windows requires to allow you to add control of third party devices to your programs. 

To install, simply run the setup program. Note that whether you install SIMPL 
Windows first, or the database first, the install programs will automatically setup 
SMW to find the database wherever it was installed. Thus, there are no additional 
configuration steps.  

Installing the SIMPL+ Cross Compiler 

To use SIMPL+ for the 2 Series control systems, you must download and install the 
SIMPL+ Cross Compiler. You will need version 1.1 of the Cross compiler or later to 
work properly. 

Please note that if you have other applications that use Cygwin (a Unix compatability 
layer for Windows), you should use version 1.2 of the Cross compiler or later, as this 
version address co-existing installation issues with Cygwin.  

Installing the Crestron Toolbox 

In order to communicate, upload to, and manage to 2 Series processors you will 
need to download and install the Crestron Toolbox. Note that the Crestron Toolbox is 
not compatible with processors prior to the 2 Series (X Generation, ST-CP, and 
CNMS era control systems). To use these processors, you will need to use the 
Viewport utility. 

Crestron Electronics, Inc. 
Rockleigh, NJ 07647 
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Tel: 800.237.2041/ 201.767.3400 
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